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Quick Start

Contract Setup

Every contract that appears in the "Selected" box will appear in your drop down lists for the order tickets and quotes
window setup.

Click on the desired group (i.e.) “Currencies” under the "Available" window and open it up so that you can see all of
the contracts included in that window. Click to add a checkmark next to the contracts you want to see in your
drop down lists for the order tickets and quotes window setup. You will see the contracts move to the
“Selected” box as you select them.

Once you have added the desired contracts to the contract setup “Selected” box you will next want to select the
months that you want to trade. If you change the month’s column to the “Nearest 2" selection you will most
likely have the contract months you trade. If the month you trade is not part of the Nearest 2 selection then
select “All Months”. Make sure that you click “Set Months” before exiting the “Contract Setup” window or else
your settings will not be saved.

You can also set a default quantity for one or many contracts at once by pressing CTRL and selecting the contracts
then, set the Def. Qty. and hit "Set Qty". Note: This settings will show once you log off and log back in.

m Contract Setup E]@
Available: Selected:
e Currencies Diezcription Symbal | Manthg ad
= Energies Auszzie Dollar Bé Mearest
EH - Heating il British Pound ] Mearest
CL - Crude Ol [pit] Canadian Dollar BC Mearest
GCL - Crude Ol Ewra Fx Currencies EE Mearest
fowmeren H e
GHL - Unleaded Mezican Peso G Mearest
5HG I*-JHtH NIEII::wa:_GatSd Mew Zealand Dallar = Mearest
i - Matural laas Last-day Fussian Ruble GR Mearest
HO - Heating il [pit) Swizz Franc 65 Mearest
HF - Matural Gas South African Rand £ Mearest
HU - Unleaded [pit] Ethar_ml [pit] ] AC MNearest
MG - HH Matural Gas [pi] .&uss!e Dollalr [pit] AD Mearest
06 - HH Natursl Gas miN'y e o v
GH - Heating Oil mitv Sovbean Ol [pit] BO Mearest
(M - Crude Ol mitNy Biritish Pound [pit] BP Mearest
QU - Gasoline miky Brazilian Real [pit] ER MNearest
ET -RBOBE Gazoline Carn [pit) C Mearest
WS - Crude Qil Eocoa_[pit] _ cc MNearest
o Firnarcials Canad|a_n Dl-:-IIar [pit] CD Mearest
i Grains Crude il [pit) _ CL Mearest
# [ Indices TR B Nowed
=2 Meats 1S Dallar D Nearest
+ tetals E-Mini Eura F E7 MNearest
+ Softs Ewro Fx Currencies [pit] EC Mearest
Eura Dallar [pit]_ ED Mearest -
{1 Mo, LIBOR [oit) Erd MNearest R

Next, you will go to “Quotes” in the menu bar and select “Add Market” Select the contract you want to add and click

“OK™.

Account Summary

You can customize the "Account Summary" window by hiding the rows that you do not want to see.




Account Summarny E
Total
Profit/Loss
Open PAL $0.00
Realized P/L $13.875.00
Tatal PAL $£13.875.00
Balance
Cazh $ B4.765.00
Open FAL n.0a
Met Lig $ B4 7ER.00
Rate

Right-click anywhere inside the Account Summary window then, select "Column Setup..."

Account Summarny E
Total
ProfitfLoss
Open PAL $0.00
Realized P/L $13.875.00
Tatal PAL $13,875.00
Balance
Caszh $ 64 765.00
Open FAL n.0a
Met Lig $ 64.765.00
R ate
all Currencies
| Column Setup. ..
Fonk...

Click on the row that you want to hide under the column "Visibility" and select “hidden”.

[ e
m Account Summary = @
Colurmn izibility
Open PrL Hidden v
Fealized P/L
Total PAL Esl’dma'
Cash Hidden
Open PAL Tarmal
Met Lig Mormal
Fate Marmal
aE. l [ Cancel

Realized P/L shows the P/L of any closed trades.
Open P/L shows the P/L of any open positions.
Total P/L shows the total P/L for both the Open and Realized P/L.

Quick Start
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Account Summan

Profit/Loss
Open F/L
Realized P/L
Total FAL

» | all Currencies

Tatal 5D
000 0.00
-4 55.00 -55.00
-4 55.00 -55.00
R0167.50

Fork...

Column Set - 0.00
all Currencies | B01E7.50

Export ko C5V.

1

CHF

0.00
0.00
0.00

003
0.00
009

JET3

If you have a balance in another currency you will see another window showing the same information for that
currency. The window titled “Total” will sum up all the currencies in your account so if you want to view this window
only, uncheck “Show Currency Summary Columns”.

Confirmations

As a safeguard a trader can turn on the "Confirmations" feature in APPLTrader. This gives the trader an opportunity
to confirm the order before the order is sent for execution. This feature is optional and is turned on by default.

m OECTrader Demo

File  Account

Symbaol | HBo

ECLE
ESUG

Orders

Abbreviated Order Enkry

Carmmunications

Quotes  Wiew

Reparts

Turbo Order Enkry
Rapid Crder Enkry

Depth OF Market Order Enkry

Ctrl+1
Ctrl+2
Chrl4+3
Chrl+4

Setup

Toolbox

b

Crder Defaules, ..
Clear after Submit

Pos| % Total PAL

] $550.00
10 $2.625.00

[ Average Position

Mew Order
Cancel Order

m Order Confirmation

Contrack Setup..,
Account | Confirmations
DEMO25330 Motifications
Show Cancelled Orders
Show Rejected Orders
(< | -
-

?

Account: DEMOZ5830
Send BUY 5 BAUG MET?

| oK

[ Cancel

Notifications



Quick Start

If a trader wants to be notified by an alert box when an order has been filled or if an order modification or cancellation
failed leave the options checked. We recommend leaving a check mark next to “Notifications” > "Modify or Cancel

Failed".

m OECTrader Demo

File  Account

Symbal | #HBa

ECUG
ESUE

Average Pozition

Account
DEMO25830

Crders | Communications Vieww  Reports  Setup Toolbox  Help 0
Abbreviated Order Enkry Chrl+1
Turbo Order Entry Ckrl+2 Poz| % Tatal PAL
Rapid Order Enkry Chrl+3 5 $300.00
10 $2,750.00
Depth OF Market Order Enkry Chrl+4
Order Defaults, .
Clear After Submit
Cankrack Sefup...
Confirmations Surhbinl Prre Last Croc

Motifications

Show Cancelled Orders
Show Rejected Orders

| New Fil
Modify or Cancel Failed

m OECTrader Demo

-,

Cloze

\_‘l) & fill [100=31 298, 25] has been added inta Order #733150

Sound alerts

Customize different sound alerts to make you aware of trading events such as cancel failed, fill received, order

accepted etc.

You can customize with any wave (.wav) file or our programmed files which come with the software.

Decide if you would rather hear a sound or see an alert box.

To access Sound Alerts:

a. Communications > Sound Alerts
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m Alert Settings

Channel Sound Level
Cancel Failed < default: Alert Bow
Dezk Meszage <default: Sound
Fil Received <default: Alert Bow
b odify Failed <default: Alert Bow
Order Accepted <default: Sound
Order Cancelled <default: Sound
Order Completed <default: Sound
Order Filled <default: Sound
Order [2zued <default: Sound
Order Rejected <default: Alert Box

<default: v E

Level | Alert Bow L

o) (o)

To configure:

a. Highlight the channel that you want to assign the sound to.

b. Hit "Browse" and search your computer for (.wav) sound files. Note: The default windows .wav files
are located: (C:/WINDOWS/Media)

C. Hit "Play" to preview the selected sound.

d. Level: Set "Alert Box" if you want an alert pop-up along with the sound. Or, select "Sound" if you
want sounds only.

e. Hit "OK"



Overview
File

Logon

When disconnected from the APPLTrader, selecting Logon will present a dialog box to connect. This will require your
Username and Password. As an option you may also select for the APPLTrader to Auto Reconnect in the event you
lose connection from the APPL servers. Once the Username and Password have been filled in click Logon to
connect or Cancel to abort the process. Note:(Username and Password are case sensitive).

-,

m OECTrader Demo

Uszer Mame: serTest

m QECTrader Demo

Password; | =

File | Accounk  Orders
Yersion: | 31,04
| Logan
A, Auto Reconnect
Exit [ Logon H Catizel
Logoff

To logoff the APPLTrader, select File then logoff. This will present an Exit Confirmation dialog box recapping your
daily activity. From this dialog box you can confirm the Exit or Stay Logged On. This selection will keep the
APPLTrader on your screen however it will be logged off from the servers.

m OECTrader Demo

File | #ccount  Orders

| Logaoff | Avg.

Exit Logaff

Exit

This feature will provide the same functionality as the Logoff and in addition it will close the entire APPLTrader
application.
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m OECTrader Demo
File | Account  Orders
Logoff A
Exit |r
m Exit Confirmation
1 Wwiorking Orders
1 Filled Orders
Aocount Symbol | #Prev | #Bought | #5old | Met Pos
DERMOZRE30 BCLE i 0 1] i
DERMOSR339 BCLIE - 0 1] -
DEMOZ5830 ESLE 10 0 1] 10
DERMOSR339 ESLIE 20 20 1] 40
E xit l [ Stay Logged On
Account

m OECTrader Demo

File | Account | Orders  Communications

Average Positions

Sy Detailed Positions Id
ECLI 1]
ESL Select Account L

Accounk Filker, .

Average positions
Displays the average positions open on each specific contract that has been traded.
In order to go flat in a specific contract:

a. Inorderto go flat in a specific contract, left click on the position and click on "Exit F2". This will immediately
transmit a market order for the contract selected to flatten the position.

b. In order to go flat in all current contracts with open positions left click the "Exit Al"l. This function will
immediately transmit a market order to exit all contracts with open positions.
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Average Posibions LA
Symbol | HBought | Awg BuyPrice | #50ld| Awg Sell Price | MetPos|  $ Total PAL| | E¥IEFS
Exit all

ESLIE 20 1293.75 1] .00 20 F250.00

Detailed position

Shows each contract that has been traded specifically. Exit or Exit All the same way as the Average Position window.

Detailed Positions ERER|
Symbal | Awg. Buy Price | Awa. Sell Price | Amount Fealized PAL Open P/ Tatal PAL || EEF2
Exit &l
ESLE 1293.75 0.00 20 noouso 2a0.000sSD 28000150

Select Account

If trading multiple accounts, left click the upped area where it says "Account: DEM0O85399", choose the account you
would like to trade. This same function can be accessed by the keyboard function CTRL-A.

=

Accounk: DEMOSSZ99

DEMOZ5830
DEMOB5399

Account Filter

The Account Filter allows the trader to select any account they are assigned to see Open or Completed Orders on
the APPLTrader.

Select Always Show Selected Account and the APPLTrader will automatically display the orders of the selected
account.

m Account Filter Dialog M

DEMOZ5830
DEMOB5333

Always Show Selected Accaunt

| Toggleasl || cieaan || ok || Cancel
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prd ers

m OECTrader Demo

Symbaol | HBo

ECUE
ESUE

<

-.-’-'-.v.erage Position

Accaunt
DEMOZRS30

File fccount | Orders Carmmunications Quotes  Wiew

Repi

Abbreviated Order Enkry Chrl+1
Turbo Order Enkry Chrl4+2
Rapid Crder Enkry Chrl+3
Depth OF Market Order Enkrw Chrl+4

Crder Defaules, ..
Clear after Submit

Contrack Setup...
Confirmations

Motifications

Show Cancelled Orders

Show Rejected Orders

Order Tickets

Abbreviated Order Entry (AOE)

Simple way to trade within the platform

Side kdarkeat Selection

(%) Buy Cluaritity S ymbol

O Sel . | |Esus ™
Order Spacs

Type: | Market v Flag: | Mone

| BLMT F3 | | B-MKT F4 |

New Order F8 | | SLMTF5 | [ 5-MKT Fé |

Template:

Turbo Order Entry (TOE)

a. Create a number of orders at one time

b.  Can transmit multiple orders concurrently

c. Allows you to load and save orders from excel.

10
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Turbo Order Entry (4 |
Account Side [ty Symbol | Type Flagz Price | Prce? | Statuz

[+] DEMO25830 Buy 4 BALE b arket Mone Ready to zend
DEMOZ5830 Sell 15 ESUB Lirnit GTC 1.60 Feady to zend
DEMOZ5330 Buy 4 BEUB b arket Mone Ready to zend
DEMOZ5330 Buy 15 EDUB b arket Mone Ready to zend

B 2]

Mew Order Transmit B-LMT B-MKT S-LMT S-MKT | Submit &l Delete Clear | (& Load

Rapid Order Entry (ROE)

Advanced method to trade with specific amounts and settings.

R apid Order Entry [
Auta Factor Settings

.

Bup StopLimt (0.00 (2] 0.00 2] Stop 1295.75 [ Limit 129575 4]
Sell Limit 000 2 Limit 1295.75 |2 Sell Limit
Cluantiby Suyrbol
0 w| [ESUE " Last 1295.75
= . Size =

Bid 129550 . Sell Bid
Auta Factor Settings
Buy Limit 000 2] Limit 1295.75 (2
SellStop Limit 0.00 (3] 000 2] Stop1295.75 3] Limit 129575 |3

Depth of Market Order Entry (DOM)

Allows you to launch DOMs from here

[N

1
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Depth Of M arket Order Enby [
Symbot |BAUE  [v| [Launch |  Symbok Launch
Symbok | |»| Lewch | Spmbok | ] Launck
Symbok | |»| Lewch | Spmbok | ] Launck
Symbok | |v| Lewch | Spmbok | [v] Launck
Symbok | |v| Lewch | Spmbok | [v] Lounck

Order default

Can create default orders for each account what will appear when a new order is being placed after clicking on NEW
ORDER in the AOE.

r Order Defaults -
Account: | DEMD25830 v
Drefault Order for
Bup/Sell: |Eu_l,l [VI
Symbal; |ESL|E [v]
OrderT ype: | b ark: ezt [V]
[ s ] [ Cancel ]

Contract Setup

1. Every contract that appears in the SELECTED box will appear in the drop boxes
2. Can add market and groups
3. Can customize each contract

4.  Give each contract a default quantity (QTY).

5. Change the contract months that are traded.

Confirmations

As a safeguard a trader can turn on the "Confirmations" feature in APPLTrader. This gives the trader an opportunity
to confirm the order before the order is sent for execution. This feature is optional and is turned on by default.

12



OECTrader Demo

Overview

Notifications

File  Account | Orders | Communications Quotes  Wiew  Reporks Setup Toolbox  f
Abbreviated Order Enkry Chrl+1
Symbal | #EBo Turbo Qrder Enkry Chrl+2 Pos| % Tatal PAL
ECUE Rapid Order Enkry Chrl+3 5 $950.00
ESLE 10 $2.625.00
Depth OF Market Order Entry Chrl+4
Crder Defaulks., ..
- ,
Average Posiion Clear After Submit
Contrackt Setup...
Py | Confirmations 2 | Mew Order
DEMO 25830 Notifications > Cancel Order [
Showve Cancelled Qrders
« | show Rejected Orders
(€1 m [
m Order Confirmation
-~ Account: DEMO25330
O Send BUY 5 BAUG MEKT?
[ k. ] [ Cancel

If a trader wants to be notified by an alert box when an order has been filled or if an order modification or cancellation

failed.

13
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m OECTrader Demo

File  Account | Orders | Communications  Quotes  Yiew  Reports  Setup Toolbox  Help 0
abbreviated Order Entry Chrl+1 |
Symbol | #Eo Turbo Order Enkry Chrl+2 _P.;.S 4% Toatal PAL
EEHEE Fuapid Order Enkry Chrl+3 'Ig $2$§gggg

Depth OF Market Order Enkry Chrl+4

Crder Defaults, .,

.. w | After Submik
Ayerage Position =ar ATter SUbm

Conkrack Setup..,.

Account Confirmations ' e | ast Cone

DEMOZ5630 | Motifications 1o hewr I
Show Cancelled Orders Modify or Cancel Failed
Show Rejected Orders

.

m OECTrader Demo

\ 12 & fill [100231 298, 25] has been added inta Order #733150

Cloze

Show Orders

To display "Cancelled Orders" and/or "Rejected Orders" in the "Completed Orders" window check the options "Show
Cancelled Orders" and/or "Show Rejected Orders" respectively.

Account Order # | State Side [ty | Symbal Ay Price
DERMOZ5530 778834  Cancelled By 0/3 ESUB
DERMOB5399 780529 Completed By 20420 ESUG 1297.75
DERMOS5399 783150 Completed Sell 1040 ESUG 129825
DEROZ25230 783258 Rejected By 000 BCUB

Communications

Sound alert

e  Customize different alerts to make you aware of trading events such as cancel failed, fill received, order
accepted etc.

®  You can customize with any .wav file or our programmed files which come with the software

e  Decide if you would rather hear a sound or see an alert box.

14



Overview

m Alert Settings

Channel Sound Level
Cancel Failed < default: Alert Bow
Dezk Meszage <default: Sound
Fil Received <default: Alert Bow
b odify Failed <default: Alert Bow
Order Accepted <default: Sound
Order Cancelled <default: Sound
Order Completed <default: Sound
Order Filled <default: Sound
Order [2zued <default: Sound
Order Rejected <default: Alert Box

<default: v E

Level | Alert Bow L

o) (o)

Message History
®  See your message with the broker you spoke with, when about what and what the broker said.

e  Click on view to view within the software or PDF to export into a PDF file or Excel to export into a .exe file

P ¢ Message History

File
Begin Date: End Date:
08/23/2006 00:00  [»| | 08/23/2006 2353 [+ | view | [ _POF | [ Escel |
H 4 Page1of1 bk M =]
Chat History for DFormica57
Time From -> To M
08/23/2006
15:28:33.607 DFormicas? -= Danield  |Hello I have a question.
15:28:47.170 DFormicas?y -= Danield | What is the current symbol of th
15:29:13.513 Daniels -= DFormicas? | The current symbaol for the mini =
15:29:23.763 DFormicas? -= Danield | Thank you !
15:29:35.730 Danield -= DFormicas? | Your Welcome!

15
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Chat/Research Windows

Close/Open

Click on the RESEARCH options; if the option has a check next to it then it's available to view; if it doesn’t have
a check then it isn’t available to view.

3:41:39 PM RISK
Rizk wiolation Max credit = 0 USD Order would need credit of 60712.52
15D [zash available iz 37862 48 150]

Click on the CHAT option. If it is already checked it will uncheck the CHAT option and it'll be unavailable to
chat.

Chat

3:28:36 PM to Daniel&:Hello | have a question. A | | Darield
3:28:50 PM to DanielA\what iz the current symbol of the
rriti SP 500 7

32917 PM Danieli: The current spmbaol for the mini S&P
A00 iz ESUR

D-0-F Dl b D mmanllA - Tl-ande oman |l

Quotes

16
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File  Account  Orders  Communications

Average Positions

Symbal | #Bought | Avwg Buy Price | #5old

BCLG 0 0.00 0
ESUG 0 0.00 0

Awerage Positions | Detailed Positions |

Open Orders

Account Order #| State By

<] 1

Abbreviated Order Enty
Side hdarket Selection
) Buy Quantity Symbal
O Sel 0 v |Zveos
Order Specs
Type: | b arket &I Flag: [

Quotes | Yiew  Repaorks

Setup

Add Market

add Market Group
Remove Market
Remaove All Markets

Insert Blank Line

Movwve Up
Mave Dawn

Sort By Alpha

Cuskom Price Format
Fonk...

Rename...

Add Price Alert
Remove Price Alert

Wi Price Alerts, ..

[l |
Chart

Column Setup. ..

Expork ko C5V...

Add Remove Market and Group

Add Market
a. Add a market by contract
b.  Pit contracts are snap-shots

c.  Electronic contracts are streaming

m Market Selection

Contract Title: | BALIE

[ OE. ] [ Cancel

X]
]
|

Add Market Group
a. Add an entire Market Group

b. Nearest month or all months

Overview
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m Market Group Selection
Group Title: b onths:
Curmencies w MHearest 1 | w

(] ] [ Cancel

Remove Market

Remove the highlighted market from the Quotes window.

Remove All Markets

Remove all markets from quote window.

Customize Appearance

Quotes

Symbaol Last | Lastol Bid| BidSize Bzl | AszkSize ||
E5SLG 1297.50 1 1297.25 R2T 1297.50 340 1
MNOUE 1867.00 13 1567.00 13 1557.25 251 1
ERZUE E99.2 2 £99.1 K1l £99.2 3

ZBLG 11000 1 11000 1477 110m 276

ZHUEB 106 305 a0 106 30.0 3249 106 305 728 10
ZrE0E E23.3 1 G204 3 215 1

Insert Blank Line

Insert blank line just above the highlighted contract in the Quotes window.

Move up/Move Down
Move the highlighted contract up/down

Sort by Alpha

Sort all the contracts in the Quotes window in alphabetic order
Customize Format

Custom Price Format
Allows customers to change the decimal format of LAST, BID and ASK columns within the Quotes window.



m Price Format
BSLIE

Default Format Default Mulipler
wiZ *0.00000
wid *0.00001
/8 *0.0001
w16 *0.00
w32 00
u/B4 01
w128 "1
n/206 10
0 100
na #1000
Q.00 *10000
0.0o0 *100000
0.0000 * 1000000
0.00000
0.000000
0.0000000
0.00000000
0.000000000

Apply ] [ Cancel

Font

Customize the font of your Quotes window.

o~

Font
Eont: Faont style: Size:
kicrozoft Sans Senf R egular a [ K ]
) Microsoft Sans Senf & ]| | Fegular a ”
(} Monotype Corsiva [talic: 9
(} M5 Outlook Buold 10
{} M5 Reference Sans 5| | Bold ltalic 1
g M5 Feference Specia 12
Y Boli 14
} Palating Linotype M 15 M
Effects Sample
[ ] 5trikeout
AaBbv
[ ] Underline sBBYYZ2
Script:
|'W'estern B]
Rename...

Ability to rename the title of the Quotes window.

Overview
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P . Quotes T est
Custom name of Quote... Symbol Last| Last\fol Bid | BidSize
Please enter New name: ESUG 1297.75 0 1297.50 528
’ GALIG 76.16 4 76.16 7
[uates Test GCLI6 90.11 1) 90.17 17
GELI6 127.81 3 127.87 22
Ok, ] [ Cancel GG 3.674 1) 3.6713 240
6506 309.3 G 309.7 21

Quote alerts

Add,Remove Price Alert

To add an alert, select the desired contract from the Quotes window. Select "Add Price Alert" to get to the
below window. Enter Alert Price, criteria and the options text.

-,

m OECTrader Demo

Alert Price | 1238.00 3 ) <=
O =

1 Auto
Alert Tewxt [optional]
ESUE went below or equal to 1233.00

k. l [ Cancel

To remove an alert, select the desired contract from Quotes window. Right click and select "Remove Price
Alert".

View Price Alerts...

View all current price alerts. To remove one alert, select one alert and hit "Remove". To remove all alerts, just
hit "Remove All".

20



m Price Alerts

Market | Price
ESLE ¢=1298.00 ESUG went below or equal to 1238.00

Uzer Meszage

Edit

Femove Remove All

View
Yiews | Reports  Setup  Toolbox

Lock Windows |

Show Tabs
Layauk ]
Positions 3
Account Summnary
Cpen Orders
Completed Orders —
Order Tickets 3
Quokes
Depth of Market r
Charts k
Communications 3 o

Lock/Unlock Windows

stay in the current location and are not configurable.

1.
2.
desired.
Layout
Save...

Save an already customized layout. Enter a name for the layout and hit "OK".

Overview

Click on View, and then LOCK WINDOWS. When a check is next to LOCK WINDOWS then the windows will

If there isn't a check next to the LOCK WINDOWS option the windows are unlocked. Please configure as

21
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Save Layout
Enter name of layaut;

MyLapout]

[ Ok, ] [ Cancel

Once the layout is saved it will be available under View > Layouts.

Wiews | Reports  Setup  Toolbox  Help Cpen a Live Accounk
Lock Windows
Show Tabs
| Layauk k | Save. ..
Positions 3 Delete. ..
Account Summary Restore Default Layout
Open Orders MyLavout]
CDITlp|EtEI:| Orders e
Crder Tickets 3
Quates Account Order #
DEROBE3299 FB0529
Depth of Market P DEROB5399 783150
Charts N DERMOZ5330 ¥83258
DEROB53299 783704
Cornrnunic ations 3 b
Delete...

Delete a saved layout. Select the layout that you want to delete and hit "OK".
Configure windows

Positions Window

Ability to toggle back and forth from Average Positions to Detailed Positions.

Wiews | Reports  Setup  Toolbox  Help Cpen a Live Accou

Lock Windows
Show Tabs Tatal PAL

Layout » SF2.00Ush
-288.00 USD
| Pasitions » m Average Positions
Account Surmmary Detailed Positions
Open Orders

Other Windows

22
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Account Summary, Open Orders, Completed Orders, , Order Tickets, Quotes, Depth of Market, Charts or
Communications.

Access Reports

Each report can be filtered by one account or all and date ranges. They can be viewed in PDF or Excel format.
Access any one of the following reports.

Daily Fills

Shows the dalily fills for the designated dates indicated above.

Daily Activity

Daily Activity is the number and contracts that you traded on the dates indicated above.

Working Orders

Working orders are the orders that are working or have been working from the date increment from above.

Rejected Orders

This report indicates all the rejected orders within the dates entered above.

Order Statistics

The number of orders placed, orders cancelled, orders filled, open orders, the number bought and the number
sold for the date above and within the contracts that were traded.

Order Ticket Statistics

The method the orders were placed weather they be AOE, Turbo, Rapid or DOM and the order statistics for
each order method.

P/L Summary

The Profit and Loss for each trade placed and the order statistics, for the date(s) provided above.

Chat History

The chat history is recorded for quick reference and for security reason. This allows traders and brokers to view
previous conversations between trader and broker.

News History

The Research comments that have been presented by the Brokers to the entire APPL population. These
messages are important details from the broker involving major Futures issues.

Order Details

Provides a detailed description of each trade made and the necessary identifications for each detail within the
order placed.

Daily Positions

Daily Positions represents the positions for the account above between the dates indicated.

Trade Log

Provides a detailed description of the trades placed. The trade log provides the time, side, the contract, the

price and the amount at which each trade was place.

Open Orders
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Provides the list of open orders that exist with in that account.

Setup

Shortcut Manager

Allows you to customize the hotkeys for a vast amount of APPL Trading options.

Action Keys -
File
Logaon
L ogiff
E xit
Orders
Abbreviated Order Entry Chrl+1
Turbo Order Entry b adifiers:
Rapid Order Entry ]
Drepth Of Market Order Entryp Cul [] shift [] Al

Contract Setup Key:
Clear &fter Submit

1 | | Reset
Turn ofn Mew Order Confirmation -

Restare Defaulq [ Ok ] [ Cancel ]

Quick Start

Allows you to view the quick start menu which has a direct link to the Quick Start Guide, Depth user’s guide and all
the contact info for customer service and support.

24



Toolbox

Glossary
Display APPL'’s Glossary web page with your default browser.

URL: http://www.applfutures.com/glossary terms.php

Help

Contact Us

You can email us your questions at appl@applfutures.com

About

Displays the current information of the platform that the trader is currently running.

Open Live Account (DEMO ONLY)

Demo Only

Display APPL’s Online Application with Electronic Signature web page with your default browser.

URL: http://www.openecry.com/ibportal/Pages/ApplyOnline.cfim?WLID=44

Overview
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File

Logon

When disconnected from the APPLTrader, selecting Logon will present a dialog box to connect. This will require your
Username and Password. As an option you may also select for the APPLTrader to Auto Reconnect in the event you
lose connection from the APPL servers. Once the Username and Password have been filled in click Logon to
connect or Cancel to abort the process. Note:(Username and Password are case sensitive).

-,

m OECTrader Demo

Uzer Mame: |UserT est

m OECTrader Demo Password: |1
File | Account  Orders
Yersion: | 3.7.0.4
| Logan
g, Auta Reconnect
Exit [ Logan l [ Cancel
Logoff

To logoff the APPLTrader, select File then logoff. This will present an Exit Confirmation dialog box recapping your
daily activity. From this dialog box you can confirm the Exit or Stay Logged On. This selection will keep the
APPLTrader on your screen however it will be logged off from the servers.

26



‘m OECTrader Demo

File

fccount Orders

Logan

Ay,

Exit Logaff

Exit Confirmation

Wharking Orders
Fillod Ciclers

Accaunt Symbol | #Prev
DEMO25830 ECUE ]
DEMO25530 ESLEG 10
DEMOE5399 ESLG 20

#Bought | #Sold| MetPoz
0 1] i

0 1] 10

20 1] 40

E xit

] [ Stay Logged On

Exit

This feature will provide the same functionality as the Logoff and in addition it will close the entire APPLTrader

application.

File
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m ﬂ!! | raaer Bemn

File | #Account  Orders

Logan

Logaff A

5

!

Wworking Orders
Filled rders

DEMOZ5830 BCUE

DEMO25820 ESUE
DEMOAR5333 ESUE

Account | Symbol | #Prev| HBought| #5old| MetPos|

5 0 1] 5
10 0 1] 10
20 20 1] 40

E xit

] [ Stay Logged On

28



Account

Average positions

Displays the average positions open on each specific contract that has been traded.

In order to go flat in a specific contract:

In order to go flat in a specific contract, left click on the position and click on EXIT F2. This will immediately

a.
transmit a market order for the contract selected to flatten the position.

b. In order to go flat all current contracts with open positions left click the Exit All. This function will immediately
transmit a market order to exit all contracts with open positions.

Symbol | #Bought | Awg BupPrce| #Sold | Awg Sell Price | Met Pos $ Total PAL
BCLE 0 0.00 il q0.03 -5 FE0.00 | | Exit Al
ESLIE 20 129375 0 0.00 20 $250.00

Detailed position

Shows each contract that has been traded specifically. Exit or Exit All the same way as the Average Position window.

4| »
Symbal | Awg. Buy Price | Awa. Sell Price | Amount Realized P/L Open P/ Total P/L
ECUE .00 a0.03 -5 noouso 11000 0sD 1000 USD | Exit Al
ESLIE 1293.75 0.00 20 noouso 25000050 25000150

Select Account
If trading multiple accounts, the trader has the ability to switch from one account to the other to trade.

Left-click the upper right area where the current account number is being displayed. Or, Keyboard function
CTRL-A

a.

b.  Check the account that you want to trade.

BEX

Account: DEMOS5399

DEMOESE30

DEMOR5399

Account Filter

The Account Filter allows the trader to select any account they are assigned to see Open or Completed Orders on
the APPLTrader.
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Select Always Show Selected Account and the APPLTrader will automatically display the orders of the selected
account.

Account Filter Dialog = @

DEMOZ55830
DEMOE5333

Alwaysz Show Selected Account

| Toggesl || cCearan || ok || Cancel




Orders

Order Tickets

Abbreviated Order Entry (AOE)

Simple way to trade within the platform.

" { . }
Side hdarket Selection
() Buy Quantity Symbol
1] ESUE
Order Specs
Type: | Market v Flag: | Mone v
| B-LMT F3 | | B-MKT F4 | Template: v
| Mew Order Fa | | 5-LMT F5 | [ 5-MKT FE |

Side

Buy

Purchase a certain commodity at a certain date in the future at a pre-set price. The future date is called the
delivery date. The pre-set price is called the futures price. The price of the commodity on the delivery date is
called the settlement price. The futures price, naturally, converges towards the settlement price on the delivery

date.

Sell

Sell a certain commodity...
Market Selection

Quantity

Amount of contracts you desire to trade.

Symbol

Code by which futures are identified on a futures exchange; a corporation which provides the facilities to trade
futures contracts

Order Specs

Type
Market (MKT)

Orders to buy/sell at the best possible price as soon as possible. They are the first orders to be filled at
any given price, and are used to enter or exit the market quickly, regardless of the current price.
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Limit (LMT)
Orders generally used to buy/sell at a specified price, or better. They don’t move once the limit price has

been reached, i.e., they do not become MKT orders.
Stop (STP)

Orders are traded only when the MKT price trades at or “through” the STP price.

a. Buy STP orders is placed above the current MKT price and is transformed into a MKT order when
the futures price trades or is bid at or above the STP price

b. Sell STP order is placed below the current MKT price, and is transformed into a MKT order when the
futures price is traded or is offered at or below the stop price
Stop Limit (STP LMT)

Orders are used like STP orders, but execution is restricted to the limit price or better. They do not become
MKT orders once the STP price has been reached. No order can be guaranteed an execution.

a. Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order
will not be filled unless the price remains at or drops below the limit level

b. Sell STP LMT is activated when the commaodity is offered or traded at or below the STP level, the
order will not be filled unless the price remains at or rises above the limit level
Market If Touched (MIT)

Similar to STP orders in two ways:

1. They are activated when the price reaches the order level
2.  They become MKT orders once they are activated

MIT orders are used differently from STPs.

Buy MIT below the MKT price to establish a long position.

Sell MIT above the MKT price to establish a long position.

MIT orders are not allowed on CBOT but are used on CME.
Market To Limit (MKT2LMT)

Market On Open (MOO)

A buy or sell order in which the broker is to execute the order at the market's opening. It does not
guarantee the trade will be executed at the listed opening price, but the trade will be executed within a
range of prices, or not at all.

Market On Close (MOC)

A buy or sell order which is to be executed as a market order as close as possible to the end of the day.
Market On Pit Open (MOOPIt)

This order type is similar to the MOO however it only applies to electronic contracts that have
corresponding pit contracts.

Electronic contracts can be placed MOOPIt if traders want the contract to be traded at the opening of the
Pit for the corresponding pit contracts opening.

i.e. ES has a next day opening of 4:30 EST but if a trader places a MOOPIt type then the order will be
placed when the S&P opens at 9:30 am EST
Market On Pit Close (MOCPiIt)

This order type is similar to the MOC however it only applies to electronic contracts that have
corresponding pit contracts.

Electronic contracts can be placed MOCPIt if traders want the contract to be traded at the closing of the Pit
for the corresponding pit contracts close.
Trailing Stop Loss (TrSTP)

A complex stop-loss order in which the stop loss price is set at some fixed percentage below the market
price. If the market price rises, the stop loss price rises proportionately, but if the stock price falls, the stop
loss price doesn't change. This technique allows an investor to set a limit on the maximum possible loss
without setting a limit on the maximum possible gain, and without requiring paying attention to the
investment on an ongoing basis.

Trailing Stop Limit (TrSTP LMT)

Place a TrSTP which is a complex stop-limit order in which the stop limit price is set at some fixed
percentage above or below the market price. If the market price falls or rises, the stop loss price fall or rise
proportionately, but if the stock price rises or falls, the stop limit price doesn't change. This technique



Orders

allows an investor to set a limit on the maximum possible loss without setting a limit on the maximum
possible gain, and without requiring paying attention to the investment on an ongoing basis.

Once the TrSTP has been activated at or above/below depending on the SIDE the commodity was traded;
the order will not be filled unless the price remains at or drops/rises in relation to the LMT level.

Flag
Good Till Cancelled (GTC)

Order remains on the books until cancelled and can be filled at an undesirable time if forgotten
Fill or Kill (FOK)

LMT orders which, if not filled immediately, are cancelled
Immediate or Cancel (IOC)

LMT orders which, if not filled immediately, are cancelled
AON

Hot Keys

Template

Have the ability to create a template for quick and easy trading of specific contracts

Save/Delete.

a. i.e., BUYthe ES at5 QTY with MKT type and GTC flags. Click on save and when this template is
referenced to it will ALWAYS appear as above: BUY 5 ES MKT GTC

b. Traders can have as many Templates as desired for quick an easy trading made for the trader.
You can have different template for the same contract.

d. DELETE refers to the template that is highlighted in the REMOVE TEMPLATE drop box. This feature is
nice if you have increased your volume and desire to revise your old template.

Transmit/New Order

Exit MKT

a. Inorderto EXIT (F2) a Position quickly, traders are able to highlight the position they wish to exit, and
select EXIT or hotkey (F2).

b. Once EXIT has been activated the AOE box will display the exiting trade for that position in order to make
it FLAT. Click on Transmit and the exiting trade will be placed.

Trade Contract
a. Place atrade by clicking TRANSMIT

b. Remove the current order information for a new trade by clicking NEW ORDER.

Turbo Order Entry (TOE)

a. Create a number of orders at one time
b.  Can transmit multiple orders concurrently

c.  Allows you to load and save orders from excel.
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Turbo Order Entry (AR
Account Side Gk | Symbol | Type Flagz Frice | Prce2 | Status

[+] DEMOZ5830 By 4 BALIE b arket M one Feady to zend
DEMOZEE20 Sell 15 ESUR Lirnit GTC 1.50 Ready to zend
DEMOZ5330 Buy 4 BEUEG b arket Mone Ready to zend
DEMOZ25830 By 1% EDUEG b arket Maone Ready to zend

£ >
Mew COrder Transmit E-LMT B-MKT S-LMT S-MKT | Submit &l Delete Clear | [ Load B

Side

Buy/Sell a certain commodity at a certain date in the future at a pre-set price. The future date is called the delivery
date. The pre-set price is called the futures price. The price of the commodity on the delivery date is called the
settlement price. The futures price, naturally, converges towards the settlement price on the delivery date.

Qty

Amount of contracts you desire to trade.

Symbol

A future symbol is a code by which futures are identified on a futures exchange; a corporation which provides the
facilities to trade futures contracts

Type

MKT

Orders to buy/sell at the best possible price as soon as possible. They are the first orders to be filled at any
given price, and are used to enter or exit the market quickly, regardless of the current price.

LMT

Orders generally used to buy/sell at a specified price, or better. They don’t move once the limit price has been
reached, i.e., they do not become MKT orders

STP
a. Orders are traded only when the MKT price trades at or “through” the STP price

b. Buy STP orders is placed above the current MKT price and is transformed into a MKT order when the
futures price trades or is bid at or above the STP price

c. Sell STP order is placed below the current MKT price, and is transformed into a MKT order when the
futures price is traded or is offered at or below the STP price

Price

The factor at which you want the order to be placed in regards to the current price. i.e., ES MKT price is 1299.5;
PRICE will be placed 1.5 ticks above/below that current price . The Price will be placed above or below the MKT
price depending on the SIDE you trade on.



Price2

Orders

PRICE 2 is only used if two prices are necessary for a trade. i.e., If a customer were to BUY 5 ES STP LMT PRICE
would be 1.5 ticks above the MKT and .5 Ticks below the PRICE once the STP has been reached

Status

1. Confirms what key pieces of information are needed in order to complete an accurate trade

2. Will say READY TO SEND if the order ticket has been completed
Toolbar/Hot Key

Transmit/new order
a. Place atrade by clicking TRANSMIT

b. Remove the current order information for a new trade by clicking NEW ORDER.

Submit All

Enter a variety of trades manually or load from excel and place all the orders at the same time

Delete/clear
a. DELETE will remove the highlighted order entry
b. CLEAR will remove ALL order entries

Load/Save
a. Load from .csv files or from .exe file types.

b.  Save the order entries to .csv files or .exe file types

Rapid Order Entry (ROE)

Advanced method to trade with specific amounts and settings.

R apid Order Entry
Aubo Factor Settings

Bup StopLimt 0.00 (4] 000 [2 Stap 1295.75

Sel Limit 000 3 Limit | 1295.75

bAarket Selection Ask 1795 75

[uantity Symbal

0 «| [ESUE v Last 1295 75
Bid 129550

Aubo Factor Settings

Buplimt 000 2] Limit 1235.75

Sell Stop Limit | 0.00 = 0.00 % Stop 123375 5 Limit 1235.75

.v.

.A.
£

.A.
b

e
-

3 Sell Limit
Size
222

.
poalll  Sell Bid

Auto Factor Settings

Buy Stop Limit
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e  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not
become MKT orders once the STP price has been reached

®  Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order
will not be filled unless the price remains at or drops below the limit leve

®  No order can be guaranteed an execution
Factors

The values that you wish to increase your STP order by, i.e., .50 in the first box will increase the STP value
by the factor of .50; The same concept works the second factor box in that it effects the LMT.
BUY STOP

Places the STP LMT prices for the buy STP LMT order
Stop

Buy STP orders is placed above the current MKT price, but is not transformed into a MKT order when
the futures price trades or is bid at or above the STP price; It turns into a LMT order

Limit
LMT order is placed used to buy/sell at the specified price. It doesn’t move once it has been reached,
i.e., it does not become MKT order

Sell Limit
Factors

The price at which you want to place the Sell LMT
SELL LIMIT

Limit
1. Alimit order is an order to buy or sell a commodity at a specific price

2. Can only be executed at the limit price or higher
Market Selection

Quantity

Amount of contracts you desire to trade for the entire ROE

Symbol

e A future symbol is a code by which futures are identified on a futures exchange; a corporation which
provides the facilities to trade futures contracts

(] Is the contract that is traded for the entire ROE

BUY ASK/SELL ASK
BUY ASK

Bid on a commodity at the ASK price
SELL ASK

Sell a commodity at the ASK price
Ask

The ASK price (Offer). The lowest price at which someone is prepared to sell a commodity
Size

The number of sellers at the ask price
BUY MARKET/SELL MARKET

. Will buy a contract of the ROE’s QTY at the MKT price of the ROE’s symbol or

. Will sell a contract of the ROE’s QTY at the MKT price of the ROE’s symbol.
Last

The price at which the ROE’s symbol was last traded
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BUY BID/SELL BID
BUY BID

Bid on a commodity at the BID price
SELL BID

Sell a commodity at the BID price
Bid

Bid Price is the highest price at which someone is prepared to buy a commodity
Size

The number of buyers at the bid price
Auto Factor Settings

Buy Limit
Factors

The value that effects where the LMT order will be placed, i.e., 1.5 will place a LMT 1.5 below the LAST
price
BUY LIMIT

Limit: LMT order is placed used to buy/sell at the specified price. It doesn’'t move once it has been
reached, i.e., it does not become MKT order.

Sell Stop Limit

e  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not
become MKT orders once the STP price has been reached

®  Sell STP LMT is activated when the commodity is offered or traded at or below the STP level, the order
will not be filled unless the price remains at or rises above the limit level.

e  No order can be guaranteed an execution
Factors

e  The values that you wish to decrease your STP order by, i.e., .50 in the first box will decrease the
STP value by the factor of .50;

®  The same concept works the second factor box in that it effects the LMT
SELL STOP

Places the STP LMT prices for the sell STP LMT order
Stop

®  Sell STP order is placed below the current MKT price, but is not transformed into a MKT order
when the futures price is traded or is offered at or below the STP price; turns into a LMT order.

Limit
e |LMT order is used to buy/sell at the specified price. It doesn’t move once it has been reached,
i.e., it does not become MKT order

e Can only be executed at the limit price or higher.

Depth of Market Order Entry (DOM)

Depth of Market Order Entry (DOM)

To view the Depth of Market Order Entry go to "Orders" > "Depth Of Market Order Entry"

Open
To open a DOM window from the Depth Of Market Order Entry:

Select the contract symbol from the drop down then hit "Launch".
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Depth 0f Market Order Entry )
Symbol: |BAUE  |v| [Launch | Symbol Launch
Symbok | |%| Leauech | Swmbok | [ Leunch
Symbok | || Leunch | Swmbek | [s]| Leurch
Symbok | %] Lawnch | Spmbok | [s| Launen
Symbok | || Launch | Spmbok | [w] | Lawnck
View

To open a new DOM, go to "View" > "Depth of Market" > "New..."

Wieww | Reports  Setup Toolbox  Help Qpen &

Lock windows

Show Tabs Total PAL
Layout p | 28000 USD
Positions »

Account Summary

Open Orders

Completed Crders

Order Tickets 3

Quokes

Cepth of Market » m Mew, .,

Charts » ESLiG

ommunications GELE
E7UG

e The only contracts that will appear in the drop box are those that have been specified in the "Contract
Setup..." under Orders

e  Select the account and contract you wish to trade the DOM and hit "OK".
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rm DOM W
Account; | DEMOBE399 M
Contract: | ESLIE kl

[ ]9 H Cancel ]

To open a DOM session, go to "View" > "Depth of Market" > i.e:" ESU6".

contracts you have opened before or are on the default layout.

Wieww | Reports  Setup Toolbox  Help Qpen &
Lok, Windows
Show Tabs Total PAL
Lavaut Y 0.00 LSO
Positions »
Account Summary
Open Orders
Completed Crders
Order Tickets 3
Quokes
Cepth of Market » | Mew, .,
Charts 3 | Folle
ommunications GELE
E7UG
Quotes

Orders

Contracts below the brake Line are

Right-click on the contract within QUOTES and scroll down to DOM, click on it and a DOM will appear for the

guote you have highlighted.

Quotes Test Add Price alert

Symbol

ESUG 1

GA LG

6CLIG Do |
FDAXUG Chart

6EUG ar

606 Column 3etup. ..

gf:—;ﬁ Export bo CSY..,
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DOM - Opening

Quotes box

Right-click on the contract within Quotes window and select "DOM" in the submenu and a DOM will appear for the
quote you have highlighted.

Quotes Test Add Price Alert
Symbol 4
ESLIG 1 |
GALIG
6CUIG DM |
FDAXLUIG h
GEUG Chark
6.6 Column Setup. ..
gf:;ﬁ Export ko CSY...
View

Contracts below the brake line are contracts you have opened or are on the default layout. Select any one of these
contracts to open the respective DOM.

Yiew | Reports  Setup  Toolbox  Help Qpen ¢

Lock Windows
Shon Tabs Total PAL

Lavout , 0.00 USD

Pasitions 3
Accounk Surmraty

Cpen Orders

Completed Orders

Order Tickets *

Quokes

Depth of Market 3 | e, ..

Charts » | ESLG

Zommunications CELE
E¥lG

Depth of Market Order Entry

Main menu "Orders" > "Depth of Market Order Entry"

Charts

Open chart a of the DOM contract you have open currently.
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@ ESUG - Depth of Market (22~ ) OB

Open
ICha
S w (3G ||llf  oemossass -

M m
Ot | 1013 TotalPAL: G} ¥ 300000
Pos: 20 @ 1305.00 [ Exit at MET ] [ Reverse ]

il
1302.00
1302.75
1302.50
1302.25
1302.00
-
| BwMKT || Gotolast || SelMkT |
Bid
# 6A76 - Depth of Market M=)
=R | [ 5 |BfF v 3G [l DEMO99sIs -
Oty T4 TotalPA $0.00
Pos: 0
| CancelBids || Cancelan |
-
T
1 w28
Left Click: LIMIT |75 27 I
Right Click: STOP EE.EE e
w5 Il
-
| BuwMKT || Gotlast || selmkT |

Right Click: STP

1. Rightclick in the green column at the price level you would like to place a buy STPLMT

2. The QTY of the buy STP will appear in the white column next to the price level selected

Left Click: LMT

1. Leftclick in the green column at the price you would like to place a buy LMT

2. the QTY of the working order will appear in the white column to the left of the selected price

Orders
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Offer X
# 6A76 - Depth of Market =Jo/&d

=W | [F # | &F v (A G |G| DEMO99999 -
Gty 1% Tatal PAL 41000
Pos: 1@7523) | Exit atMKT | [ Reverse |
| CancelBids || Canceldll || CancelOffers |

Left Click: LIMIT
Right Click: STOP

[ Buy MET ] [ o to Last ]

Right Click: STP

1. Rightclick in the red column at the price you would like to places a sell STP

2.  The QTY of the working order will appear in the white column to the right of the price selected

Left Click: LMT
1. Leftclickin the red column at the price you would like to place a sell LMT

2. The qty of the working order will appear white column to the right of the price selected
Modify Price/Quantity of an Order

Price of an Order
1. Place the initial order by left clicking in the green column at the price you would like to place a buy limit

2. To modify the price left click the order and drag and drop it to the new price
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# ESZ6 - Depth of Market

FX]

)

| @ & |efF v 34 ||  DEMozssso -
Oty 1% Total PAL $ 662,50
Poz: o

[ Cancel Bids H Cancel Al H Cancel Offers ]

Bid

Right Click: Cancel
Drag: Madify Price

........

Left Click: Modify Oty

F Y

1331.00
1330.75
1330.50
1330.25

1330.00

1328.75

1329.25
1329.00

B

| BuwMET ||

3o to Last

|| seimkr |

Quantity of an Order

1. Place the initial order by i.e., left clicking in the red column at the price you would like to place a sell LMT

2. To modify the QTY left click the original order and select a new QTY from the pop out box

"¢ B =
- N I 1= DEMC25830 - -
Ifr_l_ai"'?é_}lrﬂl |
ity 1% Total PAL: $ BE2.50 14
13
Paoz: 0 12
[ Cancel Bids ] [ Cancel &l ] [ Cancel Offers ] ::1['
:

........ E
| E 1 :
I 133325

| Left Click: Modify Gy
1333.00 Ft Click: Modif

e 133275 Right Click: Cancel
I 1332 R0 I Drag: Modify Price
I 13225 1 k
I 133200 G 2
N 1331.75 1
N 133150 EEHE

- EEm -

| BuMKT || Gotolast || selmkT |

Thumbtack

Orders
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Stay on Top

To make the DOM ticket stay on top of other applications left click on the Thumbtack so it is pointing straight into the
ticket. To allow the DOM to move behind other applications left click the thumb tack again so it is sideways

When the Thumbtack is pointed out to the left this means the STAY ON TOP feature is not active.

BEx]

# 6AZ6 - Depth of Market

| [F & | Bf ¥ (3 G [l | DEMO999 -
Qty: 1% TatalPAL: $0.00
Pos: 0
| CancelBids || Cancelal |
r
75.15
75.14
75.13
75.12
7511
-
| BuwMKT || Gotolast || SelmkT |

When the Thumbtack is pushed in the STAY ON TOP feature is active and will stay on top of all other applications.

BEx]

# 6AZ6 - Depth of Market

@ || @ & |F v (35 |Mll |  DEmMosgsss -
Oty 113 TotalPAL: $0.00
Poz 0
| CancelBids || Canceltu |
il
75.15
75.14
75.13
75.12
7511
-
| BwMKT || Gotolast || SelmkT |

Display Options

Auto Center Price
This Options keeps the MKT prices in the center of the viewable length of the DOM
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Open Order Stats

Provides the total number of open orders for each SIDE at the bottom of each column.

Auto Sum Bid/Ask

e  Adds up the total Volume traded for the BID and OFFER and displays it at the bottom of the respective
columns

®  Open Order Stats and Auto Sum Bid/Ask CAN NOT be active at the same time

Open P/L

Open P/L represents the amount of Profit and Loss when the open position exists. If Open P/L is not checked then
the Total P/L will show. The Total P/L represents the whole profit and loss from all your trades in that DOM.

Open Pos Price

Your open positions average price will be displayed by an arrow. You will see it displayed on the Offer if you are
short and on the Bid if you are long.

Show Tooltip

This options is for first time users of a Depth of Market order ticket. The tooltip allows traders to see what type of
order they can place and where they can place it on the DOM

-

& DOM Setup
Display | Wumber Pad | Font & Colors

Dizplay Items

[] Auta Center Price [] OpenPiL

[] Open Orders Stats Open Pos Price

Auto Sum BidAdsk Show Tooltip

[ k. l [ Cancel ] [ Apply

Number Pad

1. Configure the number pad to the amounts you desire to have in each key punch options

2. Click apply and the Number pad will change without having to reload the Number Pad
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@ DOM Setup x|

Configure the number pad

Setto Zera
1 2 3
4 4] 10
15 0 20 | BO

Set to Defaulk:

[ k. H Cancel ][ Apply

Font & Colors

e  Allows Traders to change the DOM and the colors of the orders

e OCO'’s, Stops, and Trailing Stops can be customized to their own recognizable color for easy view and quick
reference.

[ ]

The option to restore the defaults is available if the color scheme does not work for the trader

# DOM Setup X|

Fart

AaBbyyez [ Change font . ]

Wwhorking order colorz
oco: | |
Stop: | NN v |
TraiingStop: | I~

[] Save az Defaults [ Load Defaults ]

[ k. H Cancel ][ Apply ]




Orders

Red/Green Indicator

We have also added the high and low of the launched contract to the DOM order ticket. The high of the day is
displayed by a red line and the low is displayed by a green line.

Number Pad

Touch Pad

Number pad is able to be opened and closed with the options at the top of the page that looks like a number pad.

You can change the number template within Display.

# 6AZ6 - Depth of Market

[ setozen 4[]8 ¥ 36 )

Oy | 1% TatalPL

Pos: 2 @753 @
[ CancelBids | [  Cancelanl |

Set to Defaulks

F Y

75.34
B @ | 7533

OCO Orders

Order Cancel Order (OCO)
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" .| X
= | [ [5F ? 3 S |l | DEMO4704 - |
Qty: 5% TatalPAL: $0.00

Pos: 0 @ Confirm orders
a Bup BESZE LMT 1324.50
Buy 5 ESZE LMT 1326.00

[ Mo

i

5

| v

.

10 1326.00
B 1552 132575
2720 132550
2660 1325.25
4240 1325.00
I 1324.75
1324.50
Left Click: OO LIMIT
| BwMkT || Gotolast || selmkr |

1. OCO (One cancels other) is a pair of orders sent together.
2. Currently only Limit and Stop orders of one side (buy limit/buy stop or sell limit/sell stop) are supported.

3. Tosend OCO orders, user needs to check OCO toolbar button, and then send two orders in usual way.
Another way to enter a single pair of OCO orders, user could hold SHIFT key while clicking.

4.  After clicking first order, the price would be marked with different color, until second order is entered. To cancel
OCO order entry after first order is entered, user should uncheck OCO toolbar button (or release SHIFT key).

5. Working OCO orders are displayed in blue color by default.

Order Flags
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# ESZ6 - Depth of Market

L

BX]

=4 | [ &
by 0 {:}
Fos:

DEMOESE30 -

dlella & i

Toatal FAL:
1]

$1.000.00

Bi

2
(=]
—
&n

f=h
P | | e
== ES
g8 F3| 63|
==&
E

-
==]
¥=1

F

1329.00
1328. 75
1328.50
1328.25
1328.00

1327.75
1927 AN
-

o to Last

Offer

Order Flags
) Mone

O GIC O FoK O 10C

Good Till Cancelled (GTC)

Order remains on the books until cancelled and can be filled at an undesirable time if forgotten

Fill or Kill (FOK)

LMT orders which, if not filled immediately, are cancelled

Immediate or Cancel (I0C)

LMT orders which, if not filled immediately, are cancelled

Stop Limit/Trailing Stop

Stop Limit (STP LMT)

Orders

®  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not become
MKT orders once the STP price has been reached

e  Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order will not be

filled unless the price remains at or drops below the limit level

®  Sell STP LMT is activated when the commodity is offered or traded at or below the STP level, the order will not

be filled unless the price remains at or rises above the limit level

e  No order can be guaranteed an execution
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# ESZ6 - Depth of Market

mE]

A | 3 & | ef "?IF} |l |  DEMos7094 ~
Oty 5/%]  TatalPAL: $0.00
Fos: 0
Fs
132675
1326.50
1326.25
1326.00
132575
132550
1325.25
1325.00
1324.75
TE30 -
| BuwMkT || Gotolast || selmkr |
[ ] Stop Limit [ ] Trailing Stop
Factor; Factor; 0.25 {3}
Trailing Stop

A complex stop-loss order in which the stop loss price is set at some fixed percentage below the market price. If the
market price rises, the stop loss price rises proportionately, but if the stock price falls, the stop loss price doesn't
change. This technique allows an investor to set a limit on the maximum possible loss without setting a limit on the
maximum possible gain, and without requiring paying attention to the investment on an ongoing basis.

Bracket Options
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BE]

W | 3 & |=f v AlE ||l | DEMo47094 -
Oy 5% TotalPAL $0.00
Fos: 0
- [Cffer
[ 1327 75 2327
e 1327 50 2335
I 132725  [REXED
1327.00
132675 [
- 10062
| BuwMkT || Gotolast || Selmkr |
[ ] Buy Bracket [] Sell Bracket
[ ] Sell Limit [] Buy Stop
Factor: Factor:
[ ] 5Sell Stop [] By Limit
Factor: Factor:

Buy Bracket

Orders

1. Bracket orders are designed to limit your loss and lock in a profit by "bracketing" an order with two opposite-side

orders.

2. A BUY order is bracketed by a high-side sell limit order and a low-side sell stop (or stop-limit) order.

Sell Bracket

1. Bracket orders are designed to limit your loss and lock in a profit by "bracketing" an order with two opposite-side
orders

2. A SELL order is bracketed by a high-side buy stop (or stop-limit) order and a low side buy limit order.

Account Filter

Scroll through various accounts you might have and trade the same contract with a click of a button.

51



APPLTraderUserGuide

ESZ6 - Depth of Market

=]

L

=1 | [ & |oF [¥ ] & |l | [oEmossssn -
Oy 003  TotalPL DEMOZ5E30

DEMOB5399
Poz: 1]

- Offer
- 1329.25 lﬂﬂ
1329.00
1117 132875 -
1328.50 Il
| 4 | 132825 I
-

Goto Last

Order Flags
() Mone (O GTC (3 FOE. (O 10C

Qty
Amount of contracts you desire to trade for the entire ROE.
@ ESZ6 - Depth of Market mEX]
| | [ & |F v A G |l | DEMo47ond -
ity 5l Total PAL: $0.00
Pos: 0

1326.25
1326.00
1325.75
1326.50
1325.25

-

| BuwMKT || Gotolast || SelmkT |

P/L

Open P/L or Current P/L
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# ESZ6 - Depth of Market

BEx]

A | 3 & |EF v (A 5 || DEMozssso -
Oty 0/ | Tatal P/ $1,000.00
Pos: 0

il
I 1329.25
1329.00
1326.75
132650
o] 122825
e

3o to Last

1

1. Open P/L is the Profit and Lose for the Position that is open currently

2. Current P/L is the Profit and Lose for all positions that have been traded on this session

Position

Shows the amount of contracts you have open and at what price they are open at.

ESZ6 - Depth of Market

L)

%]

| [F & | Ef ¢ (3 5 Gl | DEMO2S830 -
Qhy: 5% Total P/ $ 81250
Fos: 5@1323.50 [ Exit at MET ] [ Reverse ]
| ConcelBids || Cancela |
-
1348 1329 N
N 1124 122200 [
3661 122275 [
2621 122250 [
3932 122225 [
| 4 | 152800 N
I 13277
1 132750 [
| 2 132725
I 132700 [
I 13675
[ 1 132650 [
1326.25
-
| BuwMKT || Gotlast || selmkT |

Orders
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Exit at MKT

Turns any open position into a FLAT position by trading the opposite of the open position.

" ] b
42 | @ 4 [BF| v (3 G @@ | Demozssi0 -]
Qty: 5% TotalPAL: $ 812,50
Pos: 5@ 132375 I Euit at MET l [ Reverze ]
| CancelBids || Cancelal |
I 1330.00
B = 132975 [EEWD
1061 | 132950 (oo S
1329 25 ) Order Confirmation
I 3403 | 1328.00 _
Eo64 137875 Account; DEMOZE820
1328.50 Send SELL 5 ESZ6 MKT?
8 | 1328.25
4 | 1328.00
N 1327.75 | ok | [ Cancsl
1| 1327.50
I 122725 [
1327.00
-
| BuMKT || Gotolast || selMkT |
Reverse

Will take any open position and EXIT it and then reverse the position by placing the identical position on the reverse
side. it was initially open on.

i.e., ES 1 @ 1329.75 and reverse the position it would end up ES -1 @ 1329.75
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" : X
= | [F & |EF v (A 4G || DEMozsss0 -
Qty: 1% Tatal PAL $ 725.00
Pos: 1@132975 | ExitatMKT | | Reverse |

id E S Offer
el 17 |p 132975
2749 1329.50 ~
2105 132975 Eﬂrder Confirmation
3475 1329.00
| 2 | 132850 @ Send SELL 2 ESZB MKT?
8 | 1326.25
4 | 1326.00
I 1327.75 [ ok, ] [ Cancel
1| 1327.50
. 132725
I 132700 [
1326.75
-~
| BuMKT || Gotolast || SelmkT |
Cancel orders
¥ £SZ6 - Depth of Market =)<
=R | [ 5| &F ¢ (2 [[ll|  DEMo2ssio -
Oty 11 Total P $ 587.50
Poz: -1 @ 133025 [ Exit at MET ] [ Beverze ]
[ Cancel Bids ] [ Cancel &ll ] [ Cancel Offers ]
Eid - Offer
I 133328 [
I 133300 [
I 133275 HEE
I 133250 [
I 13322 A
I 133200 A
I 122175 [
| 1331.50 3160
I 1331.25 3327
-
| BuwMKT || Gotolast ||  selmkT |

Cancel Bids

Orders
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This options will cancel out of all working orders on the BID side

Cancel All

This will cancel ALL working orders

Cancel Offers

Will cancel out of all working orders on the OFFER side

At Market
# ESZ6 - Depth of Market M=
A | [ & |EF v (A 45 || DEMo2sss0 -
Oty 1% Total P/ $ B87.50
Fos: -1 @ 1330.25 [ Exit at MET ] [ Reverse ]
[ Cancel Bids ] [ Canicel All ] [ Cancel Offers ]
- Offer
1333.25 ]
1333.00 I
1332.75
1332.50 e
1332.25 e
1332.00 e
1331.75 e
1331.50
1331.25 3327

- 13079

| BuwMKT || Gotolast || SelMKT |

Buy MKT

Place a Buy @ MKT at the bid price

Go to Last

Will center the MKT Prices; without having to scroll; if they have trailed off the existing view

Sell MKT

Will place a Sell @ MKT at the offer price

Order Default

Can create default orders for each account which will appear when a new order is being placed after clicking on
NEW ORDER in the AOE.

a. Goto "Orders" > "Order Defaults..."
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b.  Enter your default parameters and hit "OK"

mﬂrder Defaults

Account; DEMOZ5830 V
Drefault Order for

Buy/Sell: Buy V

Symbal: ESUE

OrderT ype: Market ™

Flag: Maone v

(] ] [ Cancel

Contract Setup

e  Every contract that appears in the "Selected" box will appear in your drop down lists for the order tickets and
guotes window setup.

®  Click on the desired group (i.e.) “Currencies” under the "Available" window and open it up so that you can see
all of the contracts included in that window. Click to add a checkmark next to the contracts you want to see in
your drop down lists for the order tickets and quotes window setup. You will see the contracts move to the
“Selected” box as you select them.

®  Once you have added the desired contracts to the contract setup “Selected” box you will next want to select
the months that you want to trade. If you change the month’s column to the “Nearest 2” selection you will most
likely have the contract months you trade. If the month you trade is not part of the Nearest 2 selection then
select “All Months”. Make sure that you click “Set Months” before exiting the “Contract Setup” window or else
your settings will not be saved.

®  You can also set a default quantity for one or many contracts at once by pressing CTRL and selecting the
contracts then, set the Def. Qty. and hit "Set Qty". Note: This settings will show once you log off and log back
in.
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# Contract Setup E]@
Available: Selected:
+ Curencies Description Sumbal | KManths -~

= Energies Auzszie Dollar B, Mearest
EH - Heating Ol Biritish Pound &R Mearest
CL - Crude 0l [pit] Canadian Daollar BC Mearest
GECL - Crude Ol Eura Fis Currencies EE Mearest
GHO - Heating Ol popanese ren o heares!
1azilian Fleal eares
GHU - Unleaded Merican Peso =] Mearest
GNG - HH Natural Gas Mew Zealand D ollar BN Mearast
HH - Natural Gas Last-day Russian Fuble ER Mearest
HO - Heating Ol [pit) Swisz Franc g5 Mearest
HF - Matural Gas Gouth African Rand [ Mearest
HU - Unleaded [pit] Ethanal [pit] AC MNearest
NG - HH Matural Gas [pil] .-’-‘«uss!e DDIIa_l [pit] AD Mearest
6 - HH Natural Gas mitly ﬁ'”m!”“rg.[lp'” ’g‘h Hea"as‘
. o eating Ch earest
LH - Heating _D'I !T"NY Sopbean Oil [pit] BO Mearest
Gk - Crude Ol milly Biitish Pound [pit] BP MNearest
QU - Gasoline mit'y’ Brazilian FReal [pit] BR Mearest
RT - RBOB Gasoline Corn [pit] C Mearest
WS - Crude Oil Cocoa [pit) [ Mearest
" FEancials l:anadia_n D_nllar [pit] CD Mearest
5 Grains Crude Oil [pit) CL Mearest
, Catton Mo, 2 [pit] CT Mearest
# [#] Indices Dl [pit) 0 Nearest
+ Meats LS Dallar [k Mearest
+ Metals E-Miri Euro F EV MNearest

+ Softg Evra Fx Currencies [pit] EC Mearest
Euro Dallar [pit] ED Mearest

<1 Ma. LIBOR ioitl Erd Mearest = i

e Next, you will go to “Quotes” in the menu bar and select “Add Market” Select the contract you want to add and
click “OK”.

Confirmations

As a safeguard a trader can turn on the "Confirmations" feature in APPLTrader. This gives the trader an opportunity
to confirm the order before the order is sent for execution. This feature is optional and is turned on by default.
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Orders

File  Account | Orders | Communications

Quotes  Yiew  Repaorks

Setup Toolbox

Order Confirmation

[ Ok, ] [ Cancel

~ Account: DEMO 25530
@ Send BUY 5 GAUG MET?

Notifications

Abbreviated Order Enkry Chrl+1
Symbal | #EBo Turbo Qrder Enkry Chrl+2 Pos| % Tatal PAL
ECUE Rapid Order Enkry Chrl+3 5 $950.00
ESLE 10 $2.625.00
Depth OF Market Order Entry Chrl+4
Crder Defaulks., ..
- ,
Average Posiion Clear After Submit
Contrackt Setup...
Py | Confirmations 2 | Mew Order
DEMD25830 Natifications v Cancel Order
Showve Cancelled Qrders
Show Rejected Orders
P m [

If a trader wants to be notified by an alert box when an order has been filled or if an order modification or cancellation
failed leave the options checked. We recommend leaving a check mark next to “Notifications” > "Modify or Cancel

Failed".
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m OECTrader Demo

File  Account | Orders | Communications  Quotes  Yiew  Reports  Setup Toolbox  Help 0
abbreviated Order Entry Chrl+1
Symbol | #Eo Turbo Order Enkry Chrl+2 FPoz| $ Total PAL
EEHEE Fuapid Order Enkry Chrl+3 'Ig $2$§gggg

Depth OF Market Order Enkry Chrl+4

Crder Defaults, .,

i .. w | After Submik
Ayerage Position =ar ATter SUbm

Conkrack Setup..,.

Account Confirmations ' e | ast Cone

DEMOZ5630 | Motifications VI[=] newri I

Show Cancelled Crders Modify or Cancel Failed
Show Rejected Orders
-

m OECTrader Demo

\_‘l) & fill [100231 298, 25] has been added inta Order #733150

Cloze

Show Orders

To display "Cancelled Orders" and/or "Rejected Orders" in the "Completed Orders" window check the options "Show
Cancelled Orders" and/or "Show Rejected Orders" respectively.

Account Order # | State Side [ty | Symbal Ay Price
DERMOZ5530 778834  Cancelled By 0/3 ESUB
DERMOB5399 780529 Completed By 20420 ESUG 1297.75
DERMOS5399 783150 Completed Sell 1040 ESUG 129825
DEROZ25230 783258 Rejected By 000 BCUB
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Sound alerts

Customize different sound alerts to make you aware of trading events such as cancel failed, fill received, order
accepted etc.

You can customize with any wave (.wav) file or our programmed files which come with the software.
Decide if you would rather hear a sound or see an alert box.
To access Sound Alerts:

a. Communications > Sound Alerts

& Alert Settings

Channel Saound Level
Cancel Failed <defaultz Alert Box
Deszk Meszage <default: Saound
Fill Received <default: Alert Bow
b odify Failed <default: Alert Bow
Order Accepted <default: Sound
Order Cancelled <default: Saound
Order Completed <default: Sound
Order Filled <default: Sound
Order lzzued <defaultz Sound
Order Rejected <default: Alert Bow

<default: v m

Level | Alart Baw "

o) o]

To configure:

a. Highlight the channel that you want to assign the sound to.

b.  Hit "Browse" and search your computer for (.wav) sound files. Note: The default windows .wav files are located:
(C:/WINDOWS/Media)

c. Hit"Play" to preview the selected sound.

d. Level: Set "Alert Box" if you want an alert pop-up along with the sound. Or, select "Sound" if you want sounds
only.

e. Hit"OK"

Message History
See your message history in detail of all previous chat sessions you have had with the brokers.

Click on "View" to view within the software or PDF to export into a PDF file or Excel to export into a .exe file.
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| Message History
File
Begin Date:; End Drate:
08/23/2006 00:00 ||| | 08/23/2006 2359 |+ [ Wiew ] [ PDF ] [ Excel ]
H 4 Page1of1 bk M ]
Chat History for DFormicab7
Time From -> To M
08/23/2006
15:28:33.607 DFormicas?y -= Danield  |Hello T have a question.
15:28:47.170 DFormicas? -= Danield [ What is the current symbaol of th
15:29:13.513 Daniels -= DFormicas? | The current symbaol for the mini =
15:29:23.763 DFormicas? -= Danield | Thank vou !
15:29:35.730 DanielA -= DFormicas? | Your Welcome!
Chat

Allows one customer to directly ask questions, get quotes, place orders, etc with a broker. The broker answers the
questions/comments via the CHAT box.

We highly recommend most questions be transmitted via the CHAT box. It is the most streamline method of
communication.

Chat

3:28:36 PM to DanielA:Hello | have a question. A | | Danield
3:28:50 PM to DamelA\what iz the curent zumbol of the [

mini 5P 500 7

3:29:17 PM DanielA: The current symbaol for the mini S&F

A00 iz ESUR -

D-30-3F Dhd b M amanl A - Tl - | L J

In order to initiate chat with a BROKER, select their name (i.e. APPLBroker9) and type your message in the open
row at the bottom. Once you have entered your text you will be offered the SUBMIT button. Click on the SUBMIT
button and the broker you selected will receive your message. The drop box is there for your reference so you can
repeat your self with previous comments or say the same thing to a different broker by just clicking into the drop box
and selected the previously written text.

To access Chat:

a. From Communications menu options, click on the CHAT option. If it is already checked it will uncheck the
CHAT option and it'll be unavailable to chat.

b.  From View menu, click on Chat in order to make it highlighted.

Research

This window displays important messages that consist of major market issues sent from the brokers to the entire
APPL population. It also displays Risk messages such as available credit, etc.



Communications

Each time a research appears it will be accompanied by a topic first then a message. The broker can make it as
specific as possible for quick reference by using the seven templates. The topics are Indices, Currencies, Energies,
Grains, Metals, News, and General.

3:41:39 PM RISK
Rizk wiolation Max credit = 0 USD,Order would need credit of 6012.52
15D [zash available iz 37862.43 15D]

To access Research:

a. From Communications menu options, click on the "Research Window"; if the option has a check next to it then
it's available to view; if it does not have a check then it isn’t available to view.

b.  From View menu, click on Research in order to make it highlighted.
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Add Market
To add a Market from Quotes window:

Right-click anywhere in the "Quotes" window and select "Add Market"
To add a Market from the main menu:

Main menu, go to "Quotes" > "Add Market"

The Market Selection box will appear. Just select the desired contract and hit "OK".

rm Market Selection W
Contract Title: |E.-’3.L|E [v]
[ ak. ] [ Cancel ]
Notes:

a. Add a market by contract
b.  Pit contracts are snap-shots

c.  Electronic contracts are streaming

Add Market Group
To add a Market from the Quotes window:

Right-click on the Quotes window and select "Add Market Group".
To add a Market from the Main menu:

Go to "Quotes" > "Add Market Group".

The "Market Group Selection" box will appear. Select the market group and the nearest month or all months.

m Market Group Selection
Group Title: b onths:
| Curmencies [VI | MHearest 1 [VI
I ()4 ] [ Cancel ]
Remove Market
Remove the highlighted market from the Quotes window.
Quotes
Symbol Add Market Bid...
ESUG add Market Group 11
6A L6 | Remove Market | 109
6CU6 r 124
R |'r=“-‘“—"-”—“—""“"="—|
FDAXUG i Remove Market 14

1. To remove a Market:



Quotes

a. Highlight the market in the Quotes window

b.  Right-click within the Quotes window and select "Remove Market"

2. To remove a Market
a. Highlight the market in the Quotes window

b.  Main menu "Quotes" > "Remove Market"

Remove All Markets

Remove all markets from quote window.

Quotes
Symbol La #dd Marlket
ESUG 1305.0 &dd Market Group
6A L6 75.€ Remove Market
6CLIG g0.(
FDﬂXUﬁ 53?4 | Remaove All Markets |
GE L6 128.( ine
& o rdRemove Al Markets

1. To remove all Markets:

a. Right-click anywhere in the Quotes window and select "Remove All Markets"

2. Toremove all Markets:

a. Main menu "Quotes" > "Remove All Markest"

Insert Blank Line

Insert blank line just above the highlighted contract in the Quotes window.

1. Toinsert a blank line:

a. Highlight the contract that you want to have the blank line insert just above
b. Right-click and select "Insert Blank Line"

2. Toinsert a blank line:
a. Highlight the contract that you want to have the blank line insert just above

b. Main menu "Quotes" > "Insert Blank Line"

Quotes
Symbol #dd Market id
ESUG &dd Market Group 50
6A L6 Remove Market 89
6CLIG ri
EDAXU6 Remove All Markets ) 5
Insert Blank Line
GELIG
Mg =] |

Move up/Move Down
Move the highlighted contract up/down.
To move a contract up/down:

a. Highlight the contract in the Quotes window
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b. Right-click and select "Move Up" or "Move Down"

Sort by Alpha
Sort all the contracts in the Quotes window in alphabetic order.
To sort by alphabetic order:

a. Right-click anywhere in the Quotes window and select "Sort by Alpha"

Custom Price Format

Allows customers to change the decimal format of LAST, BID and ASK columns within the Quotes window.

-,

m Price Format
BSLE
Default Format Drefault Multiplier
w2 *0.00000
wid *0.00001
w8 *0.000
w16 *0.00
w32 00
w/B4 01
w128 "1
w256 10
0 100
nao *1000
0.00 *10000
0.0o0 *100000
0.0000 * 1000000
0.00000
0.000000
0.0000000
0.00000000
0.000000000
Apply ] [ Cancel
Font

Customize the font of your Quotes window.
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Font
Eant: Fant ztyle: Size:
Microzoft Sans Senf Reqgular a [ (] l
)} Microzoft Sans Senf [~ | | Fegular a e
{} Monotype Corsiva [ ] [talic | E
() M5 Outloak, Bald 10 3
(} M5 Reference Sans 5| | Bald ltalic 1
{} M5 Reference Specia 12
(} v Boli 14
{} Palating Linotype [V] 16 [V]
Effectz Sample
[] Strikeout
AaBbv
[ ] Underline aBbYyZ2
Script:
|Western [V]
Rename...

Ability to rename the title of the Quotes window.

Go to "Quotes" > "Rename...", enter the title name and hit "OK".

~

Custom name of Quote...

-,

Please enter new name:

[uotes Test

I ak. ] [ Cancel

The renamed Quotes window title would look like the one below.

Quotes Test

Symbol Last| Last\ol Bid| BidSize
ESUG 1297.75 10 1297.50 228
GAUG 76.76 4 76,76 7
GCLIG 90.11 1 90.11 17
GELIG 127.81 3 14781 22
66 8.674 1 8.673 240
65U/6 809.3 6 509.1 21

Add,Remove Price Alert

To add an alert, select the desired contract from the Quotes window. Select "Add Price Alert" to get to the
below window. Enter Alert Price, criteria and the options text.

Quotes
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m OECTrader Demo

Alert Price 123300 % (®) <=
0=
) Auto

Alert Tewt [optional]
ESUE went below or egual to 1298.00

1] l [ Cancel ]

When the price criteria is met, the alert box is displayed.

-,

m OECTrader Demo

1 ESUE went below or equal ta 1233.00
T

To remove an alert, select the desired contract from Quotes window. Right click and select "Remove Price
Alert".

View Price Alerts...
Go to "Quotes" > "View Price Alerts".
To remove one alert, select one alert and hit "Remove". To remove all alerts, just hit "Remove All".

m Price Alerts

barket | Prce Uzer Meszage

ESLE ¢<=1298.00 ESUE went below or equal to 1233.00

Edit Remowve Remowve All

Depth or Market (DOM)

Opens the DOM for a specific contract. Jut highlight a contract from the Quotes window then select "DOM".
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Quotes Test Add Price alert

Symbol 4
ESUG 1 |
GA LG

6CLIG Do |
FDAXUG chart

GE LG *

6.JL6 Column Setup...

f:f:;ﬁ Expart ko CSY...

Next, the DOM window will open.

'@ ESUG - Depth of Market LoE)

| [ & |&F v (A 5 || DEmMozsszo -
Qty: 0% TatalPAL: $2,125.00
Fos: 10 129200 [ Exit at MET ] [ Reverze ]

F 9
I 1297.50
1297.25
184 | 1297.00
1296.75
1557 129650
v

3o ko Last

Column Setup

Check the columns that you want visible from the Quotes window. Then, hit "Save" to view your the changes.
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m Quotes Test

Symbol L
Last

Laztval

Bid

BidSize

Ak

AzkSize

High

Loy

Chg

Chaoi
Tatahsol
Open

Settle

] Updated

[] Baze Contract
[] Expires

[ ] Description
[] Cumrency [v]

Cirag a column by mowuze or Presz Chl-lp or
Ctrl-Dravar to change the column order

[ Save l [ Cancel ]

Export to CSV

Exports your Quotes window data to an excel file. After selecting this option you will see a confirmation dialog
box.

To export all items just hit "Yes".

To export selected items, you would have to first highlight the desired items from the Quotes window by
pressing CTRL left mouse click each item. Then, select the "Export to CSV..." option and hit "No" in the
confirmation dialog box.

L o

Export

Do ol wank export all ikemsy?
fes - all ikems, Mo - selected item only)

| es |[ o H Cancel ]
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View

Lock/Unlock Windows

Wiewy | Reports  Setup Toolbox  Help

» | Lock Windows ”_

] showTabs Total P/L
Layout p | -B250.00USD

To lock APPLTrader windows:
a. Main menu, click on "View" > "Lock Windows".

b.  When a check is next to "Lock Windows" then the windows will stay in the current location and are not
configurable.

To unlock APPLTrader windows:
a. Main menu, click on "View" > "Lock Windows" and make sure that there isn't a check next to "Lock Windows"

b.  Uncheck "Lock Windows" then the windows will become movable and configurable.

Show Tabs

Some of the windows within APPLTrader have tabs available which can be displayed by selecting View > Show
Tabs. The tabs will appear below the box they are associated with

Example 1: Positions window has "Average Positions" and "Detailed Positions"

Symbaol | Awg Buy Price | Awag. Sell Price | Amount | Realized PAL

ECLIE 30.04 0.00 ] 0.0 usD
ESUE 1233.00 0.00 10 0.a0usD

Average Positionz | Detailed Pozitions

Example 2: Order Tickets window has "Standard", "Turbo", 'Rapid”, "DOM".
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Abbreviated Order Enry
Side hdarket Selection
() Buy Cuartity Symbal
0 | |BAUB '
Order Specs
Type: | Market v Flag: | Hone v
| BLMT F3 | | B-MKT F4 | Template: v

Mew Order F8 | | S-LMT F5 | | 5-MKT F5 |

Standard | Twbao | Rapid | DOk

Layout

Layout

Layout offers the ability to save different window configurations and delete existing configurations.
Layout also allows the trader to RESTORE DEFAULT LAYOUT; which is the initial layout that appeared when the

software was first downloaded.

Save...

Save an already customized layout. Enter a name for the layout and hit "OK".

-,

Save Layout

Enter name of layout;

M yLlawout]

l )4 l [ Cancel

Once the layout is saved it will be available under View > Layouts.
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Account Surmnnary

Wigw | Reports  Sebup Toolbox  Help Open a Live Account
Lock Windows |
Shiow Tabs
| Layout r Save...
Positions » Celete. ..

Restore Default Layout

Cpen Orders MyLavoutl

Completed Orders

Crder Tickets 3

Quates Arccount Order #

1 DEROB5399 80529

Depth of Market r — DEROBR399 F83150

hart , i DERMOZ5530 783258
ars DEMOE5339 783704

Cornrmunications k ;

Delete...

Delete a saved layout. Select the layout that you want to delete and hit "OK".

Configuring Windows

Docked Windows

To configure that specific window, right-click on any of the boxes to view a menu as the one below.

View information on how to unlock a window.

Account Summarny [X]
Close 1
ProfitfLoss Urelots
Epelrj PQLF',-'L Canfigure. .,
ealize
Tatal PAL Shiow Tool Bar
Balance Top Header
Met Lig Left Header |
Close

CLOSE will remove the selected box from the layout. This allows traders to configure the trading platform
layout. If you wish to re-open that box just simply go to "View" > and the box you wish to open. Once
clicked the box will appear UNDOCKED and you will have to manually dock into the Layout (if desired).

Undock

The DOCKED form is the form that appears on the default layout. Each box its nicely compacted within
the width and height of the APPLTrader platform. Any undocked boxes will appear as free flowing
windows. The UNDOCK feature will remove the selected box from the docked form and display the
selected box as a free flowing window.

If a free flowing undocked box is open, when the APPLTrader platform is closed/minimized the free flowing
box will close/minimize with it.
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1 Live Account Accounk: DEMOZ5E30
Account Summary = &
Tl:ltal .........
ProfitfLoss
Open PAL $2.175.00 Exit all
Realized PAL $0.00
Tatal F/L $3175.00
Balance I
Met Lig $ 48.862.50
%]
Configure...

See Information.
Show Tool Bar

If the check is next to the "Show Tool Bar", the tool bar will appear within that box. The tool bar offers a
number of different options depending on the box selected. Each box has different toolbar options.
Top Header

Display the header on the top of the box running from left to right the entire height of the box.
Left Header

Display the header on the left-side of the box running from top to bottom the entire height of the box.

Undocked Windows

Once the windows are unlocked the ability to change the windows are endless. Perform a mouse right-click on
the header of the undocked window to view a menu like the one shown below.

View information on how to lock/unlock windows.

Account Summary sl
Profit/Loss Move
Open P/L $ 36 Size
Realized F/L i
Tatal PAL %36
O Maximize
Balance |
Met Lig $ 493 ¥ Close Alt+F4
Configure... 1
r Shows Toolbars
v Dockable
Independent
Skay On Top

Move
Allow to move the box without activating the blue docking indicator arrows.
Size

Allow to change the size of the box. Same result is obtained by carefully hovering the mouse on one of
the borders of the box until the mouse cursor changes to a double-pointed arrow, at this point you would
want to left-press your mouse and drag until the desired size is achieved.

Maximize
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View

Maximize the window to the whole size of your screen.
Close

CLOSE will remove the selected box from the layout. This allows traders to configure the trading platform
layout. If you wish to re-open that box just simply go to "View" > and the box you wish to open. Once
clicked the box will appear UNDOCKED and you will have to manually dock into the Layout (if desired).
Configure...

See Information.
Show Tool Bars

If the check is next to the "Show Tool Bar", the tool bar will appear within that box. The tool bar offers a
number of different options depending on the box selected. Each box has different toolbar options.
Dockable

When 'Dockable' is checked, dragging the undocked window will show the the layout configuration tool
(blue indicator arrows) which allow to dock the window.
Independent

When 'Independent' is checked, the undocked window will change its look to that of a regular window.
Stay on Top

When 'Stay on Top' is checked, the window will remain visible at all times; it will never be under any other
window on your screen.

Docking a Window

1 Live Account Accounk: DEMOZ5E30
Account Summary = &
Tl:ltal .........
ProfitfLoss
Open PAL $2.175.00 Exit all
Fealized P/L $0.00
Tatal P/L $3175.00
Balance I
Met Lig $ 43,862.50
]

Perform a Left-click and leave pressed the header section of the window. Drag the window slowly onto the
box you desire to place it, you should see the layout configuration tool (blue indicator arrows) shown in the
below image.

75



APPLTraderUserGuide

en FAL Tal PAL |
uouso 1,]L|SD Tatal
i M & ¥ Profit/Loss
i » Qpen F/L % 3.650.00
Realized PAL $0.00
Toatal AL £ 2.650.00
Balance
g Met Lig $49,337.50
d Account | Or

Keep pressing the header of you window, place your cursor over the location in relation to the box that is
highlighted. In this case we select the single right options in the layout configuration tool to dock the
Account Summary window in its original spot. Or, If you want it to stretch across the bottom place your
cursor on the bottom option of the layout configuration tool.

Configure

To configure a window, first make sure that the trader windows are unlocked. View information on how to
unlock a window.

Account Summary el
Profit/Loss Maovve
Open P/L $ 3R Size
Realized F/L i
Tatal PAL $36
O Maximize
Balance
Met Lig $ 492 X Close alt+F4
Corfigure. .. 1
r Show Toolbars
v Dockable
Independent
Skay On Top

Then, place the mouse on the header of the window, perform a right click and select ‘Configure...".

CONFIGURE allows traders to open the specific options for the selected box. Whether it be toolbar
options, menu options or general box settings.
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Account Summary =

Toolbars = Menu = Setkings -

Default

All Currencies
Setup
Special

Separatar

Toolbar

View

Gives the options to have one or multiple toolbars with various tools within each toolbar. At any time

a trade can restore the toolbar to the default layout.
Menu
Offers options to add different utilities into the menu option for each box.
Settings
Provides the ability to change the types of methods traders wish to use the toobar.

Positions

Average positions
Displays the average positions open on each specific contract that has been traded.

In order to go flat in a specific contract:

a. Inorderto go flat in a specific contract, left click on the position and click on EXIT F2. This will immediately

transmit a market order for the contract selected to flatten the position.

b. In order to go flat all current contracts with open positions left click the Exit All. This function will immediately

transmit a market order to exit all contracts with open positions.

Symbal | HBought | Avwg Buy Price | #S5old | Awg Sell Price | Met Pog F Total F/L

BCUG 0 0.00 5 30.03 ] -$60.00 | Exit Al
ESUE 20 1233.75 0 0.00 20 $250.00

Detailed position

Shows each contract that has been traded specifically. Exit or Exit All the same way as the Average Position window.
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Symbal | Awg. Buy Price | Awg. Sell Price | Amount

ECLIE 0.00 90.02 B
ESUE 1293.75 0.00 20

Account Summary

Realized F/L

0.00ush
000 ush

Open P/L

1000 Ush

250.00 05D

Total F/L

1000 LSE | Exit Al

250.00 15D

You can customize the "Account Summary" window by hiding the rows that you do not want to see.

Account Summarny (3]
Total
Profit/Loss
Open PAL $0.00
Realized PAL $13.875.00
Tatal PAL $13.875.00
Balance
Cazh $ B4 765.00
Open PAL .00
Met Lig $ 64,765.00
Rate

Right-click anywhere inside the Account Summary window then, select "Column Setup..."

Account Summary ||
Tatal
Profit/Loss
Open PAL $0.00
Realized P/L $13.875.00
Tatal PAL $13.875.00
Balance
Caszh $ 64 765.00
Open PAL .00
Met Lig $ 64,765.00
Rate

all Currencies

| Column Setup, .,

Fork...

Click on the row that you want to hide under the column "Visibility" and select “hidden”.
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m Account Summary

EX]

Colurmn Yizibility
Open PAL Hidden w
Realized P/L ==
Total P/L Esl’dma'
Cash Hidden
Open PAL Tarmal
Met Lig Marmal
Fate Marmal
()4 l [ Cancel

Realized P/L shows the P/L of any closed trades.
Open P/L shows the P/L of any open positions.

Total P/L shows the total P/L for both the Open and Realized P/L.

Account Summan

Total 5D
ProfitfLoss

Open P/L $0.00 0.00
Fealized F/L -5 95.00 -595.00
Tatal PAL -5 9500 -595.00

» | Al Currencies
A0,167.50
Calurin SetL]E 0.0o

urrencies
Expark bo C34 | 501 E?.51EI
= Font... .

CHF

0.00
0.00
0.00

009
0.00
003

FE73

View

If you have a balance in another currency you will see another window showing the same information for that
currency. The window titled “Total” will sum up all the currencies in your account so if you want to view this window
only, uncheck “Show Currency Summary Columns”.

Open Orders

Open Orders

Account Ord... State

DEMOBS333 318432 “Waorking
DEMOB5333 818508 ‘Working

Awg. Side | Oty Suymbal
Buy 040 ESUE
Sell 0/2 Wl

Price Last.Crnd
LT 1303.75  #H426574 Cancel all
LMT 4.0000 by DemoBroker #426581

% Find

Open Orders allows traders to view their open orders in addition to the order statisitics. At any time a trade can
cancel the order by clicking “ Cancel” which will cancel the selected order or “Cencel All” which will cancel all the

orders in the Open order box.

Completed Orders

79



APPLTraderUserGuide

Aocount Order #| State Side [ty | Symbal Ay Price
DEMOES339 a18481 Completed By 10410 ESUB 1307.00
DEMOSS339 2818530 Completed Buy 20420 BELE 12849
DEMOB5399 2818533 Completed Sell 5/5 BELB 12850

Completed Orders provides traders with an accurate view of their completed trades from the current session. The
completed orders is color coordinated for easy viewing and customization. Traders can customize anything from the
column setup to the font size by right clicking in the completed orders box area

Order Tickets

Abbreviated Order Entry (AOE)

Simple way to trade within the platform.

A

Side hdarket Selection
(&) Buy Quiartity Symbuol

0 ESLEG
Order Specs
Type: | Market L") Flag: | Hone L%

| BLMTF2 | | BMKT F4 | Template: v

| New OrderFa | | 5-LMT FS | [ S-#KT FE |

Side
Buy
Purchase a certain commodity at a certain date in the future at a pre-set price. The future date is called the
delivery date. The pre-set price is called the futures price. The price of the commodity on the delivery date is

called the settlement price. The futures price, naturally, converges towards the settlement price on the delivery
date.

Sell

Sell a certain commodity...
Market Selection

Quantity

Amount of contracts you desire to trade.

Symbol
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View

Code by which futures are identified on a futures exchange; a corporation which provides the facilities to trade
futures contracts

Order Specs

Type
Market (MKT)

Orders to buy/sell at the best possible price as soon as possible. They are the first orders to be filled at
any given price, and are used to enter or exit the market quickly, regardless of the current price.
Limit (LMT)

Orders generally used to buy/sell at a specified price, or better. They don’t move once the limit price has
been reached, i.e., they do not become MKT orders.
Stop (STP)

Orders are traded only when the MKT price trades at or “through” the STP price.

a. Buy STP orders is placed above the current MKT price and is transformed into a MKT order when
the futures price trades or is bid at or above the STP price

b. Sell STP order is placed below the current MKT price, and is transformed into a MKT order when the
futures price is traded or is offered at or below the stop price
Stop Limit (STP LMT)

Orders are used like STP orders, but execution is restricted to the limit price or better. They do not become
MKT orders once the STP price has been reached. No order can be guaranteed an execution.

a. Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order
will not be filled unless the price remains at or drops below the limit level

b. Sell STP LMT is activated when the commodity is offered or traded at or below the STP level, the
order will not be filled unless the price remains at or rises above the limit level
Market If Touched (MIT)

Similar to STP orders in two ways:
1. They are activated when the price reaches the order level
2. They become MKT orders once they are activated
MIT orders are used differently from STPs.
Buy MIT below the MKT price to establish a long position.
Sell MIT above the MKT price to establish a long position.

MIT orders are not allowed on CBOT but are used on CME.
Market To Limit (MKT2LMT)

Market On Open (MOO)

A buy or sell order in which the broker is to execute the order at the market's opening. It does not
guarantee the trade will be executed at the listed opening price, but the trade will be executed within a
range of prices, or not at all.

Market On Close (MOC)

A buy or sell order which is to be executed as a market order as close as possible to the end of the day.
Market On Pit Open (MOOPIt)

This order type is similar to the MOO however it only applies to electronic contracts that have
corresponding pit contracts.

Electronic contracts can be placed MOOPIt if traders want the contract to be traded at the opening of the
Pit for the corresponding pit contracts opening.

i.e. ES has a next day opening of 4:30 EST but if a trader places a MOOPIt type then the order will be
placed when the S&P opens at 9:30 am EST
Market On Pit Close (MOCPiIt)

This order type is similar to the MOC however it only applies to electronic contracts that have
corresponding pit contracts.

Electronic contracts can be placed MOCPIt if traders want the contract to be traded at the closing of the Pit
for the corresponding pit contracts close.
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Trailing Stop Loss (TrSTP)

A complex stop-loss order in which the stop loss price is set at some fixed percentage below the market
price. If the market price rises, the stop loss price rises proportionately, but if the stock price falls, the stop
loss price doesn't change. This technique allows an investor to set a limit on the maximum possible loss
without setting a limit on the maximum possible gain, and without requiring paying attention to the
investment on an ongoing basis.

Trailing Stop Limit (TrSTP LMT)

Place a TrSTP which is a complex stop-limit order in which the stop limit price is set at some fixed
percentage above or below the market price. If the market price falls or rises, the stop loss price fall or rise
proportionately, but if the stock price rises or falls, the stop limit price doesn't change. This technique
allows an investor to set a limit on the maximum possible loss without setting a limit on the maximum
possible gain, and without requiring paying attention to the investment on an ongoing basis.

Once the TrSTP has been activated at or above/below depending on the SIDE the commodity was traded;
the order will not be filled unless the price remains at or drops/rises in relation to the LMT level.

Flag

Good Till Cancelled (GTC)

Order remains on the books until cancelled and can be filled at an undesirable time if forgotten
Fill or Kill (FOK)

LMT orders which, if not filled immediately, are cancelled
Immediate or Cancel (IOC)

LMT orders which, if not filled immediately, are cancelled
AON

Hot Keys

Template

Have the ability to create a template for quick and easy trading of specific contracts

Save/Delete.

a.

i.e., BUY the ES at 5 QTY with MKT type and GTC flags. Click on save and when this template is
referenced to it will ALWAYS appear as above: BUY 5 ES MKT GTC

Traders can have as many Templates as desired for quick an easy trading made for the trader.
You can have different template for the same contract.

DELETE refers to the template that is highlighted in the REMOVE TEMPLATE drop box. This feature is
nice if you have increased your volume and desire to revise your old template.

Transmit/New Order

Exit MKT

a.

In order to EXIT (F2) a Position quickly, traders are able to highlight the position they wish to exit, and
select EXIT or hotkey (F2).

Once EXIT has been activated the AOE box will display the exiting trade for that position in order to make
it FLAT. Click on Transmit and the exiting trade will be placed.

Trade Contract

a.
b.

Place a trade by clicking TRANSMIT

Remove the current order information for a new trade by clickihng NEW ORDER.

Turbo Order Entry (TOE)

a. Create a number of orders at one time

b.  Can transmit multiple orders concurrently



View

c. Allows you to load and save orders from excel.

Turbo Order Entry 4|k
Account Side [ty | Symbal | Type Flags Price | Price2 | Statuz

[+ DEMOZ25830 By 4 BaAllG b arket Mone Fieady to zend
DEMOZEEE0 Sell 15 ESUR Lirnit GTC 1.50 Ready to zend
DEMO25530 By 4 EBEUEG b arket Mone Feady to zend
DEMOZ5530 By 15 EDUG b arket M one Feady to zend

£ >
Mew Order Transmit E-LMT B-MKT S-LMT S-MKT | Submit Al Delste Clear |2 Load 5

Side

Buy/Sell a certain commodity at a certain date in the future at a pre-set price. The future date is called the delivery
date. The pre-set price is called the futures price. The price of the commodity on the delivery date is called the
settlement price. The futures price, naturally, converges towards the settlement price on the delivery date.

Qty

Amount of contracts you desire to trade.

Symbol

A future symbol is a code by which futures are identified on a futures exchange; a corporation which provides the
facilities to trade futures contracts

Type

MKT

Orders to buy/sell at the best possible price as soon as possible. They are the first orders to be filled at any
given price, and are used to enter or exit the market quickly, regardless of the current price.

LMT

Orders generally used to buy/sell at a specified price, or better. They don’t move once the limit price has been
reached, i.e., they do not become MKT orders

STP
a. Orders are traded only when the MKT price trades at or “through” the STP price

b. Buy STP orders is placed above the current MKT price and is transformed into a MKT order when the
futures price trades or is bid at or above the STP price

c. Sell STP order is placed below the current MKT price, and is transformed into a MKT order when the
futures price is traded or is offered at or below the STP price

Price
The factor at which you want the order to be placed in regards to the current price. i.e., ES MKT price is 1299.5;

PRICE will be placed 1.5 ticks above/below that current price . The Price will be placed above or below the MKT
price depending on the SIDE you trade on.
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Price2

PRICE 2 is only used if two prices are necessary for a trade. i.e., If a customer were to BUY 5 ES STP LMT PRICE
would be 1.5 ticks above the MKT and .5 Ticks below the PRICE once the STP has been reached

Status
1. Confirms what key pieces of information are needed in order to complete an accurate trade

2. Will say READY TO SEND if the order ticket has been completed
Toolbar/Hot Key

Transmit/new order
a. Place atrade by clicking TRANSMIT

b. Remove the current order information for a new trade by clicking NEW ORDER.

Submit All

Enter a variety of trades manually or load from excel and place all the orders at the same time

Delete/clear
a. DELETE will remove the highlighted order entry
b. CLEAR will remove ALL order entries

Load/Save
a. Load from .csv files or from .exe file types.

b.  Save the order entries to .csv files or .exe file types

Rapid Order Entry (ROE)

Advanced method to trade with specific amounts and settings.

R apid Order Entry [
Aubo Factor Settings

-

Bup StopLimt 0.00 (4] 000 [2 Stop 123575 (2] Limit 129675 (&
Sell Limit 000 3 Limit 1295.75 2 Sell Limit
[uantity Symbal
0 | [ESUE v Last 129575
- . Size -

Bid 129550 . Sell Bid
Aubo Factor Settings
Buy Limit 000 2] Limit 1295.75 2
SellStopLimt 0.00 (2] (000 3 Stop129675 2] Limit123575 3

Auto Factor Settings

Buy Stop Limit
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View

e  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not
become MKT orders once the STP price has been reached

®  Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order
will not be filled unless the price remains at or drops below the limit leve

®  No order can be guaranteed an execution
Factors

The values that you wish to increase your STP order by, i.e., .50 in the first box will increase the STP value
by the factor of .50; The same concept works the second factor box in that it effects the LMT.
BUY STOP

Places the STP LMT prices for the buy STP LMT order
Stop

Buy STP orders is placed above the current MKT price, but is not transformed into a MKT order when
the futures price trades or is bid at or above the STP price; It turns into a LMT order

Limit
LMT order is placed used to buy/sell at the specified price. It doesn’t move once it has been reached,
i.e., it does not become MKT order

Sell Limit
Factors

The price at which you want to place the Sell LMT
SELL LIMIT

Limit
1. Alimit order is an order to buy or sell a commodity at a specific price

2. Can only be executed at the limit price or higher
Market Selection

Quantity

Amount of contracts you desire to trade for the entire ROE

Symbol

e A future symbol is a code by which futures are identified on a futures exchange; a corporation which
provides the facilities to trade futures contracts

(] Is the contract that is traded for the entire ROE

BUY ASK/SELL ASK
BUY ASK

Bid on a commodity at the ASK price
SELL ASK

Sell a commodity at the ASK price
Ask

The ASK price (Offer). The lowest price at which someone is prepared to sell a commodity
Size

The number of sellers at the ask price
BUY MARKET/SELL MARKET

. Will buy a contract of the ROE’s QTY at the MKT price of the ROE’s symbol or

. Will sell a contract of the ROE’s QTY at the MKT price of the ROE’s symbol.
Last

The price at which the ROE’s symbol was last traded
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BUY BID/SELL BID
BUY BID

Bid on a commodity at the BID price
SELL BID

Sell a commodity at the BID price
Bid

Bid Price is the highest price at which someone is prepared to buy a commodity
Size

The number of buyers at the bid price
Auto Factor Settings

Buy Limit
Factors

The value that effects where the LMT order will be placed, i.e., 1.5 will place a LMT 1.5 below the LAST
price
BUY LIMIT

Limit: LMT order is placed used to buy/sell at the specified price. It doesn’'t move once it has been
reached, i.e., it does not become MKT order.

Sell Stop Limit

e  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not
become MKT orders once the STP price has been reached

®  Sell STP LMT is activated when the commodity is offered or traded at or below the STP level, the order
will not be filled unless the price remains at or rises above the limit level.

e  No order can be guaranteed an execution
Factors

e  The values that you wish to decrease your STP order by, i.e., .50 in the first box will decrease the
STP value by the factor of .50;

®  The same concept works the second factor box in that it effects the LMT
SELL STOP

Places the STP LMT prices for the sell STP LMT order
Stop

®  Sell STP order is placed below the current MKT price, but is not transformed into a MKT order
when the futures price is traded or is offered at or below the STP price; turns into a LMT order.

Limit
e |LMT order is used to buy/sell at the specified price. It doesn’t move once it has been reached,
i.e., it does not become MKT order

e Can only be executed at the limit price or higher.

Depth of Market Order Entry (DOM)

Depth of Market Order Entry (DOM)

To view the Depth of Market Order Entry go to "Orders" > "Depth Of Market Order Entry"

Open
To open a DOM window from the Depth Of Market Order Entry:

Select the contract symbol from the drop down then hit "Launch".
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View

Depth 0f Market Order Entry )
Symbol: |BAUE  |v| [Launch | Symbol Launch
Symbok | |%| Leauech | Swmbok | [ Leunch
Symbok | || Leunch | Swmbek | [s]| Leurch
Symbok | %] Lawnch | Spmbok | [s| Launen
Symbok | || Launch | Spmbok | [w] | Lawnck
View

To open a new DOM, go to "View" > "Depth of Market" > "New..."

Wieww | Reports  Setup Toolbox  Help Qpen &

Lock windows

Show Tabs Total PAL
Layout p | 28000 USD
Positions »

Account Summary

Open Orders

Completed Crders

Order Tickets 3

Quokes

Cepth of Market » m Mew, .,

Charts » ESLiG

ommunications GELE
E7UG

e The only contracts that will appear in the drop box are those that have been specified in the "Contract
Setup..." under Orders

e  Select the account and contract you wish to trade the DOM and hit "OK".
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-,

‘@ pom

Account; | DEMOBE399 M
Contract: | ESLIE kl

| oK

H Cancel ]

To open a DOM session, go to "View" > "Depth of Market" > i.e:" ESU6".

contracts you have opened before or are on the default layout.

Wieww | Reports  Setup Toolbox  Help Qpen &
Lok, Windows
Show Tabs Total PAL
Lavaut Y 0.00 LSO
Positions »
Account Summary
Open Orders
Completed Crders
Order Tickets 3
Quokes
Cepth of Market » | Mew, .,
Charts 3 | Folle
ommunications GELE
E7UG
Quotes

Contracts below the brake Line are

Right-click on the contract within QUOTES and scroll down to DOM, click on it and a DOM will appear for the

guote you have highlighted.

Quotes Test Add Price alert

Symbol

ESUG 1

GA LG

6CLIG Do |
FDAXUG Chart

6EUG ar

606 Column 3etup. ..

gf:—;ﬁ Export bo CSY..,




View

DOM - Opening

Quotes box

Right-click on the contract within Quotes window and select "DOM" in the submenu and a DOM will appear for the
quote you have highlighted.

Quotes Test Add Price Alert
Symbol 4
ESLIG 1 |
GALIG
6CUIG DM |
FDAXLUIG h
GEUG Chark
6.6 Column Setup. ..
gf:;ﬁ Export ko CSY...
View

Contracts below the brake line are contracts you have opened or are on the default layout. Select any one of these
contracts to open the respective DOM.

Yiew | Reports  Setup  Toolbox  Help Qpen ¢

Lock Windows
Shon Tabs Total PAL

Lavout , 0.00 USD

Pasitions 3
Accounk Surmraty

Cpen Orders

Completed Orders

Order Tickets *

Quokes

Depth of Market 3 | e, ..

Charts » | ESLG

Zommunications CELE
E¥lG

Depth of Market Order Entry

Main menu "Orders" > "Depth of Market Order Entry"

Charts

Open chart a of the DOM contract you have open currently.
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# ESUG - Depth of Market

DREX]

N e A A=

il

Open
Cha
DEMOS5399 -

1004 Total PAL

[ty

-$3.000.00

|Chart L

20 (2 1305.00 [ Exit at MET ] [ Reverse ]

Pos:

il
1302.00
1302.75
130250
1302.25
1302.00
-
| BwMKT || Gotolast || SelMkT |
Bid
# 6A76 - Depth of Market M=)
= | [F 5 |aF v A G || DEMOggses -
Oty T4 TotalPA $0.00
Pos: a
| CancelBids || Cancelan |
-
T
1 528
Left Click: LIMIT |75 27 I
Right Click: STOP EE.EE e
5 Il
-
| BuwMKT || Gotlast || selmkT |

Right Click: STP
1. Rightclick in the green column at the price level you would like to place a buy STPLMT

2. The QTY of the buy STP will appear in the white column next to the price level selected

Left Click: LMT
1. Leftclick in the green column at the price you would like to place a buy LMT

2. the QTY of the working order will appear in the white column to the left of the selected price
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Offer X
# 6A76 - Depth of Market =Jo/&d

=W | [F # | &F v (A G |G| DEMO99999 -
Gty 1% Tatal PAL 41000
Pos: 1@7523) | Exit atMKT | [ Reverse |
| CancelBids || Canceldll || CancelOffers |

Left Click: LIMIT
Right Click: STOP

[ Buy MET ] [ o to Last ]

Right Click: STP
1. Rightclick in the red column at the price you would like to places a sell STP

2.  The QTY of the working order will appear in the white column to the right of the price selected

Left Click: LMT
1. Leftclickin the red column at the price you would like to place a sell LMT

2. The qty of the working order will appear white column to the right of the price selected
Modify Price/Quantity of an Order

Price of an Order
1. Place the initial order by left clicking in the green column at the price you would like to place a buy limit

2. To modify the price left click the order and drag and drop it to the new price

View
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FX]

)

# ESZ6 - Depth of Market

| @ & |efF v 34 ||  DEMozssso -
Oty 1% Total PAL $ 662,50
Poz: o

[ Cancel Bids H Cancel Al H Cancel Offers ]

1331.00
1330.75
133050
133025
1330.00
1329.75

........

1329.25
1329.00

B

Left Click: Modify Oty
Right Click: Cancel
Drag: Madify Price

| BuwMKT || Gotolast || selMkT |

Quantity of an Order
1. Place the initial order by i.e., left clicking in the red column at the price you would like to place a sell LMT

2. To modify the QTY left click the original order and select a new QTY from the pop out box

"¢ B =
- N I 1= DEMC25830 - -
Ifr_l_ai"'?é_}lrﬂl |
ity 1% Total PAL: $ BE2.50 14
13
Paoz: 0 12
[ Cancel Bids ] [ Cancel &l ] [ Cancel Offers ] ::1['
:

........ E
| E 1 :
I 133325

| Left Click: Modify Gy
1333.00 Ft Click: Modif

e 133275 Right Click: Cancel
I 1332 R0 I Drag: Modify Price
I 13225 1 k
I 133200 G 2
N 1331.75 1
N 133150 EEHE

- EEm -

| BuMKT || Gotolast || selmkT |

Thumbtack
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Stay on Top

View

To make the DOM ticket stay on top of other applications left click on the Thumbtack so it is pointing straight into the

ticket. To allow the DOM to move behind other applications left click the thumb tack again so it is sideways

When the Thumbtack is pointed out to the left this means the STAY ON TOP feature is not active.

# 6AZ6 - Depth of Market

BEx]

| [F & | Bf ¥ (3 G [l | DEMO999 -
Qty: 1% TatalPAL: $0.00
Pos: 0
| CancelBids || Cancelal |
r
75.15
75.14
75.13
75.12
7511
-
| BuwMKT || Gotolast || SelmkT |

# 6AZ6 - Depth of Market

BEx]

@ || @ & |F v (35 |Mll |  DEmMosgsss -
Oty 113 TotalPAL: $0.00
Poz 0
| CancelBids || Canceltu |
il
75.15
75.14
75.13
75.12
7511
-
| BwMKT || Gotolast || SelmkT |

Display Options

Auto Center Price

This Options keeps the MKT prices in the center of the viewable length of the DOM

When the Thumbtack is pushed in the STAY ON TOP feature is active and will stay on top of all other applications.
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Open Order Stats

Provides the total number of open orders for each SIDE at the bottom of each column.

Auto Sum Bid/Ask

e  Adds up the total Volume traded for the BID and OFFER and displays it at the bottom of the respective
columns

®  Open Order Stats and Auto Sum Bid/Ask CAN NOT be active at the same time

Open P/L

Open P/L represents the amount of Profit and Loss when the open position exists. If Open P/L is not checked then
the Total P/L will show. The Total P/L represents the whole profit and loss from all your trades in that DOM.

Open Pos Price

Your open positions average price will be displayed by an arrow. You will see it displayed on the Offer if you are
short and on the Bid if you are long.

Show Tooltip

This options is for first time users of a Depth of Market order ticket. The tooltip allows traders to see what type of
order they can place and where they can place it on the DOM

-

& DOM Setup
Display | Wumber Pad | Font & Colors

Dizplay Items

[] Auta Center Price [] OpenPiL

[] Open Orders Stats Open Pos Price

Auto Sum BidAdsk Show Tooltip

[ k. l [ Cancel ] [ Apply

Number Pad

1. Configure the number pad to the amounts you desire to have in each key punch options

2. Click apply and the Number pad will change without having to reload the Number Pad



View

@ DOM Setup x|

Configure the number pad

Setto Zera
1 2 3
4 4] 10
15 0 20 | BO

Set to Defaulk:

[ k. H Cancel ][ Apply

Font & Colors

e  Allows Traders to change the DOM and the colors of the orders

e OCO'’s, Stops, and Trailing Stops can be customized to their own recognizable color for easy view and quick
reference.

[ ]

The option to restore the defaults is available if the color scheme does not work for the trader

# DOM Setup X|

Fart

AaBbyyez [ Change font . ]

Wwhorking order colorz
oco: | |
Stop: | NN v |
TraiingStop: | I~

[] Save az Defaults [ Load Defaults ]

[ k. H Cancel ][ Apply ]
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Red/Green Indicator

We have also added the high and low of the launched contract to the DOM order ticket. The high of the day is
displayed by a red line and the low is displayed by a green line.

Number Pad

Touch Pad

Number pad is able to be opened and closed with the options at the top of the page that looks like a number pad.

You can change the number template within Display.

# 6AZ6 - Depth of Market

[ setozen 4[]8 ¥ 36 )

Oy | 1% TatalPL

Pos: 2 @753 @
[ CancelBids | [  Cancelanl |

Set to Defaulks

F Y

75.34
B @ | 7533

OCO Orders

Order Cancel Order (OCO)

96



View

" .| X
= | [ [5F ? 3 S |l | DEMO4704 - |
Qty: 5% TatalPAL: $0.00

Pos 0 @ Confirm orders

a Buw 5 ESZE LMT 1324.50
Buy 5 ESZE LMT 1326.00

B -
I
- [ Yes ] [ Ha
.
10 1326.00
1325.75
2720 132550
1325.25
1325.00
I 1324.75
E 132450
Left Click: OO LIMIT
| BwMkT || Gotolast || selmkr |

1. OCO (One cancels other) is a pair of orders sent together.
2. Currently only Limit and Stop orders of one side (buy limit/buy stop or sell limit/sell stop) are supported.

3. Tosend OCO orders, user needs to check OCO toolbar button, and then send two orders in usual way.
Another way to enter a single pair of OCO orders, user could hold SHIFT key while clicking.

4.  After clicking first order, the price would be marked with different color, until second order is entered. To cancel
OCO order entry after first order is entered, user should uncheck OCO toolbar button (or release SHIFT key).

5. Working OCO orders are displayed in blue color by default.

Order Flags
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BX]

L

# ESZ6 - Depth of Market

= | [ 5 - =, |l | DEMOZ5830 -
Qty: 0/ Total P/ $1,000.00
Fos: 1]

<
I 1329.00
13227 R
122850 [
122825 R
122800 [
2615 122775 R

1227 RN
N - BEos

Order Flags

@ Nore O GTC O FOK O 10C

Good Till Cancelled (GTC)

Order remains on the books until cancelled and can be filled at an undesirable time if forgotten

Fill or Kill (FOK)

LMT orders which, if not filled immediately, are cancelled

Immediate or Cancel (I0C)

LMT orders which, if not filled immediately, are cancelled

Stop Limit/Trailing Stop

Stop Limit (STP LMT)

®  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not become
MKT orders once the STP price has been reached

e  Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order will not be
filled unless the price remains at or drops below the limit level

®  Sell STP LMT is activated when the commodity is offered or traded at or below the STP level, the order will not
be filled unless the price remains at or rises above the limit level

e  No order can be guaranteed an execution
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# ESZ6 - Depth of Market

mE]

A | 3 & | ef "?IF} |l |  DEMos7094 ~
Oty 5/%]  TatalPAL: $0.00
Fos: 0
Fs
132675
1326.50
1326.25
1326.00
132575
132550
1325.25
1325.00
1324.75
TE30 -
| BuwMkT || Gotolast || selmkr |
[ ] Stop Limit [ ] Trailing Stop
Factor; Factor; 0.25 {3}
Trailing Stop

A complex stop-loss order in which the stop loss price is set at some fixed percentage below the market price. If the
market price rises, the stop loss price rises proportionately, but if the stock price falls, the stop loss price doesn't
change. This technique allows an investor to set a limit on the maximum possible loss without setting a limit on the
maximum possible gain, and without requiring paying attention to the investment on an ongoing basis.

Bracket Options
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ESZ6 - Depth of Market Mi==
W | 3 & |=f v AlE ||l | DEMo47094 -
Oy 5% TotalPAL $0.00
Fos: 0
- [Cffer
[ 1327.75 2327
e 132750 2335
| 132725 [EXED
1327.00
132675
- 10062
| BuwMkT || Gotolast || Selmkr |
[ ] Buy Bracket [] Sell Bracket
[ ] Sell Limit [] Buy Stop
Factor: Factor:
[ ] 5Sell Stop [] By Limit
Factor: Factor:

Buy Bracket

1. Bracket orders are designed to limit your loss and lock in a profit by "bracketing" an order with two opposite-side

orders.

2. A BUY order is bracketed by a high-side sell limit order and a low-side sell stop (or stop-limit) order.

Sell Bracket

100

1. Bracket orders are designed to limit your loss and lock in a profit by "bracketing" an order with two opposite-side
orders

2. A SELL order is bracketed by a high-side buy stop (or stop-limit) order and a low side buy limit order.

Account Filter

Scroll through various accounts you might have and trade the same contract with a click of a button.



P/L

ESZ6 - Depth of Market

L

=]

=1 | [ & |oF [¥ ] & |l | [oEmossssn -
Oy 003  TotalPL DEMOZ5E30

DEMOB5399
Poz: 1]

- Offer
- 1329.25 lﬂﬂ
1329.00
1117 132875 -
1328.50 Il
| 4 | 132825 I
-

Goto Last

Order Flags
() Mone (O GTC (3 FOE. (O 10C

Qty
Amount of contracts you desire to trade for the entire ROE.
@ ESZ6 - Depth of Market mEX]
| | [ & |F v A G |l | DEMo47ond -
ity 5l Total PAL: $0.00
Pos: 0

1326.25
1326.00
1325.75
1326.50
1325.25

-

| BuwMKT || Gotolast || SelmkT |

Open P/L or Current P/L

View
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@ ESZ6 - Depth of Market LEE)
A | 3 & |EF v (A 5 || DEMozssso -
Oty 0% | Total PAL $1,000.00
Pos: 0

-
| 1329.25 1
1329.00
1328.75
3883 1328.50
N 132825
e

3o to Last

1. Open P/L is the Profit and Lose for the Position that is open currently

2. Current P/L is the Profit and Lose for all positions that have been traded on this session

Position

Shows the amount of contracts you have open and at what price they are open at.

%]

L)

ESZ6 - Depth of Market

| [F & | Ef ¢ (3 5 Gl | DEMO2S830 -
Qhy: 5% Total P/ $ 81250
Fos: 5@1323.50 [ Exit at MET ] [ Reverse ]
| ConcelBids || Cancela |
-
1348 1329 N
N 1124 122200 [
3661 122275 [
2621 122250 [
3932 122225 [
| 4 | 152800 N
I 13277
1 132750 [
| 2 132725
I 132700 [
I 13675
[ 1 132650 [
1326.25
-
| BuwMKT || Gotlast || selmkT |
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Exit at MKT

Turns any open position into a FLAT position by trading the opposite of the open position.

" ] b
42 | @ 4 [BF| v (3 G @@ | Demozssi0 -]
Qty: 5% TotalPAL: $ 812,50
Pos: 5@ 132375 I Euit at MET l [ Reverze ]
| CancelBids || Cancelal |
I 1330.00
B = 132975 [EEWD
1061 | 132950 (oo S
1329 25 ) Order Confirmation
I 3403 | 1328.00 _
Eo64 137875 Account; DEMOZE820
1328.50 Send SELL 5 ESZ6 MKT?
8 | 1328.25
4 | 1328.00
N 1327.75 | ok | [ Cancsl
1| 1327.50
I 122725 [
1327.00
-
| BuMKT || Gotolast || selMkT |
Reverse

Will take any open position and EXIT it and then reverse the position by placing the identical position on the reverse
side. it was initially open on.

i.e., ES 1 @ 1329.75 and reverse the position it would end up ES -1 @ 1329.75
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" : X
=) @ 5 ) ef v (3 G |6l DEMo2sesn -
Qty: 1% Tatal PAL $ 725.00
Pos: 1@132975 | ExitatMKT | | Reverse |

id E S Offer
IYCl 17 |p 132975
2749 132950 =
2105 132975 Eﬂrder Confirmation
3475 1329.00
| 2 132850 @ Send SELL 2 ESZE MKT?
8 | 1329 25
4 | 1322.00
- 1327.75 [ k. ] [ Cancel
1 | 1327.50
I 132725 N
I 132700 [
1326.75
-~
| BuMKT || Gotolast || SelmkT |
Cancel orders
# ESZ6 - Depth of Market =)<
= | [ 5 |af ¢ (A5 || DEMo2ss30 -
Oty 11 Total P $ 587.50
Poz: -1 @ 133025 [ Exit at MET ] [ Beverze ]
[ Cancel Bids ] [ Cancel &ll ] [ Cancel Offers ]
Bid - Offer
I 133328 [
I 133300 [
I 133275 HEE
I 133250 [
I 13322 A
I 133200 A
N 122175
I 1331.50 3160
[ 1331.25 3327
-
| BuwMKT || Gotolast ||  selmkT |
Cancel Bids
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This options will cancel out of all working orders on the BID side

Cancel All

This will cancel ALL working orders

Cancel Offers

Will cancel out of all working orders on the OFFER side

At Market
# ESZ6 - Depth of Market M=
|3 & |Ef v (2 5 |l | DEmoessan -
Oty 1% Total P/ $ B87.50
Pos: -1 @ 133025 [ Exit at MET ] [ Reverse ]
[ Cancel Bids ] [ Canicel All ] [ Cancel Offers ]
- Offer
12222 R
122200 [
1332.75
122250 [
13225 R
13200 [N
133175 R
1331.50
1331.25 3327

- 13079

| BuwMKT || Gotolast || SelMKT |

Buy MKT

Place a Buy @ MKT at the bid price

Go to Last

Will center the MKT Prices; without having to scroll; if they have trailed off the existing view

Sell MKT

Will place a Sell @ MKT at the offer price

View Quotes
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=ymbol
UGB
BB
WG
Sls
B
ML
HOUG
506
FDAXLG
ER2UG
LV
CUB

The columns can be configured to be displayed or hidden. Below is a list with all the columns available from the

Quotes window.

Symbol

Last
107 04.0
110 11
3.9700
12,4490
54175
1682.25
1.9530
B10.5
58725
7218
7010
2.2875

The contract symbol.

Last

Last price at which the contract was traded.

LastVol

The last amount of Volume that trade that specific contract.

Bid

The bid market price.

BidSize

The total amount of bids on that contract.

Ask

The offer market price.

AskSize

The total amount of offers on that contract.

High

Last ol

—_

OO MR EOCO —=0Wwom

Bid

107 04.0
11010
0.0000
0.000
0.0000
1582.25
1.9450
a.a
a5720
217
0.00
0.0000

BidSize
1542
2111

a

~ oo =00

o=

The highest price traded of the contract during this trading session.

Low

Ask
107 04.5
110 11
3.8800
12.410
£.4050
158275
1.9500
0.0
8725
7219
0.00
0.0000

AskSize
2033
708

The lowest price traded of that highlighted contract during the most current trading session.

Chg

The total amount of change from the opening of the current trading session.

Chg%



View

The total percentage of change from prev. day settlement.

TotalVol

The total volume traded on that specific contract through the current trading session.

Open

What the price was of the contract at the opening of the current session.

Settle

What the contract price was at the end of the most recent close.

Updated

The most recent time at which the contract's price, bid/ask, volume etc was updated.

Base Contract

The symbol of the contract that is being traded without the year or month attached. e.g: The ESU6'’s base
contract is ES.

Expires

The date the contract will no longer be available to be traded.

Description
The name of the contract. e.g: 2. The ES has a description of E-Mini S&P.

Currency
The currency that the contract is traded in. e.g: 2. ES E-Mini S&P trades in USD and DAX DAX trades in EUR.

Exchange

The exchange that the selected contract is traded on.

Group

The group that the selected contracts falls under e.g. ES is a contract under the Indices Group .

Type
Whether the contract is traded electronically (E) or pit (P).

Start Time

What time the contract opens in relation to the exchange’s time zone. E.g. CME is Chicago Mercantile
Exchange which is located in Chicago, IL on Central Standard Time (CST).

Stop Time

The time the contract closes in relation to the exchange’s time zone.

Tick Size

What the increment amount is per tick. The ES has a Tick Size of .25. e.g. ES has gone from 1309.50 to 1310

therefore it has increased by 2 ticks .

Per Point
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The total amount of amount effected per point. The ES has a Per Point value of 50. This mean that if the
market moved up one point from 1309 to 1310 someone who was Long would make $50 on a 1 lot. To find out
the per tick value, multiple the Per Point value by the Tick Size. 50 x .25 = 12.50 per tick for the ES.

Charts

Charts - Open
a. Left-click on VIEW in the Toolbar Scroll down to CHARTS one up from the bottom

1. Click on NEW and Market Selection will prompt you

e  Enter the Market you want and click ok

2. Click on anything below the line i.e. Chart — 15 min (ESU6)

e  Thisis a chart that you have either opened during this current session or a chart that you have
save

b. Right Click on the contract you want in the QUOTES box

a. Scroll down to CHARTS one up from the bottom and the chart will appear
c. Launch a DOM

1. In the top toolbar below the title bar will be a set of icons

2. The eight icon from the left looks like a bar chart

3. Put you mouse on it, so it is highlighted and left-click

4. The chart will appear for that DOM
Add Indicator

Add Indicator
Customize or select from a variety of indicators and profiles.
1. Click on ADD INDICATORS in the top left corner of the chart

2. Add indicators via RIGHT_CLICK shortcut. Right-Click any where on the graph and have a menu bow pop up
and select ADD INDICATORS.
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# Chart - 15 min (ESU6)

Conkract. ..

L

High 12

™
W

ARC |r'I'I!"'Lﬂ
.;?r, & 2008

Open 13

=

Add Indicatar = 15 min

Channels

Data

Moving Averages
Oscilliator

Prices

Trend Followers
Wolatility

Yolumes

| @ Connected | 08/24/2006 16:30

* OHLC
b -
» L1304.75
3
L1202 00

P .....
b
y -1296 50
3

10:44:00 AM .2

Volatility

View
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# Chart - 15 min (ESU6)
Contract,,, |&dd Indicator =| 15 min
L, High 12 Channels
b Open 13 Daka
B Maving Averages
_s Dscilliator
| ﬁ Prices
pu H'ri Trend Followers
Ff’ @ m| Yolakility » Awverage True Range
1 % Yaolumes k Standard Deviation
ip) @ Connected | 08/20/2006 17:15 wolatility
wolatility Chaikins
Wolatility Fatio

Average True Range (ATR)
e  Appears below Contract chart

e  Measures commitment comparing the range between High, Low and Close prices

Standard Deviation (StdDev)
e  Appears below Contract chart

e  Difference between values (Closing Price) and average.

Volatility (Volatility)

®  Appears below Contract chart

Volatility Chaikins (CHV)
®  Appears below Contract chart

e  Difference between high and low prices, indicates the top and bottom of the market

Volatility Ratio (VR)

®  Appears below Contract chart

Channels



'@ Chart - 15 min (ESU6) m=<|

Contract... | Add Indicator = | 15 min * OHLEC v A
L High 1E| Channels ’ Bollinger Band
, LDpen 12 Data » Cormmadity Channel Indesx
b Moving Averages 3 Envelopes
i Oscilliatar * Keltner Channel
| Prices 3
pu "_‘ll Trend Followers 3
'Fr" 2 2006 Yolatility ]
" % Yolumes 3

_.!' Connected | 03/20/2006 17:15 10:54:05 AM

Bollinger Band
e  Will put a Bollinger Band on the chart directly

e  This indicator can be used to measure the relative highness or lowness of price

Commodity Channel Index
e  Will put a Chart below the existing Contract chart

e  Compares Prices with its moving average

Envelope
e Wil apply a envelop directly on the contract chart

e  Plots above and below the moving average at a specified percentage

Keltner Channel

e  Will apply 3 lines to the Contract chart

e  This indicator shows a central moving average line plus channel lines at a distance above and below

Data

View
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'@ Chart - 15 min (ESU6) LoE)

Contract,.. | Add Indicator = | 15 min T OHLZ w7

L, High 12 | Channels ro |‘

L Zeen 12! Data ’ | Yolume 75

b Moving Averages k

il Oscilliakor 3

| Prices r

. Hﬂll Trend Followers 3

Fr" & 2008 Yalakility b

" % Yalurnes 3
_ﬂ' Connected |EIE!,|'2EI,|'2EIEIE~ 17:15 10:57:42 AM .-
Volume

e  Will put a volume chart below the contract chart

e  Shows the amount of trades at a specific time of the day

Moving Averages

~ -
@ Chart - 15 min (ESU6) M=1<
Contract,.. | Add Indicator = | 15 min T OHLZ w7
L, | Channels 3 -
b Data * F 130475
b | Moving Averages 2 Exponential Moving &verage
5 Dscilliator ] Least Square Moving Average
| Prices L Rolling Mowing Average
al ﬁﬂ Trend Followers 4 Sirmple Moving Average
Fr" & 2006 Walakility k Triangular Mowing Average
1 % Yalumes » Triple Moving Average
uip @ Connected | 08/20/2006 17:15 Variable Moving Average
Weighted Maoving Average

Exponential M.A. (EMA)
e  Will apply a line direct to Contract Chart

e EMA is an average of data calculated over a period of time where the most recent days have more weight

Least Square M.A. (LSMA)

e Wil apply a line direct to the Contract chart

Rolling M.A. (RMA)

e Will apply line direct to Contract chart
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Simple M.A. (SMA)
e Will apply line direct to Contract chart

®  The average of data calculated over a period of time

Triangular M.A. (TMA)
(] Direct line onto Contract chart

®  Average calculated over a period of time where the middle portion of the data has more weight

Triple M.A.

e Applies 3 lines on Contract chart, the Slow, the Fast and the Median

Variable M.A.

e Will apply line direct to Contract chart

Weighted M.A.
(] Direct onto the Contract chart

® An Average where the greater weights are attached to the most recent data, it is calculated from the sum

of the day
Oscillator
— 1
# Chart - 15 min (ESU6) M=%
Contract,.. | Add Indicator = | 15 min * OHLC ~
Lx High 12 Channels 3 r
[ Zeen 13 Diats v L1:304.75
B Moving Averages k
_is | Orscilliabor » Average Directional Index
| Prices » Detrended Price Oscillakor
. ':'Ii Trend Followers 3 Mormenkum
{—ip & 206 Wolatility » Performance
+ % Yolumes k Price Osciliator
) @ Cormected | 08/20/2006 17:15 Rate OF Change
Relative Strength Inde:x
Stochastic
Williarn's %R

Average Directional Index
e  Will appear below the Contract chart

e  Will have three lines, ADX, -DI, +DI

Detrended Price Oscillator

e  Will appear below Contract chart
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e  The Detrended Price Oscillator is used to "remove" the trend from the price. Comparing Closing or any
other price with it's moving average

Momentum

. Will appear below the Contract chart

Performance
e  Will appear under the Contract chart

e  Compares the current Close (or any other price) with the first Close value. Shows how much the Close
price was changed from the beginning

Price Oscillator
e  Will display below Contract chart
e  Rate of Change

®  Appears below Contract chart

Relative Strength Index
®  Appears below Contract chart

e  Compares upward movement of the Close price with the downward movement resulting in a value which
ranges from 0 and 100

Stochastic (%K, %D)
®  Appears below Contract chart

e Indicator helps to find trend reversal searching for a period when close prices is close to low price in up
trending market or close prices is close to high price in down trending market

William’s %R (%R)
®  Places the charting below the Contract chart

e  This indicator is used to measure overbought and oversold levels

Prices
e -,
#! Chart - 15 min (ESU6) M=l
Conkract... |&dd Indicator - | 15 min |*| CHLC =
L, High 12 Channels 3
-4 Open 12 Daka »
b Moving Averages k
5 Dscilliator ]
| | Prices r | Median Price
al Trend Followers 3 Typical Price
FH & 2008 Walakility k Weighted Close
" % Waolumes ] —
) €} Connecked | 08202006 17:15 11:15:30 &AM
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Median Price (Median)
®  Places a line directly on the Contract chart

e  Mid-point value of daily prices

Typical Price (Typical)
e  Appears directly on the Contract chart

®  The average value of the daily prices

Weighted Close (Weighted)

®  Appears direct to the Contract chart

e  Average value of daily prices, only difference is that the closing price has extra weight as the most

important price

Trend Followers

¥ Chart - 15 min (ESU6)

Conkract,., |A&dd Indicator - | 15 nirs

L\ High 12 Channels

4 Open 12 Daka

S Maving Averages

i Oscilliator

Prices

Alnc Hﬂﬁi Trend Followers 3 MECD

Fﬁ' @ 2008 Walakility k Mass Index

1 Iii% Yalumes r Tangent of Linear Regression
iy @ Connected | 08/20/2006 17:15 TRIX

—

MACD (MACD, Histogram, Signal)
®  Appears below Contract chart

e  Compares two moving averages of prices.

Mass Index (MI)

e  Below the Contract chart

e  Developed to predict trend reversal by comparing difference and range between high and low prices

Tangent of Linear Regression (Tangent)

®  Appears below Contract chart

TRIX (TRIX)

e  Below Contract chart

e  Based on triple moving average of Closing Price and its purpose is to eliminate shorter cycles

Volumes

View

Is used with its 9 day Exponential Moving average as signal
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'@ Chart - 15 min (ESU6) M=)

Contrack,., |&dd Indicatar = 15 min * CHLC -

L\ High 12 Channels 3

'

Open 13
SO Data v L 1204.75
b Moving Averages k
- F 1302 .00
C=cilliator 3

| Prices »
. ,ﬂr\" Trend Followers 3
Fﬁ’ @ 2008 Wolatilitsy 3 m
1 Iiit_a‘ﬁl Yalumes r Accumulation Distribution

| ™ {3 Connected | 05/20/2006 17:15 Ease of Mowvement
Money Flow Index

Megative Yolume Index
On Balance Yolume
Positive Yolurne Inde:x
Price Volurne Trend

Wolume Cscillator

Accumulation/Distribution (A/D)
e  Appears below Contract chart

e  Estimates the strength of price movement with the relationship between volume and prices

Ease of Movement (EoM)
®  Appears below Contract chart

®  Uses volume to estimate how strong the price trend is

Money Flow Index (MFI)
®  Appears below Contract chart

e  Compares upward changes and downward changes of the volume weighted typical prices

Negative Volume Index (NVI)
®  Appears below Contract chart
e  Should be used with PVI

e  Changes only if the volume decreases from the previous day

On Balance Volume (OBV)
e  Appears below Contract chart
®  Measures positive and negative volume flows.

e  Volume is added if the closing price moves up and subtracted if the closing price moves down

Positive Volume Index (PVI)
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®  Appears below Contract chart
e  Should be used with NVI

e  Changes only if the volume decreases from the previous day

Price Volume Trend (PVT)
®  Appears below Contract chart
e  Cumulative volume total

e  Calculated by using the relative changes of the Close price

Volume Oscillator (VO)
®  Appears below Contract chart

e  Tries to identify any trends in volume, comparing two moving averages; one with a short period and the
second with a longer period

Period

This function allows you to set the time period for each unit (e.g. bar, candlestick, etc.) of your chart. The minimum
time increment is 1 minute, and the platform can be configured to display periods of length up to one day.

o 1
# Chart - 1 min (ESU6) M=%
Contrack,,, Add Indicator = |1 min = | OHLC -

L\ - 1 min ~
High 1305.50 Lows 1305, = Iiin f—
k- Open 130323 Close 130%.153 min
Mo 4 min
b H1302.75
- F1302.50
| F1301.25
AEC
F F1300.00
1
| @ 2008 Qpen E Ciy, LLT ﬁi’m
t : :
annecke g feich
| @ C ted | 08/28/2006 04:29 11:33:10 AM
Profile
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-
# Chart - 3 min (ESU6) mE X
Contrack,,. #&dd Indicator = 3 min * OHLC =
Lk High 1304.00  Lowe 130400
\\ Open 130400 Claze 130400 .
R Properties  orss
| X
| add Indicator 1 r1300.73
Period ] F1293.00
Profile & save Profile...
Area Save As Defaudlt, .,
Series Delete Profile. ..
Drawing Tools , Select Profile b A
Expatt b Bollinger Band
Auka Scral Wolumes
Offset MMomenturn
b Foom In CErl+1 Default
= Zoom Cut Chr 40 areen On Black
Save Profile

This allows you to save the currently selected chart with all of its settings for future use. Upon selection, this
feature presents you with the opportunity to use a default chart name or create your own chart title for increased
customization and personalization.

Save as Default

This allows you to not only save the currently selected chart but also to set it to your default chart upon the
launching of the platform. This function is recommended for what each trader would consider being the chart
from which he/she obtains the most utility.

Delete Profile

This allows you to remove a previously saved profile.

Select Profile
ADX (Average Directional Index)

This indicator evaluates the strength of the current market trend. The resulting figure is one that indicates
relative strength, with further implication upon the trading style that will prove most effective in a given
market. The oscillator fluctuates from 0 to 100; readings above 40 indicate a strong trend, while readings
below 20 indicate one of relative weakness.

Bollinger Band

These are indicators placed at standard deviation levels away from a simple moving average. The
resultant standard deviation derived from the applied formula indicates the relative volatility of the market.
Volumes

This indicator simply displays different levels of volume in a given market. A volume oscillator is intended
to compare moving averages of varying time periods to compare volumes.
Momentum

The momentum profile provides the trader with a simple moving average on the chart, and, in addition,
charts indicating the momentum and RSI of the market at its current state.
Default



Are

View

This function returns the trader to the chart profile that he/she has saved as the contract's default profile.

vi. Green on Black: This chart is differentiated largely by its aesthetic divergence from other charts; what
was once a chart of black lines against a white background is now one of green lines against a black
background.

a

Allows you the ability to see properties of series, removes series, Freeze Limits or Auto Limits

NOTE: the Contract chart will be the default chart unless you right-click on the Line or chart you want. You will know
the Chart has been selected because it will have points highlighted along the line itself.

~

Chart - 3 min (ESU6) Mm=Ex|

Contrack,., Add Indicator « 3 min * OHLC -

L,

High 1304.00  Low 130400

™
B

Open 130400 Cloze 130400
- 130400

Properties
b

F1302.25

F1300.30

Ser

Add Indicator 3

Period k 123873
Profile 3

Area r | Properties: Chart Area 1
Series ¥

Drawing Tools » Freeze Limits

Export , Auto Limits

Properties: Chart Area X

Will open the Properties box on the right side of the Chart. With this you can change around and customize
appearance. (SEE SELECT PROFILE > 3. PROPERTIES BOX)

Remove: Chart Area X

Will remove the selected chart from all chart area.

Freeze Limits

Freeze limit will capture the high and low prices of the currently viewed chart window. Once the prices have
been captured the viewable window will not change, therefore not allowing the chart to be viewed above or
below the high or low price which was frozen.

Auto Limits

Auto limit allows the viewable chart to adjust to the necessary prices accordingly. The high and the low of a
specific contract will adjust its scale depending on how high or low the market price diverges from the initial
median price.

ies
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~

L

"

. -\
Chart - 3 min (ESU6) MR
Contrack,.. Add Indicator = 3 min = OHLC -
High 1304.00 Lows 130400
Open 130400 Close 130400 T
T LT Rt LT 1:30.001
Propetties
F1302.25
Pl
F1300.50
Add Indicakor 3
Period 3 [1238.75
Profile 3
Area 3
| Seties ¥
Drawing Toals ’ save As Default
Expork r Indicators. ..
[

Move to New Area

Once a chart indicator has been highlighted by right-clicking on the desired chart, traders can move the chart to
a new viewable window below the contract chart window. A number of indicators already start in a new chart
area . Some of the moving averages for example appear directly on the contract chart, thus being able to be
moved to a new chart area.

Save As Default

Saves properties as default for newly created series of the same type.

Indicators...

Shows the Indicator List Dialog. The Indicator List dialog allows traders to remove indicators or modify
properties of the selected indicator.

Drawing Tools
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-
# Chart - 3 min (ESUS6)
Contrack,,. #&dd Indicator - 3 min -
L\ High 1303.75 Lows 130375
\\ Open 130375 Cloze 130375
XS Properties
b F1202 .25
| add Indicatar » F1300.50
AEC Period »
(i 4 Profile »
t Area b
ﬂ Series 3 12:09:43PM .t
| Drawing Tools » | Painker
Expart p | B Trend
Auto Scroll S| Line
Offset () Callout
g9 | Zoom In Chrl+1 4EC Texk
= Zoom Ot ChE+O — | Horizonkal Line
Diata Box | | wertical Line
Crosshair Mode w | T Arrow
Load More Data By Send To Back
W Volume L Ering To Front
Allowe Selecting
Select Al
Pointer

Allows traders to highlight specific area by dragging the cursor. Once highlighted the trader can zoom in on the
highlighted area.

Trend

Displays trend lines with 3 lines. The standard deviation, the variance and the average. This can be adapted
by only the trends of the Chart, they are not free flowing and they are not dependent on the y axis or price.
Line

This is a free flowing chart that can be changed with not regards to either the x or y axles.

Callout

This allows traders to place call outs attached to specific high or lows at a certain time. Traders can put
whatever they desire in the call outs.

Text

Text is an option where traders can put text on the chart not dependent on anything but their text within the text
box.
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Horizontal Line

This line can ONLY move horizontally no matter how vertical your diverge from the initial point on the line.

Vertical Line

This line can ONLy move vertically no matter how horizontal you diverge from the initial point on the line.

Arrow
Place thick highlighted arrow anywhere on the chart.

Send to Back

The options send the highlighted chart to the back of all the other charts on that same chart area.

Bring to Front

This options sends the highlighted chart to the front of all the other charts on the same chart area.

Drawing Properties

Allows you to customize the drawing properties of the previously placed drawing tools.



# Chart - 15 min (6AU6)

Conkrack, ..

add Indicatar - 1E

LH High 73.33 Low 73.23

.,
W

! :

Open 7523 Close 75.33 I

Add Indicator = 15 min * OHLC

+ Indicatars, ..

Select Profile -

Contrack, ..
High ¥5.35 Low 733
b Open 7534 Close 733
Wy h "

[ O
T
I | 11] m
AEC i 1
tid [
+
P
Bh
Th

In the example above the trader drew a vertical line then while the line or object is highlighted, left-clicked
'Drawing Properties' in the left panel to view the properties window of my vertical line. | selected Color: Red,

Vertical - @

) Connected | 09/10

E Appearance

Colar Bl Red

End Cap Diamond [V]
Mode Finite

Start Cap Arrow

Shyle F solid

Width s G

il

al
I

|

i

1 g"

it
nl
T

o]

[] Save az Default

End Cap Diamond, Mode: Finite, Start Cap: Arrow, Style: Solid, Width:6.

Remove Drawing Object

The will remove the highlighted drawing from the chart area.

09:00

View
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Allow Selecting

When 'Allow Selecting' is checked, the trader is able to highlight or select the drawn objects in the chart by

performing a left-click on the desired object.

Select All

It will highlight or select all the objects drawn on the chart.

Export

Print

This function allows the trader to send the currently selected chart image to a printer of his/her choice.

Save Image

This allows the trader to save the currently selected chart as an image of specified file type on his/her computer

or external drive.

Save XML

This allows the trader to save the currently selected chart as an image in XML format, which is then available

for use for generation in other applications.

Copy

This allows the trader to copy the image of the currently selected chart to be able to paste into other

applications.

Auto scroll

# Chart - 3 min (ESU6)

Contrack,.. Add Indicator = 3 min * CHLC

L

High 130375 Low 130373

b
W

Open 130375 Claze 130375
T | ——

F1302.23

F1300.50

12:14:59 PM

This provides a constant timeframe for the chart. In other words, as the day progresses and the chart extends out to
the right, the data displayed on the chart will systematically progress toward the left in order to keep the most recent
data on the right side of the chart. Auto scroll can be selected (checked) or deselected (unchecked).

Properties
Pt

Add Indicator g
Period g
Prafile g
Area g
Series '
Drawing Taols g
Export b

Auka Scrall




View

Offset

This causes the display of the chart to have a relatively small blank area in between the most recent market data and
the far right edge of the chart. It is largely used for the increased ease in visual distinction it provides with respect to
market data. Offset can be selected (checked) or deselected (unchecked).

Zoom In (CTRL+I)

This allows the trader to decrease the amount of data viewed at one time on a chart. It allows him/her to more
closely see short-term market movements.

Zoom Out (CTRL+O)

This allows the trader to increase the amount of data viewed at one time on a chart. It allows him/her to better see
long-term market trends.

Data Box

This allows the trader to toggle the data box containing data such as market high, low, open, and close, normally
located in the top left corner of the chart on (checked) or off (unchecked).

Crosshair Mode

This option allows the user to specify how he/she would like the crosshair feature (red cross on the chart) to be
displayed.

Hidden

The crosshairs are not visible
on the chart

Free

The user must click on a
location on the chart to make
them appear. Upon
placement, they do not move
unless reassigned.

Mouse

The crosshairs move
unrestricted in conjunction
with the user's mouse
movements.

StickyClick

The vertical bar moves
somewhat freely (“stickily")
with the user's mouse
movements, but the
horizontal bar changes only
upon the user's specification
by mouse click.

Sticky

The crosshairs move
somewhat freely (“stickily")
with the user's mouse
movements.

Load More Data
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Load more data allows the trader to increase their viewable charts by simply clicking on the load more data. This will
decrease the size of the scroll bar therefore increase the amount of data available to be viewed. The Zoom in and
Zoom out are not effected by this option. Load More Data basically provides as much data as possible on the charts,
allowing the trader to view multiple days if not weeks of data on one chart.

Volume

126

Select "Volume" in the sub menu.

- .
# Chart - 3 min (ESU6) Mi=[<
Contrack,., Add Indicator + 3 min * OHLC * Indicators. .,

L High 130325 Low 1303 00
-4 Open 130325 Cloze 1302.00 X
N Mo T o s T T iy | L1203 .75
L WHF Add Indicakar 3
W Period b 120150
| Prafile 2 .
AEC
i Area ’ L1299 25
i Series 3
T
| ® 2006 Open E Cip, LLC Drawing Tools 3
,
01:00 | Z00E/0E/] Expart b
i) @ Connected | 0j24/2006 03: At Scrol 2:76:28 PM
Offset
Zaom In Chrl+1

Zaorm Dok Chel+0

Daka Box

[<] 0 <

Crosshair Mode 2

Load Mare Data

| i volume

Volume view



# Chart - 3 min (ESU6)

BEx]

Conkrack,,. Add Indicator = 3 min + Indicators. .,
L\ High 1303.00 Lows 130275
b Open 130275 Clase 1303.00
s olurme 95 L
b,
|
AEC i
01:00
(1]
+
i 12375
& 2006 Open E Cry, LLT
i € Connected | 08242006 03:51 12:27:40 PM

Chart Properties

Properties
Current Profile

Appearance

The chart properties are fully customizable.

View

¥ Chart - 15 min (ESZ6)

BEx]

Contract... #Add Indicator + 15 min * OHLC + Indicators... Seleck Profile - H | ﬁ
L, | " lispss | Propeties |Data | Indicators
o Current Profile ™
‘ b - 1
s % B Appearance A
i H 134725 Background Color [ ] White B
134575 Eackground Gradier [ | White
| B Bid/Ask
. 134425 Ak Color [ ] Silver
] L1242 75 Bid Colaor [ ] Silver =
(ig Show Bid/bsk  False
+ (1341559 Data Box
. Crozzhair on Mouse | Sticky
Font Arnal 6. 75 Regular
pre Show OHLC True
i Source Crozshair
4| @ 2006 Dpen E Ciy, LLC Wisibility AutoHide v
q E Grid and others B |
1001 Cursor Red, 1. Solid it
_,"" Connected | 09)26/2006 16:30 10:34:08 AM
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Background Color

The background can be customized by selecting any color from the drop box to the right. The color will appear
on the back of the chart.

Background Gradient

This is the second color of the background. This allows the two colors to blend together. This color will be bold
in the bottom right corner while the primary color will be bold in the top left corner.

Contrack,,. Add Indicator = 15 min * OHLC » Indicators.,. 3Select Profile - n |

High 1338.25 Low 133750 1250 25 | Froperties | Data | Indicators
. Open 1338.00 Close 133775

W

P Current Profile

}<E]h|

e

EH Appearance

Background Color - [_] ‘wihite
L1345 75 Background Gradient [ | ‘White
B Bid/A| 00 | Web Suztern

F13d4.23
'ﬁ'_Sk Lo 1 Trangzparent ~
134275 Bid Col | mm Black
Show § [T Wwhite
El Data | |EE DimGray
I Gray

Erussh 1 DarkGray

ont |\ Silver
Show | | LightGray
1536 75 Source |1 Gainsboro
© 2006 Open E Ciy, LLT Wisihilt E mﬂmnke

5 Grid 3\ s D arkFied
Curzar | | il Red [

I Eirowin
,,'D Connecked | 09)26/2006 16:30 | Eirchrick [l

134723

F1341.23

D@ XG> &

Bid/Ask



View

Contract... Add Indicator + 15 min * OHLC = Indicators... N
L, Properties | Data | Indicators
H1350.25
b Current Profile w
e (134300 '8 Appearance
Background Color [ ] white
5 H1247 .75 . .
Background Gradient [ | ‘white
| jsacsp | B Bid/Ask
e Azl Color [ Silver
| F1345.25 Bid Color [ Silver
(i) Show BidAek False
+ r1344.00 B Data Box True
. Crozzhair on Mouze  [Falze
i H3d2 75 Fant
p 4 541 50 Show OHLC True _
1 Source Crozshair
B 1340 25 Visibilty AutoHide
gt f 1 E Grid and others
Ask Color
The color of the Ask price on the Y axis.
Bid Color
The color of the Bid price on the Y axis.
Contrack,,. Add Indicator = 15 min * OHLC = Indicators.,. Select Profile - E | "
High 1347.75  Low 134725 Properties | Data || Indicators
Open 1347 .25 Close 134775 L1343 25 -
“ I Current Prafile v
| |
B % Background Gradient [ | ‘white -
) B Bid/Ask
134523 Aszk Calar [ Silver
I s Bid Color [ Silver
AEC . Shiow § Custom | b
{?H F1341.23 E Data [ Tranzparent S
] Crossh| | meml Black
+ Font | |3 Wwhite
. Show (| | B DhirnlGray
= 135 Source E Erjiﬁray
5 | @ 2006 OpenE Cy. LLC Visibilit | 7 5y
| E Grd g | LightGray =
By Y L1 Gainsboro .
o @ Connected | 09(26/2006 16:30 EHQ’;ﬁkaE 4
I [ arkRed
I Red
I Erown
[ Firehick s

Show Bid/Ask
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When ‘False’ is present the Bid/Ask price are not visible. Click on ‘False’ and change it to ‘True’ allowing the
Bid/Ask to be viewed for the most current price.

Conkrack,.. Add Indicator ~ 15 min * OHLC = Indicatars. ., N
E ' Propetties | Data | Indicators
350,25
Current Prafile L
W 1349.00 E Appearance
Background Color - [ ] ‘White
b F1347.73 R .
Background Gradient [ ] ‘White
I | jsac sy | B Bid#Ask
a8 Azk Color [ Silver
| 1245 25 Bid Colar [ Silver
(i) Show Biddek False
+ r1344.00 | \Fl Data Box True
. Crozzhair on Mouze  [Falze
F1342 .75 Fant
' 1241 50 Show OHLC True _
i Source Croszshair
By 1340 55 Visibility AutoHide
et f 1 =l Grid and others
Data Box
@ Chart - 15 min (ESZ6) Mi==<
Contrack,., Add Indicator « 15 min * OHLC + Indicators,., Seleck Profile -~ _
L | ' 35025 | Propetties | Data | Indicators
) s | | Curent Pofle v
Wy B Data Box ~
i 134723 Crozzhair on Mouze  Sticky
L1345 75 Font Microzoft Sans Seri
| Show OHLE True
AR [1344.25 Source Crozshair
! L y240 75 Yizibility AutoHide
'Fr” B Grid and others
t r13H.23 Curgor Red. 1. Solid
i Horizontal Tick Marksz, Gnd Li
Selection Color I Gray
pre Yertical Tick Marksz, Gnd Li
i B Scrolling
!i Auto Scroll True
Show Right Margin -~ False
T w
,,_,'D Connected | 0926/ 2006 16:30 10:21:56 AM

Crosshair on Mouse



View

Contrack,,, Add Indicator = 15 min = OHLC + Indicators,,, Select Profile -~
L | 2spos | Propertties | Data | Indicators
b 1342 75 Current Profile
R B Data Box
i 134723 Crozzhair on Mouze  Sticky
L1345 .75 Fant Hidden
I Show OHLC Free
p r1344.25 Saurce Mpuse .
] 1242 75 Wigibility StickyClick
Fﬁ' _:m E Grid and others | Sticky
Hidden ) ] ' T
The crosshairs are not visible on the chart
Free

rd B ﬁ]h"

The user must click on a location on the chart to make them appear. Upon placement, they do not move

unless reassigned.
Mouse

The crosshairs move unrestricted in conjunction with the user's mouse movements.

StickyClick

The vertical bar moves somewhat freely ("stickily") with the user's mouse movements, but the horizontal

bar changes only upon the user's specification by mouse click.
Sticky

The crosshairs move somewhat freely ("stickily") with the user's mouse movements.

Font

Customize the Font, Size and Style of the Fonts that appear on your charts and in the Data feed on the Chart;

aka OHLC (Top left corner by default).
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Contrack,..  Add Indicakor ~ 15 min * OHLC = Indicators... Seleck Profile - E | "
IE I 135005 | Froperties | Data | Indicators
b | 1248 75 Current Prafile W
g Show BidAdzk Falze ~

i A9 Data Box
H1345.75 Crosshair on Mouse Sticky
| Fort Anal 6.75 Regular
L
=
(i
[ Fant: Fant gtyle: Size:
T Hurial Regular 7
] ) Avial | [Fegular 8 A
() Arial Black Italic q
pd () Arial Marow Bold 10
H Batang Bald Italic 11
!i =) H BatangChe 12
2005 Dpen
ﬁ {} Eook Antiqua 14
- (} Bockman Old Style ¥ 16 ¥
v @ Connected Effects Sample
[ 5tikeout
AaBbYyZz
[ Underline ¥
Script:
Western w
Show OHLC
The Open High Low Close is by default displayed in the top left corner. It tracks the data that your mouse is
moving over.
Contract, .. Add Indicator = 15 min * OHLC » Indicators,., Select Profile - E | N
L, " lyssoss | Propetties |Data | Indicators
~ 1242 75 Current Profile LV
e Show BidAdsk False -
R 13472 E Data Box
134575 Croszhair on Mouze Sticky
| Font Anal 6. 75 _Regular
P [laad.23 Show OHLE Tiue
- H342 75 Source True
(3] I W Yisibility Falze
A “ 1341 23 = 2eid amd nthoea
Source

Provides the type of data that will appear in the OHLC box in the top right corner.
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View

... Select Profile ~ [ |

Contract... Add Indicator = 15 min * OHLC + Indicators "
L, | aspss | PTOREtties | Dats | Indicators
™~ P Current Profile v
o, El Data Box -
F1347 .25 . .
B Crozzhair on Mouze Sticky
H1345.75 Font Arial,6.75. Reqgular
I Show OHLC True
. 134423 Source Crozzhair
o L1age 75 Yizibiliky Last
i E Gnd and others |Mousze
t Cursar Crozzhair
{ o R I P A | T T T T
Last
The most current data presented in the OHLC.
Mouse
Presents the data from the location of your mouse on the chart.
Crosshair
Presents the strict data from exactly where the crosshairs are in relation to the contract chart.
Visibility
Contract, .. Add Indicator =+ 15 min * OHLC » Indicators,., Select Profile - E | N
High 1347.75 Low 1347 35 125025 | Propetties | Data | Indicators
Open 134750 Close 134725 -
™. P Current Profile v
W 1 WM DataBox ~
B | Crozshair on Mouze Sticky
F1345.75 Font Arial,6.75.Regular
I Show OHLC True
A 134423 Source Crosshair
| L1542 75 Wisibility AutoHide
(i) B Grid and others [Visble
t 134123 Cuirgar Hidden
. l_1333 15 Harizantal AutoHide
e Il ._. Tl b T mlAr T
Visible

The OHLC will always be on the chart.

Hidden

The OHLC will never be on the chart.

AutoHide

The OHLC will hide when the cursor is off the chart and will appear when the cursor moves over the chart.

Grid and Others

133



APPLTraderUserGuide

134

& Chart - 15 min (ESZ6)

BE=%]

Contract,.., Add Indicator = 15 min * OHLC * Indicakors... Select Profile - E | ok
LIl High 134550 Low 134375 Froperties | Data | Indicators
0 134475 CI 1344.00 L —
= i 134875 Current Profile “
Nk W 1346.50 Visibility AutoHide A
N B Grid and others
134275 JEIcIET. Red. 1. Solid
| L1242 on Harizomtal Tick Marks. Grid Lines
AEC Selection Calar I Gray
| 133375 Yertical Tick Marks. Grid Lines |
Ff’ 2l g Scrolling
t | @ 2008 OpenE 1 Auta Sl True
5 pen € Ly, Show Right Margin -~ False u
M
,!D Connected | 0902612006 16:30 10:46:44 AM
Cursor
General Information about the Crosshair.
#! Chart - 15 min (ESZ6) M=
Contract,., Add Indicator = 15 min * (OHLC » Indicators,.. Select Profile - E | CH
Lol High 133050 Low 133835 Properties | Data | Indicators
Open 1339.25 Close 1338.50 1343.00 - —
b Current Profile w
W 1346 25 Visibilty AutoHide ~
) B Grid and others
134350 B Curgor Red. 1. Solid
| Color I Red
ARG Shyle = solid
| "wiidth =
Gf’ ® Horizontal Tick Marks, Grid Lines _
t 2006 Qpen E Cry, LLC Selection Color I Gray j |
B N A _ Wertical Tick Marks. Grid Lines |+ |
|'D Connected | 09/26/2006 16:30

10:51:23 AM

Color

Specific color of the crosshair.

Style

Specific style of the crosshair whether it be a dotted line, a dashed line, a solid line, etc.

Width

The thickness of the cursor

Horizontal



Vi

iew

# Chart - 15 min (ESZ6)

/2

,'O Connected | 09/28/2006 16:30

Contrack,.. Add Indicator = 15 min * OHLC = Indicators... Select Profile - E | qp =
[ Propeties | Diata | Indicators
b Current Profile ™
s 134875 El Grid and others A
i 1347 25 Curzar Red, 1, Sohd
El Harizontal Tick Marks, Grid Lines
| m Show Grd Linez  True
2EC E Gnd Lines LightGray, 1, Dash
] F1344 25 Calar [ LightGray
(?f' Shyle =] Daszh
t r1342.73 "width =
. Label Color I Elack
134123 Label Font Microzoft Sans Serif. 7 _Regular
Show Tick Marks  True
0 1R E Tick Marks Black. 1, Solid
By L1ang 25 Calar I Elack
ﬁ Style E] 5olid
H1336 75 width 1
@ 2006 Open E Ciy, LLC Selection Color 2 Gray
Wertic:al Tick Marks, Grid Lines A
10401 1003 E Scrolling hd
1:258:54 PM

Show Grid Lines

Shows the horizontal grid lines. In order to turn the horizontal grids lines off switch ‘True’ to ‘False’.

Contract,,, &dd Indicator = 15 min = (QHLC = Indicators,., Select Profile = ﬂ | b = 5
E I Properties | Data || Indicators
Current Profile v
W B Grid and others A
i Curgor Red. 1, Solid
=l Horizantal Tick Marks, No Gnd Line:
| Show Grid Lines  False
s Grid Lines True
Label Color Falze
G) 1 I akal Farmk
\
Grid Lines

General information about the horizontal grid lines.
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# Chart - 15 min (ESZ6) =Jol&d
Contract,,. Add Indicator = 15 min * OHLC = Indicators,.. Select Profile - ﬂ | d8 = A
E Froperties | Data | Indicators
b Current Profile ™
e ﬁ;\ El Gnd and others A
i & Cursor Red. 1. Solid
El Horizontal Tick Marks,. Mo Grid Line:
[ Show Grid Lines  False
AEe = Grid Lines LightGray, 1. Dash
| 134123 Colar ] LightGray
"?{' | 1239 25 Style =] Dash
t fidth |
i F1337.23 Label Calor Il EBlack
@ 2006 Dpen E Cryp, LLC Label Fant Microsoft Sans Serif,7.Re
Show Tick Marks True [ |
X 10 10/3 R T R —————— ]
|'O Connected | 09/28/2006 16:30 1:37:42 PM
Color
Specific color of the horizontal grid lines.
Style

Specific style of the horizontal grid lines whether it be a dotted line, a dashed line, a solid line, etc.

Width
The thickness of the horizontal grid lines.

Label Color

The color of the labels on the horizontal axis (Time)

Label Font

The font of the labels on the horizontal axis
Show Tick Marks

Shows ticks from the horizontal line to the labels. Can change visibility of the horizontal ticks by changing

‘True’ to ‘False’.

Tick Marks

General information about the Tick Marks.

# Chart - 15 min (ESZ6) M=}
Contract,,. Add Indicator = 15 min * QHLC + Indicators.., Select Profile - E | g = A
E I I Froperties | Data | Indicators
., 134925 Current Profile ™
W 1247 50 E Horizontal Tick Marks. No Grid Line::A:
i Show Grid Lines  False
WErEE | O GiidLines LightGray, 1, Dash
| L 134400 Calor [ LightGray
A Style -] Daszh
| “idth —
(i} LabelColor [l Black
+ Labeel Fart Microzoft Sans Sernif. 7 .Re
— F238.75 Show Tick Marks True
B Tick Marks Black. 1. Solid
xl o rieEr.00 Calar I EBlack
3 2006 DpenE L. LLE Style  solid
" 101 10/03 Wl B 1 d]
'lo Connected | 09)258/2006 16:30 1:41:40 PM

Color
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View

Specific color of the ticks on the horizontal axis
Style

The style of the ticks on the horizontal axis
Width

The thickness of the ticks on the horizontal axis

Selection Color

The color you desired for the selected area if you were to drag you cursor from one point to another

Vertical
@4 Chart - 15 min (ESZ6) M=
Contract,.. Add Indicator = 15 min * OHLC = Indicatars... SelectProfile ~ [ | 4= = J
IE I Properties | Data || Indicatars
., Current Profile ™
b Selection Color 2 Gray ry
i B “ertical Tick Marks, Grnid Lines
Show Grid Lings  True
| E Grid Lines LightGray, 1. Dazh
Ara Colaor [ LightGray
[ Shile =1 Daszh
(i} ‘widkh =
t Label Calar Il Elack
— Label Font Microzoft 5ansz Serif, 7 Re
Show Tick Marks True
P 4227 00 Bl Tiu:lEQ h|-1arks 2:::;,' 1,k5|:|lid
& alar ac
gy, & 2006 Opan E Cw. LLC Shyle = Solid |
T 1001 10:02 idth = ]
i 3 Connected | 09/28/2006 16:30 1:43:46 PM

Show Grid Lines

Shows the vertical grid lines. In order to turn the vertical grids lines off switch ‘True’ to ‘False’
Grid Lines

General information about the vertical grid lines
Color
Specific color of the vertical grid lines
Style
Specific style of the vertical grid lines whether it be a dotted line, a dashed line, a solid line, etc.
Width
The thickness of the vertical grid lines
Label Color

The color of the labels on the vertical axis (Time)
Label Font

The font of the labels on the vertical axis
Show Tick Marks

Shows ticks from the vertical line to the labels. Can change visibility of the vertical ticks by changing ‘True’
to ‘False’
Tick Marks

General information about the Tick Marks

Color

Specific color of the ticks on the vertical axis
Style

The style of the ticks on the vertical axis

Width
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The thickness of the ticks on the vertical axis

Scrolling
# Chart - 15 min (ESZ6) M=)
Contract,.. Add Indicator = 15 min * (QHLC = Indicators.,. Select Profile - E | g =
L | ' I Properties | Data | Indicators
b [1348.73 Current Profile ™
s Source Croszshair A
8 Wigibiliby AutoHide
Grid and others
I , Cursor Red. 1. Solid
ARD Harizontal Tick Marks, No Grid Line:
| Selection Colar I Gray
(i (T Vertical Tick Marks, Grid Lines
t L1337 50 1q ; =
= Ao Scroll True
2 2006
OpenE Ciy. LLC Show Right Margin | False |
Pt 1041 10,03 s
," Connected | 09/28/2006 16:30 1:46:35 PM

Auto Scroll

Keeps the horizontal scroll bar at the bottom always at the most current price or at the most far right price

Show Right Margin

Offsets the scroll bar so the margin between the Y axis and the most current price is viewable

Chart Area 1
Misc

# Chart - 15 min (ESZ6)

M[E=1%)

Contrack,,, Add Indicator = 15 min * QHLC

Lk High 1234773 Lowe 134723
=4 Open 134723 Close 134775

Properties

Data | Indicators

Chart &rea 1

H Mizc
Cuztom Les [Collection]
Lower Limit Auto
|lpper Limit Auto

= Indicatars,,. Seleck Profile - E | g =
M

134,25

F13d2.00

F1339.73

F1337.50

1:43:29 PM




View

Custom Levels

Lower Limit

Allows you to set a specific price at which your viewable chart will not move below.

Upper Limit

Allows you to set a specific price at which your viewable chart will not exceed.
Contract (ei: ESZ6)

Appearance
# Chart - 15 min (ESZ6) M=)
Contrack... AddIndicator ~ 1Smin = Spline - Indicators... Select Prafile - [& |
bl High 133350 Low 1339.00 i Properties | Data | Indicators
N Wsas.zﬁﬁﬂ[nse 1339 50 | vros | [ES7E —
1347 .00
ww I = E Appearance
M 134075 Chart Skle Spline [w]
1343 75 Colar [ Bla_t:k
| Styles [Collection]
AEC H1344 .75 Vizible True
] B Candlestick
(i} Eearizh Il Red
+ i Eullish Bl Green
. 1337.75 B MWisc
:m Open E Cip. LLC Session 24 hours
(2=
p i [ o ok
_," Connecked | 09)22/2006 17:15 2:04:25 PM
Chart Style

Select the style of the chart you wish to view whether it be OHLC, Spline, Candlestick, Area, Stepline, etc.

Color

The color of the main contract chart

Styles

The specifics of the main contract chart

Visible

Whether or not the main contract chart is viewable

Candlestick
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"@ Chart - 15 min (ESZ6) E]@W

Conkract... &dd Indicator - 15 min = Spline = Indicators,.. Seleck Profile - E |
Ll High 134550 Low 134525 i Properties | Data | Indicatars
u] 1343.50 CI 1345.25 .
4 Jiﬁ}‘- ’r'lll FSE 1347 75 ESZE L
s ‘L h\ M B Appearance
B : z Chart Style Spline
| 1343 75 Colar Il Black
| Styles [Collection]
AEC F1341.75 Yizible True
! B Candlestick
Fr” r1339.79 Bearizh B Red
+ Bullish Bl Green
s 1337.75 B Misc
Session 24 hours
P
,'D Connected | 09/22/2006 17:15 2:15:52 PM
Bearish
The color of bearish candlesticks
Bullish
The color of the bullish candlesticks
Misc
B X
s
Contract,,, Add Indicator = 15 min * Spline - Indicatars... SelectProfile ~ [ | & = "
High 134250  Lows 134800 - Froperties | Data || Indicators
. Open 134825 Close 1348.25 e o ES76 -v-
Ll
B w WY B Appearance
B Chart Style Spline
1344 50 Color Il Black
| Stylez [Collection]
- 13427 Wisible Tiue
B Candlestick
- F13eH .00
F/ Bearizh Bl Red
+ 132925 Bullizh Bl Green
. 1237 50 B Mizc
[ Session 24 hours
@ 2006 Dpen E Cry, LLC
> ) 24 hours
L 2006/ 1002 05:15
LA () Caontract Setup -
Connected | 09/22/2006 17:15
"D 22 () Custam

Session

The time span you wish to view the chart
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24 hours

24 hours a day will be viewable
Contract Setup

The session will include only from the contract opening till the contract close
Custom

Select the time session you wish to view the contract
Additional Indicators

Appearance

andleSkick, | Indicators,., Select Prafile -

Properties | Data | Indicators |

BB and[Close:ESZE,20:2)
ESZE
|EBard(Close:ESZE20:2)

12000 ErdCloze:ESZE,20)

BB and[Cloze:ESZE,20:2]

1336.50 Stdlew|Cloze:ESEE, 20

Triple[StdD e [Close: ESZE,20),13:9:4
ATRIESZE14]

Orders

£

S:03:26 PM .

Select Profile -~

sndleskick + Indicakors...
||

Chart Style

154000 Color B DeepPink
Styles [Collection]
15650 Visble  True
B Data
[t Cloze:E5Z6

Period of indi 20

S:05:44 PM

View
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Chart Style

The style of line the indicator chart will have, whether it be line, area, point, spline, etc.

Color

The color of the indicator chart

Styles

Specifics of the indicator chart

Visible

Whether or not the indicators is viewable

Data
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andleskick,

1240.00

1336.30

+ Indicatars,., Select Profile -
||

Properties | Data | Indicatars |

BEand(Close:E 526.20:2)

ESZR

Era[Cloze:ESZE,20)
BB and[Cloze:ESER,20;2]
StdDev[Cloze:ESZE 20]
Triple[StdDey [Close: ESZE,20),18;9:4
ATRIESZE14]

Orders

W

5:03:26 PM :

snidleSkick,

| T

134000

1336.50

Properties | Data | Indicators |

+ Indicators,., Select Profile
||

EMA[CloseESZE20) v

E Appearance

Chart Style  Line

Colar I DeepPink
Styles [Collection]
Vizible True

Close:E5S6
20

Si05:44 PM

Input

Depending on the indicators, the data the indicator is having the information input from.

Period of indicator

The amount of data the indicators is viewing its information from based on the time or period indicated

Orders

Appearance

Font

View
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Customize the Font, Size and Style of the Fonts that appear on your charts and in the Data feed on the Chart;
aka OHLC (Top left corner by default).

# Chart - Bollinger Band: 15 min (ESZ6) =J0)e3d
Contract,., Add Indicator = 15 min * (OHLC » Indicators,,, Select Profile - E | CH
I 1 | 5
IE Froperties | Data || Indicators
b Orders ™
o B Appearance A
i Font Arial 6. 75 Regular [..]
E Color of Text
| Cancel Com [JJll DarkRed =
133675 .

ARG Color of Fill: [JJl] Black

| Modify Corr [JJll DarkBlue
Gf’ o0 1o Fjl Harmal Orde [l Black

t B Filter
i Cancel Com Falge
= Cancelled O False

e E.Dmpletedli True A

M"\ Fills Falze
!i m’ i C [T =N =P T sl
'!' Connecked | 09/20/2006 16:30 22706 PM

Color of Text

#! Chart - Bollinger Band: 15 min (ESZ6) M=

Contract,., Add Indicator + 15 min = OHLC + Indicators... Select Prafile ~ E | o8
Ll High 134100 Low 134075 Properties | Data || Indicators
~4 Open 134100 Close 13400 Orders 'v'

x| Ehds 1340738
ATR .36

E Appearance

.ﬁlial,E. 5. Reqular

‘Eancel Comm.[Jll DarkRed
. Color of Filz: [l Black
Modify Comm: [l DarkBlue

Ff’ TR Homal Order [l Black
t = Filter
. Cancel Comm. False
Cancelled Ord Falze
Completed Ore True
X o Fill= Falze ]
!i M \\ (9 I A PR i P .v.
i € Connected | 09/20/2006 16:30 2:29:00 PM

Cancel Command

The color of the text in an order indicator will appear by default Dark Red for cancel commands

Color of fills

The color of the text in an order indicator will appear by default Gray for Fills
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Modify Command

View

The color of the text in an order indicator will appear by default Dark Blue for Modify Commands

Normal Order

The color of the text in an order indicator will appear by default Black for Normal Order

Filter

# Chart - Bollinger Band: 15 min (ESZ6)

Contrack, ..

&dd Indicator = 15 min

T OHLC

-

L,

~
B

High  1349.00 Lowe 134825
134830

Open 134250  Close
Ehdi 13458 536
ATR 166

CE —

1003

R mrati_ E

€} Connected | 09202006 16:30

Indicatars... Select Profile = [ | <&
Froperties | Data | Indicators
Orders ™
= Filter : A

Cancel Comm. False

Cancelled Ord False

Completed Ore True

Fillz Falze

kadify Comme False

Fejected Orde Falze =

"Wizible True

Wiorking Orde Falze

Format

Agagregated Fi False

Full Format Falze ™

2:35:42 PM

Cancel Commands

This option offers the ability to view cancel commands on your chart, by default they are off.

Cancelled Orders

This option offers the ability to view cancelled orders on your chart, by default they are off.

Completed Orders

This option offers the ability to view completed orders on your chart, by default they are on.

Fills

This option offers the ability to view fills on your chart, by default they are off.

Modify Commands

This option offers the ability to view modify commands on your chart, by default they are off.

Rejected Orders

This option offers the ability to view rejected orders on your chart, by default they are off.

Visible

This option allow traders to turn the orders on or off without manually going thru each individual filter type. If
traders want to turn the viewable filters off simply change ‘True’ to ‘False’.
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For

Working Orders

This option offers the ability to view working orders on your chart, by default they are off.

mat

# Chart - Bollinger Band: 15 min (ESZ6)

BE]

Conkrack, ..

Add Indicator = 15 min = OHLC

» Indicators... Select Profile - E | b

b
s

m

s

o o

10473

Froperties | Data || Indicators

Orders

kodify Comm: Falze
Rejected Orde False

Wizible True

Working Orde False
= Format

Aggregated Fi Falze

Full Format Falze

Crder D Falze

Price Falze
[luiantity True
Ticket # Falze

Type Falze
Mﬂ?\ /—;/\’ E

€ Connected | 09/20/2006 16:30

LY

W

23007 PM

Dat

Aggregated Fills

Shows each individual quantity and the price they traded at. They are faint grey color to indicate that they are

aggregated fills

Full Format

Indicates the type, the quantity, the contract and the side of how the trade was placed

Order ID

Price

Provides the price of the trade in the viewable filters

Quantity

Provides the quantity of the trade in the viewable filters

Ticket #

Provides the ticket number accompanied by the full format indicators in the viewable filters

Type

Provides the type of order that was placed in the viewable filters.

Data

a



Information on the chart in relation to the cross-hairs on the charted contract.

View

? ¢ 573
Cortract,.. &dd Indicakor = 15 min = OHLC = Indicators... Select Profile = [ | <& =
High 133300 Low 133825 Properties | Data | Indicators
k. Open 133350  Close  1339.00
e ERds 1339155 DatedTime 06:4510/03
ATR 095 Last update 14:38.35
T Chart Area 1
| High 1339.00
Lo 1338.25
AED Open 1333.50
| Claze 1339.00
O L Ee— Top 1341 781
t Bottarn 1336.544
s Ebda 1339155
=8 Chart Area 2
StdDew 1.3
> -/\4 Chart Area 3
o o ,ETLE:\ u ATR 0.96
i €} Connected | 09202006 16:30 213537 PM

Date/Time

The time and date where the cross-hairs cross the X axis (bottom axis).

Last updated

The time the entire contract was most recently update with new data.

High, Low, Open, Close

The data is determined by the location of your cross-hairs on the chart. If the cross hairs are below the chart
they will cross at the low on the Y axis. If the cross hairs are above the chart they will cross at the high on the Y

axis.

Indicators
Channels

Channels
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o 1
# Chart - Bollinger Band: 15 min (ESZ6) M=%
Contract,.. Add Indicator = 15 min = OHLC + Indicators... Seleck Profile = H |
IE'. : _1350.25 Properties | Data | Indicators |
b [Tl = Channels "
Eh Bollinger Band
Commadity Channel [ndex =
B L 340,00 Envelopes
| K.eltner Channel
r 136,30 = Moving Averages
Ao Ewponential Moving Average
'l?g Leaszt Square Moving Average
1 Ralling Moving Average
s Simple Moving Average
P - Tr?angular Hu:uving Average
j il gl Triple Maoving Average
b e, _H'N“‘ Y ariable Moving Averaoe [V]
B3 @2006 OpenE Ty, LLG 2] Ul 2]
_.!' Connected | 0902002006 16:30 4121139 PM

Bollinger Band
Will put a Bollinger Band on the chart directly
This indicator can be used to measure the relative highness or lowness of price.

) _|[BlE3

Conkrack,., Add Indicator = 15 min * OHLC » Indicators,., Seleck Profile - E N

IE' I Froperties | Data | Indicators
b = Channels

-
o o Ballinger B and L
X Bollinger Band = @ Commadity Chantel Index 1
n El Appearance Ervelopes
| Calar [] LightBlue k.eltner Charinel
Yizible True wing Averages
4BC B Data Exponential Maving Average
(?r_; B stdes 2 Least Square Maoving Average
] InpLt Cloze:ESZH | || Falling Maving Average
Period of indicator 20 Simple Moving Average
i Triangular Maoving Awverage [V]
o i [
I, ' 214141 PM

[ Save az Default
[ ] Create Mew Area

(]9 l [ Cancel
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Com

modity Channel Index

Will put a Chart below the existing Contract chart.

Compares Prices with its moving average.

Contract... Add Indicator = 15 min * OHLC

» Indicators... Select Profile - H

View

X

High 134773 Lows  134€.00

Properties | Data | Indicators

\\ Open 134750  Close 134675 ~ Channels
& Ehd 1345 476 BD"ir‘lgEr Band
- - Commadity Channel [ndes
= B Commodity Channel Index @ Envelopes
| B Appearance ||Feltner Charnel
Chart Style Line * |wing Averages
ABC : o - ;
__ Color Bl DarkViolet Exponential Moving Average
(i 4 = Shyles [Collection] Least Square Moving Average
+ Yizible True Folling Moving Average
R B Data Simple Moving Average |
i [t ESZ6 Triangular Moving Average ||
E Period of indicator 20 B
iy @ 2:52:27 PM
[] Save az Default
(] l [ Cancel
Create Mew Area
Envelope

Will apply a envelop directly on the contract chart.

Plots above and below the moving average at a specified percentage.
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Contract... Add Indicator + 15 min * OHLC + Indicators... Select Profile - E .-
High 133850  Low 1337.50 Properties | Data | Indicators B
0 133850 Ol 1338.00 :
b pen "=e - Channels ~
- =)
Ballinger Band
W Envelopes @
P Commadity Channel [ndes
e i E Appearance Il Envelopes
| Calar [ LightCoral * || Keltner Channel
). Yizible True oving Averages
CBE Data E=ponential Moving Average
(i Irput Close:E576 Least Square Moving Average
+ Percent 01 Ralling Maving Awerage
B Feriod of indicator 20 Simple Moving Average .
= Triangular Maoving Average s
K £d
iy § 2:55:01 PM

[ Save az Defaul
[] Create Hew Avea

Ok ] [ Cancel

Keltner Channel.
Will apply 3 lines to the Contract chart

This indicator shows a central moving average line plus channel lines at a distance above and below.
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Cankrack,..

add Indicator = 15 min

T OHLC

+ Indicators.,,.

- D
Seleck Profile -~ E

View

X

o

i
IE Properties | Data | Indicators
- W = Channels ”~
E s Ballinger Band 1
Keltner Channel = @ Commodity Channel Index 3
B El Appearance Ervelopes
| Chart Style Line keltrner Channel
ol Clar [ DarkGray ¥ing Averages
Styles [Collection] E=ponential Maoving Average
F,J Wizible True Leazt Square Moving Average
+ E Data Ruolling Moving Average
_= B dewiations 1 Simple Moving Average
[ [put ESZG Triangular Moving Average
) . . L
Period of indicator 20 Trinle bAvinn &werans
p i 3; 1y |[>]
& 2:57:17 PM
[ 1 Save as Default
[] Create New érea Rl l [ Gece

Moving Averages

# Chart - Bollinger Band: 15 min (ESZ6)

mEx]

Contract... Add Indicator ~ 15 min * OHLC + Indicators... Seleck Profile E |
Ll Hih 134700 Low 134675 r Froperties | Data | Indicators .
\\ Open 134700 Close  1347.00 = Huving .ﬁ.?ElagES [A]
Wl Eme 1348512 | 14"""' Expanential Moving Average
o Least Square Moving Awerage
| stow 0.66 hdedian 0.57 1240.00 Falling Maoving Average =
| Fast nas ATk ':' 33 Simple Moving Average
1336.50 Triangular Moving Awverage
Ao Triple Moving Awverage
i?r.a Wariable Moving Awverage
4 Wwheighted Moving Awverage
i = Dszcilliator
el Average Directional Index
g D etrended Price O scillakor
X o F b ormentum i
By @ wM m <] i 2]
_" Connected | 09/20/2006 16:30 4:40:37 PM

Exponential M.A. (EMA)
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Will apply a line direct to Contract Chart.

EMA is an average of data calculated over a period of time where the most recent days have more weight.

Contrack,., Add Indicator « 15 min T CHLC

+ Indicators,., Seleck Profile - E _

rle_Il High _133%.75 Lowy 1337 5u| | f _\F'rclperties [Data

Exponential Moving Average @

E Appearance

Chart Style Line V
Color B DeepPink
Styles [Collection]
izible True
E Data

[nput Close:E5F6
Period of indicator 20

[] Save as Default

[] Create Mew Area [ ok l [ Cancel

Least Square M.A. (LSMA)
Will apply a line direct to the Contract chart.

Envelopes
Keltner Channel
- Moving Averages

|ndicators

E3 ﬁ]h

E=ponential Maoving Average
Leazt Square Moving Average
Ralling Maoving Average
Simple Moving Awverage
Triangular Moving Awverage
Triple Moving Average
Yariable Moving Average
Wieighted Moving Average

+ Merilliabtnr

2]

FESZEPM



View

Contract,.. #&dd Indicator + 15 min * OHLC - Indicators... Select Profile - [ N

(,EL-. . lm Froperties | Data | Indicators
~ =

Least Square Moving Average @ Errvelopes ~

K.elner Channel

B Appearance - Moving Averages

Chart Style Line Ld Exponential Moving Average
Coalar ] PI“_'“ Least Square Moving Average
S_t_'r'_|ES (Collection) Ralling Maoving &verage
Yisible True Simple Moving Awerage

E Data Triangular Moving Average
[npuit _ E_"-"“’:ESEE Triple Moving Average
RegrezgionOrder Linear “Wariable Maoving Average

= Pgrmds Weighted Moving Average
Window 35 + Merilliabtnr :

< 2

2110 PM

[] Save az Default
[] Create Mew frea

Ok l [ Cancel

Rolling M.A. (RMA)
Will apply line direct to Contract chart.
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Contrack,., Add Indicatar = 15 min = OHLC

+ Indicators,., Seleck Profile - E

E%\m‘% W u_:

L SEFT-LN
Rolling Moving Average @
E Appearance

Chart Style Line v
Color Bl BlueYiolet
Styles [Collection]
Wizible True
E Data
| npit Close:E576
k. 0.1

[] Save as Default
[] Create New Area

(] l [ Cancel

Simple M.A. (SMA)
Will apply line direct to Contract chart.

The average of data calculated over a period of time.

Properties | Data | Indicators

Ervelopes
F.eltner Channel

- Moving Averages

_# Mecilliatar

Esponential Moving Awverage
Least Square Moving Average
Fiolling Moving Average
Simple Moving Average
Triangular Moving Awverage
Triple Moving Awverage

W ariable Moving Awverage
Yweighted Moving Awverage

2]

F126:56 PM

:>:E]h



View

Conkract... Add Indicator = 15 min * OHLC » Indicators... Select Profile - E .-
IE. I Properties | Data | Indicators B
b Ervelopes A

. | K.eltmer Channel
(o = | = Moving Averages
Simple Moving Average @ Exponential Moving Average
B Appearance _ Least Square Moving Average
Chart Style Line ™ | Ralling Moving Average
Color [] DarkSeaGreen Simple Moving Average
Styles [Collection] Triangular Moving Average
YWizible True Triple Moving Average
B Data Warable Moving Average
[npLat Cloze:ESZ6 Wweighted Moving Awverage
Peniod of indicator 20 + Mecilliabar !
3:30:39 PM
[] Save as Default
[] Create Mew fArea [ ok ] [ Gages

Triangular M.A. (TMA)

Direct line onto Contract chart

Average calculated over a period of time where the middle portion of the data has more weight.
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Conkrack,,, Add Indicator = 15 min

 OHLC

= Indicatars,.,. Select Profile - H _

=

il

Triangular Moving Average

2X]

B Appearance
Chart Style
Colar
Styles
Yizible
B Data
[nput
Period of indicator

[] Save az Default
[] Create Mew fres

Line

Bl Green
[Collection]
True

Close:E5Z6
20

(] ] [ Cancel

Triple M.A.

Properties | Data | Indicatars

Envelopes
F.eltner Channel
- Moving Averages

Exporential M oving Average
Leazt Square Moving Average
Ralling Maoving Awverage
Simple Moving Average
Triangular Moving Awverage
Triple Maoving Average
Wariable Moving Awverage
Weighted Moving Average

+ Merilliatnr

Applies 3 lines on Contract chart, the Slow, the Fast and the Median.
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View

Contract,.. Add Indicator = 15 min * OHLC + Indicators... Select Profile - E - |
High 134000  Lows 1339.00 Properties | Data | Indicators
~4 Open 133373 Close 133925 1346 50 Erwelopes A

. = K.eltner Charnel

Triple Moving Average @ - Moving Averages

E Appearance Esponential Moving Average
Chart Style Line | Leazt Square Moving Average
Calar Bl Red Folling Moving Awerage
Styles [Collection] Simple Moving Average
Wizible True Triangular Moving Average

= Data Triple Moving Average
[nput StdDev[Close:E5S6.20) “ariable Moving Average

B Periods Weighted Moving &verage
FaztPeriod 4 + Merilliatnr !

: . < >
kedianPerniod 9 — =
SlowPeriod 18 335146 PM

[] Save az Default
(]
[] Create Mew Area l [ Lancel

Variable M.A.
Will apply line directly to Contract chart.
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Contract,,.  Add Indicator = 15 min * OHLC » Indicators,,, Select Profile - E N
High 134000  Low 133325 Properties | Data | Indicators
Open 133873 Close 133825 7
H 1546 S0
T e .,
Variable Moving Average G LNarne
g 8 - Moving Averages
B Appearance ; | E=ponential Maoving Average
Chart Style Line el Least Square Maoving Average
Colar [ Eh':"'ﬂﬂlﬂtﬂ Ralling Moving Average
S_t_'r'_|ES [Collection] Simple Moving dverage
Wizible True Triangular Maving Average
= Dataﬂ . Triple Moving Awverage
Sensitivity 0.078 Yariable Moving &verage
YWaolatility B atio StdDev[Close:ESZ6.20] weighted Moving &verage
+ Merilliabtnr !
S >
SI3F2T PM

[] Save az Default
[] Create Mew frea

] l [ Cancel

Weighted M.A.
Direct onto the Contract chart.

An Average where the greater weights are attached to the most recent data, it is calculated from the sum of the
day.
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T OHLC

=

+ Indicatars... Seleck Profile -

O
=

View

X

Contract,.. Add Indicator ~ 15 min
High 134325  Low 134150
Open 134200  Close  1342.00

b

Chdn 4500 nnn

m 1346.50

-

Weighted Moving Average

Properties | Data

(=%

Indicators [i

E Appearance

]

[] Create New Area

Chart Style Line
Colar Bl Green
Styles [Collection]
Wigible True
= Data
| pLit StdDev[Close:E5F6.20)
Feriod of indicator 20
[ ] Save az Default
Ok l [ Cancel

Envelopes
F.eltner Channel

= Moving Averages
E=porential Moving Averag

Leazt Square Moving Average

Ralling Maoving Average
Simple Moving Average
Triangular Moving Average
Triple kaoving Average
Wariable Moving Average

WWeighted Moving Average
i+ Mecilliabnr

<] I |

]

=

Es

:»]\'r

Oscillator

3139014 PM

# Chart - Bollinger Band: 15 min (ESZ6)

mEx]

* OHLC

+ Indicators,., Seleck Profile - E |

L,

b
W

Contract... Add Indicator = 15 min
High 134&.00 Lo 1347 .25
Open 134800 Close 134725
Ebd 1347 345
Sl 0.33 hedian
Fast 0.50 ATR

[

_ﬂi Connected | 0972002006 16;30

Froperties

Drata

= Dszcilhator

Average Directional Index
Detrended Price O zcillator
b ornerturm

Performance

Frice Ozcilliator

R ate OF Change

Relative Strength [ndex

Indicatars
2

Stochastic
wiilliar's %R
= Prices
tedian Price
Tupical Price [v]
(<] 1 |2
4144131 PM

Average Directional Index
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Will appear below the Contract chart.
Will have three lines, ADX, -DI, +Dl.

Conkrack,.. Add Indicatar = 15 min * OHLC + Indicatars... Select Profile - E _

R F.

IE& I Properties | Data | Indicators
b

\ Average Directional Index @
g
B Appearance _
. Chart Style Line Ea
| Color Il Black
Styles [Collection]
S visible True
Gr"’ B Data
4 [ npLat ESZG
B B Periods
Period 14
pd
i
[] Save az Default
LK ] [ Cancel
Create Mew Area

Detrended Price Oscillator

Will appear below Contract chart.

Oszcilliator
Average Directional |ndesx
Detrended Price Qzcillator
M omentum
Performance
Price Qzcilliator
Fate Of Change
Felative Strength Index

Stochastic
william's #H
Prices ]
Trand Follnweare ]
S5 16 PM

The Detrended Price Oscillator is used to "remove" the trend from the price. Comparing Closing or any other

price with it's moving average.



View

: S
o

Conkrack,.. Add Indicatar = 15 min * OHLC = Indicatars... Select Profile - E | )
IE. | ! Properties | Data | Indicators
™~ M 134650 - Dscilliator A

f° Average Directional Index
Detrended Price Oscillator @ Detrended Price O scillator
B Appearance - b ormentum
Chart Style Line || F'E.!rfl:urmarTc.e
Calar [] DarkSeaGreen Price Ozcilliator
Stles [Collection] Fate Of Change
Wisible True Relative Strength [ndes
E Data Stochastic
Imput Cloze:ES5Z6 _ Wwilliam's %R rvs
Period of indic.ataor 20 I+ Prices R
£ Ed
3:50:49 PM

[] Save az Default
Create Mew Area

LK l [ Cancel

Momentum

Will appear below the Contract chart.
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Contrack,,, Add Indicator = 15 min = OHLC

-

Sl
Ca

Indicatars... Select Praofile = E |j

Momentum

E Appearance
Chart Style
Calar
Shyles
Wizible

E Data
Input

E Penods
findon

[] Save as Default
Create Mew Area

Line v
[ YellowGreen
[Collection]

True

Close:ESZB

35

k. ] [ Cancel

Performance

Will appear under the Contract chart.

Fr

[+l Prices

.(.

operties | Data | Indicators

= Ozcilliator -~
Awerage Directional Index '
Detrended Price Dzcillator
b omenturm
Performance
Price Osciliator
Rate OF Change
Relative Strength Index
Stochastic
wiilliarn's =R

(2]

3192134 PM

Compares the current Close (or any other price) with the first Close value. Shows how much the Close price
was changed from the beginning.



View

Conkrack,,, Add Indicator = 15 min = OHLC + Indicators,,, Seleck Profile - H |_E
High 134750  Low 134550 r Propetties | Data | Indicators
Open 134573 Close 134725 m| = Dscilliator [ﬁ]
Performance . Y Average Directional lndex
@. Detrended Price Ozcillator
B Appearance tomentum
Chart Shyle Line ] Performance
Calar 1 Eﬂ'_dﬂmﬂd Price Dzcilliator =
Styles [Collection] Rate Of Change
Vizible True Relative Strength Index
B Data Stochastic
Input Close:ESZ6 Wwilliam's %R
[+ Prices ol
[{ ] 1 |[}]
354011 PM
[ ] Save az Default
k. l [ Cancel
Create Mew Area

Price Oscillator

Will display below Contract chart.
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Conkrack,.. Add Indicator ~ 15 min = DHLC = Indicatars,., Select Profile - H |j

IEMH I m Properties | Data | Indicatars
L “ 1346 50 || = Oscilliator A
=%

Average Directional Index
Detrended Price Oscillator

Price Oscilliator

B Appearance | b amentum
Chart Style Line il Perfarmance
Color Bl Red Price Oscillator
Styles (Collection) Rate OF Change
"Wizible True Relative Strength Index
B Data Stochastic
Input Close:ESZB william's %R )
Movingdwverage Simple + Prices b
Percentage True £ | >
B Periods — —
Faztudindow 9 Sy
S o indo 26
[] Sawve az Default
c (] l [ Cancel
reate Mew drea

Rate of Change

Appears below Contract chart.
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Contract,.. Add Indicator + 15 min * OHLC

View

o
Fa

+ Indicators.,. Seleck Profile - _
E |_ﬂ

High 133950

b Open 133873

P
Lowe 133630

Close  1337.00 m 1346 50

-~

Rate Of Change

=

E Appearance
Chart Style
Color
Styles
YWisible
E Data
[rpLit
Period of indicator

[] Save az Default

Create Mew fArea

Line

I IndianRed
[Collection]
True

Close:E576
20

ak. l [ Cancel

Relative Strength Index

Appears below Contract chart.

Propertties | Data | Indicators

- Dszcilliator -~
Average Directional [ndex b |
Detrended Price O scillator
M ornerturm
Performance
Frice Oscilliator
R ate OFf Change
Relative Strenagth [ndes
Stochastic
William's %R

< 2]

315715 PM

Compares upward movement of the Close price with the downward movement resulting in a value which ranges

from 0 and 100.
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.
Cortract...  Add Indicator * 15 min » OHLC = Indicatars... Select Profie = [ |j

IE I ! Properties | Data | Indicators

S| e :Ff Seasas - Dscilliator A
- Average Directional Index
Relative Strength Index @ Detrengded Frice Oscillator
B Appearance - t ormeritum
Chart Style Line || Perfarmance
Calor I DarkCyan Price Oscilliatar
Shples [Collection) Rate Of Change
"izible True Relative Strength [ndes
B Data Stochastic
Input ESZ6 Williarn's %R o]
Period of indicatar 20 < = 3]
35909 PM

[] Save az Default
Create Mew Area [

LK ] [ Cancel

Stochastic (%K, %D)
Appears below Contract chart.

Indicator helps to find trend reversal searching for a period when close prices is close to low price in up trending
market or close prices is close to high price in down trending market.
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View

) B =<

Conkrack,., Add Indicatar = 15 min * OHLC + Indicators.., Seleck Profile - E |_E

High 134000  Low 1333.25 [ Fropetties | Data | Indicators

. Open 133873 Close 133325 m % = Dscilliator [A]
" . \ &yerage Directional |ndes
Stochastic = @ D etrended Price O scillator
B Appearance Momentum
Chart Style Line [V] Performance
Calar Bl Brown Price Dzciliator =
Shiles [Collection] R ate OF Change
"izible True Relative Strength [ndes
B Data Stochastic
[t ESZ6 Wwilliam's %R [v]
PerodD 10 =
Periodk 10 ] - (2
4:05:20 PM

[] Save az Default
Create Mew Area

] ] [ Cancel

William’s %R (%R)
Places the charting below the Contract chart.

This indicator is used to measure overbought and oversold levels.
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Contrack,,, Add Indicator = 15 min = OHLC

+ Indicators,,, Select Profile -~ H |_E

|T|| Migh 133875 Low 1337.50] | [ Properties | Data | Indicators |
William's %R - 18| = osciliator ]
Average Directional [ndex
B Appearance Detrended Price Oscillat
Chart Style Line [v] Me 1=1g| te rice Qacillatar
Color Bl Brown nmeniLm
- Performance
Styles [Collection] . . 3
- Price Oscilliator E
Yizible True
= Data Rate OFf Change
Input ESZE E:Ia::veftrength Index
Period of indicator 20 DE aslt
William's %R =
0 &)
4:06:49 PM
[] Save az Defaul
Q. ] [ Cancel
Create Mew fArea
Prices
# Chart - Bollinger Band: 15 min (ESZ6) M=}
Contract.., Add Indicator = 15 min * OHLE = Indicators... Select Profile = [& |
Ll High 134150 Low 134125 [ Froperties | Data | Indicatars .
3 Open 134130 Close 134125 ~ Prices [A
Wl EmMa 1341214 tedian Price
Typical Price
— | Slow 0.24 hedian 0 YWeighted Cloze
| Fast 0.24 ATR 0.36 Trend Followers
Iig Yolatility
4 o o 20060003 0230 = Yolumes A
(?;; m Accurmulation/Distibution 3
1 E aze of Movement
B S—— Money Flow [ndex [v]
A rmomrtoic |~ rm 3 I p—r
_.l"' Connected | 092002006 16:30 4:03:45 PM

Median Price (Median)
Places a line directly on the Contract chart.

Mid-point value of daily prices.

Typical Price (Typical)
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Appears directly on the Contract chart.

The average value of the daily prices.

Weighted Close (Weighted)

Appears direct to the Contract chart.

View

Average value of daily prices, only difference is that the closing price has extra weight as the most important

price.

Trend Followers

#! Chart - Bollinger Band: 15 min (ESZ6) M=%
Contract... Add Indicator + 15 min * OHLC + Indicators.,. Seleck Profile - E |
IE. I [ Froperties | Data | Indicatars
3 = Prices [A]
N tedian Price
Typical Price
B 134000 "Weighted Cloze
| = Trend Followers
1336 50 AT
Ao b azz [ndex
'Fr) Tangent of Linear Begreszion
N TR =
s Yolatility
» = Yolumes
E2]
' Accumulation/Distribution
X i . ‘f"" E aze of Movement st
v & ty e <] 2]
_.!' Connected | 092002006 16:30 4:14:56 PM

MACD (MACD, Histogram, Signal)

Appears below Contract chart.

Compares two moving averages of prices. Is used with its 9 day Exponential Moving average as signal.

Mass Index (MI)

Below the Contract chart.

developed to predict trend reversal by comparing difference and range between high and low prices.

Tangent of Linear Regression (Tangent)

Appears below Contract chart.

TRIX (TRIX)

Below Contract chart.

Based on triple moving average of Closing Price and its purpose is to eliminate shorter cycles.

Volatility
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#! Chart - Bollinger Band: 15 min (ESZ6) M=%
Contract... Add Indicator + 15 min * OHLC + Indicators.,. Seleck Profile - E |
Ll High 133275 Low 13m0 Froperties | Data | Indicatars

b Ebd 1328 548 Average Tue Range
Standard Deviation

Slo 1.0 Median 07z " ol atiliby
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Average True Range (ATR)
Appears below Contract chart.

Measures commitment comparing the range between High, Low and Close prices .

Standard Deviation (StdDev)
Appears below Contract chart.

Difference between values (Closing Price) and average.

Volatility (Volatility)

Appears below Contract chart.

Volatility Chaikins (CHV)
Appears below Contract chart.

Difference between high and low prices, indicates the top and bottom of the market.

Volatility Ratio (VR)

Appears below Contract chart.

Volumes
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Accumulation/Distribution (A/D)
Appears below Contract chart.

Estimates the strength of price movement with the relationship between volume and prices.

Ease of Movement (EoM)
Appears below Contract chart.

Uses volume to estimate how strong the price trend is.

Money Flow Index (MFI)
Appears below Contract chart.

Compares upward changes and downward changes of the volume weighted typical prices.

Negative Volume Index (NVI)
Appears below Contract chart.
Should be used with PVI.

Changes only if the volume decreases from the previous day.

On Balance Volume (OBV)
Appears below Contract chart.
Measures positive and negative volume flows.

Volume is added if the closing price moves up and subtracted if the closing price moves down.

Positive Volume Index (PVI)
Appears below Contract chart.
Should be used with NVI.

Changes only if the volume decreases from the previous day.

Price Volume Trend (PVT)

View
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Appears below Contract chart.
Cumulative volume total.

Calculated by using the relative changes of the Close price.

Volume Oscillator (VO)

Appears below Contract chart.

Tries to identify any trends in volume, comparing two moving averages; one with a short period and the second
with a longer period.

Communications

172

Research

This window displays important messages that consist of major market issues sent from the brokers to the entire
APPL population. It also displays Risk messages such as available credit, etc.

Each time a research appears it will be accompanied by a topic first then a message. The broker can make it as
specific as possible for quick reference by using the seven templates. The topics are Indices, Currencies, Energies,
Grains, Metals, News, and General.

3:41:39 PM RISK
Rizk wiolation Max credit = 0 USD,Order would need credit of 6012.52
15D [zash available iz 37862.43 15D]

To access Research:

a. From Communications menu options, click on the "Research Window"; if the option has a check next to it then
it's available to view; if it does not have a check then it isn’t available to view.

b.  From View menu, click on Research in order to make it highlighted.

Chat

Allows one customer to directly ask questions, get quotes, place orders, etc with a broker. The broker answers the
questions/comments via the CHAT box.

We highly recommend most questions be transmitted via the CHAT box. It is the most streamline method of
communication.

Chat

3:28:36 PM to DanielA:Hello | have a question. A | | Danield
3:28:50 PM to DamelAw'hat iz the curent zymbol of the

mini 5P 500 7

3:29:17 PM Danielh: The curent symbaol for the mini S&P

A00 iz ESUR -

W-I0-DF Dl b D il - Tl—nde - |

In order to initiate chat with a BROKER, select their name (i.e. APPLBroker9) and type your message in the open
row at the bottom. Once you have entered your text you will be offered the SUBMIT button. Click on the SUBMIT
button and the broker you selected will receive your message. The drop box is there for your reference so you can
repeat your self with previous comments or say the same thing to a different broker by just clicking into the drop box
and selected the previously written text.

To access Chat:



View

a. From Communications menu options, click on the CHAT option. If it is already checked it will uncheck the
CHAT option and it'll be unavailable to chat.

b.  From View menu, click on Chat in order to make it highlighted.
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Reports

Access Reports

Each report can be filtered by one account or all and date ranges. They can be viewed in PDF or Excel format.
Access any one of the following reports.
Daily Fills

Shows the dalily fills for the designated dates indicated above.

Daily Activity

Daily Activity is the number and contracts that you traded on the dates indicated above.

Working Orders

Working orders are the orders that are working or have been working from the date increment from above.

Rejected Orders

This report indicates all the rejected orders within the dates entered above.

Order Statistics

The number of orders placed, orders cancelled, orders filled, open orders, the number bought and the number
sold for the date above and within the contracts that were traded.

Order Ticket Statistics

The method the orders were placed weather they be AOE, Turbo, Rapid or DOM and the order statistics for
each order method.

P/L Summary

The Profit and Loss for each trade placed and the order statistics, for the date(s) provided above.

Chat History

The chat history is recorded for quick reference and for security reason. This allows traders and brokers to view
previous conversations between trader and broker.

News History

The Research comments that have been presented by the Brokers to the entire APPL population. These
messages are important details from the broker involving major Futures issues.

Order Details

Provides a detailed description of each trade made and the necessary identifications for each detail within the
order placed.

Daily Positions

Daily Positions represents the positions for the account above between the dates indicated.

Trade Log

Provides a detailed description of the trades placed. The trade log provides the time, side, the contract, the

price and the amount at which each trade was place.

Open Orders
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Reports

Provides the list of open orders that exist with in that account.

175



Setup

Shortcut Manager

Allows you to customize the hotkeys for a vast amount of APPL Trading options.

Action Feys -
File
Lagan
Logoff
Exit
Orders
Abbreviated Order Entry Chrl+1
Turbo Order Extry W adifiers:
R apid Order Entry ]
Drepth OF b arket Order Entry Ctl [] Shit [] Al

Contract Setup Key:
Clear After Subrmit

1 | | Reset
Turn on Mew Order Canfirmation -

Restore Defaulq [ Ok, ] [ Cancel ]

Quick Start

Allows you to view the quick start menu which has a direct link to the Quick Start Guide, Depth user’s guide and all
the contact info for customer service and support.
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Toolbox

r@ Quick Start = E]m‘

NPT

TRADER

Welcome to Open E Cry's direct access trading software.

We encourage yvou to vizit our quick start guide and in depth uzer's
guide.

If vou have any questions please visit our Live Help or call 800-520-
5808 or 814-792-2550,

A link to the quick start guide will be available under the "Toolkox™ menu
of the software for future reference.

[l Show on startup

Toolbox

Glossary

Display the APPL’s Glossary web page with your default browser.

URL: http://www.applfutures.com/glossary_terms.php
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Help

Contact Us

You can contact us at 1-800-274-2775 or 212-809-4275. You can also email us appl@applfutures.com

About

Displays the current information of the platform that the trader is currently running.

Ehhnut

DECTrader Demo
= 2006 Open E Cry, LLC

TRADER Al rights reserved
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Open Live Account

Open Live Account

Open Live Account (DEMO ONLY)

Demo Only
Display APPL’s Online Application with Electronic Signature web page with your default browser.

URL: http://www.openecry.com/ibportal/Pages/ApplyOnline.cfim?WLID=44
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Advanced Features
Advanced Orders

Order Flags
# ESZ6 - Depth of Market

%]

[

ey - & |kl |  DEmMozssao -
Oty 0l TotalPAL $1,000.00
Poz: ]

<
I 1329.00 789
13227 R
3839 122250 |
122625 T
122800 [
122775
1327 RN
N - Ees

Order Flags

(%) Mone (O GTC O FOK (O 10C

Good Till Cancelled (GTC)

Order remains on the books until cancelled and can be filled at an undesirable time if forgotten.

Fill or Kill (FOK)

LMT orders which, if not filled immediately, are cancelled.

Immediate or Cancel (I0C)

LMT orders which, if not filled immediately, are cancelled.

OCO Orders

OCO (One cancels other) is a pair of orders sent together.
Currently only Limit and Stop orders of one side (buy limit/buy stop or sell limit/sell stop) are supported.

1. Tosend OCO orders, user needs to check OCO toolbar button, and then send two orders in usual way.
Another way to enter a single pair of OCO orders, user could hold SHIFT key while clicking.

2. Atter clicking first order, the price would be marked with different color, until second order is entered. To cancel
OCO order entry after first order is entered, user should uncheck OCO toolbar button (or release SHIFT key).

Working OCO orders are displayed in blue color by default.
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" .| = BE3
= | [ [5F ? 3 S |l | DEMO4704 - |
Qty: 5% TatalPAL: $0.00
m Confirm orders

-,

3

Buw 5 ESZE LMT 1324.50
Buy 5 ESZE LMT 1326.00

|

(m]

a &2
% —

[ es ] [ Mo
10 1326.00
B 1552 132575
2720 132550
2660 1325.25
4240 1325.00
I 1324.75
132450
Left Click: OO LIMIT
| BwMkT || Gotolast || selmkr |

Stop Limit/Trailing Stop

# ESZ6 - Depth of Market

mE]

+ | [E &

af ?é} | [l

DEMO4 7094 -

Oty 3 {:} Tatal PAL:

Fos: 0

1326.75
1326.50
1326.25
1326.00
1325.75
1326.50
1326.25

$0.00

1326.00
1324.75

-

[

Buy MET ] [ o bo Last ] [

Sell MKT |

[ ] Stop Limit [ ] Trailing Stop

Factor: Factar:

0.25/%

Advanced Features
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Stop Limit (STP LMT)

e  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not become
MKT orders once the STP price has been reached

e  Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order will not be
filled unless the price remains at or drops below the limit level

®  Sell STP LMT is activated when the commaodity is offered or traded at or below the STP level, the order will not
be filled unless the price remains at or rises above the limit level

®  No order can be guaranteed an execution

Trailing Stop (Tr STP)

A complex stop-loss order in which the stop loss price is set at some fixed percentage below the market price. If the
market price rises, the stop loss price rises proportionately, but if the stock price falls, the stop loss price doesn't
change. This technique allows an investor to set a limit on the maximum possible loss without setting a limit on the
maximum possible gain, and without requiring paying attention to the investment on an ongoing basis

Trailing Stop (Stop Limit) order is a Stop order which “follows” the market price. By checking “Trailing Stop” checkbox
all stop/stop limit orders would be sent as Trailing Stop/Stop Limit orders.

The Control key negates this checkbox settings, so right clicking with “CTRL” key pressed sends trailing stop order, if
this checkbox isn’t checked, or sends normal stop order if the checkbox is checked.

The “Factor” value controls the minimum market price change that would case order to “trail”. Its minimum value is
one tick of selected contract.

Trailing Stop order could be sent as an individual order, or as a linked (bracket) order.
Trailing Stop order couldn’'t be part of OCO orders pair.

Working Trailing Stop orders displayed in green color by default.

How to execute
1. Check the Box next to STOP LIMIT and/or TRAILING STOP.
2. The Cursor will indicate when a trailing stop/stop limit order is available

3. Right click above the market to initiate the trade

Bracket Options

Inactive Linked orders are displayed with + sign (see picture), and could be modified or cancelled separately from
master order, but master order cancellation would cancel inactive Linked orders.

Brackets are group of orders — master and 1 or 2 linked. Linked orders are activated when master order is filled.
They are mostly used to create a “bracket” around open position, so they are called brackets. However, user can
enable only one part of bracket (Stop or Limit)

When Bracket checkbox of corresponding price is checked, order would be sent as bracketed order. However, if
order is closing or reducing existing open position, it would not be sent as bracket.

Factors are price difference between bracket orders and master order

When user is moving mouse pointer over the order entry area, places for bracket orders are indicated on the
opposing side in orange, and prices also highlighted (see picture).

If market bracket order is sent, bracket prices are determined against current bid/ask price.
If both Limit and Stop checkbox are checked, linked orders will be sent as OCO order pair.

If only Stop is checked, it is possible to send linked Trailing Stop order (by checking Trailing Stop checkbox also).
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Inactive Linked orders are displayed with + sign (see picture), and could be modified or cancelled separately from
master order, but master order cancellation would cancel inactive Linked orders.

Buy Bracket

Click on the Buy Bracket Box to activate the
option of placing a BUY Bracket

If the Box is filled in with a box then only one of
the two legs are checked

Sell Limit

If sell LMT is checked then the bracket will have
the Sell LMT side attached being placed above
the market on the opposite side of the Buy
Bracket

This factor indicates how far from the BUY order
the Sell LMT will be

Sell Stop

If sell STP is checked the bracket will have the
Sell STP leg attached

This indicates where the sell STP will be placed
from the BUY bracket

Sell Bracket

Click on the Sell Bracket Box to activate the
option of placing a SELL Bracket

If the Box is filled in with a box then only one of
the two legs are checked

Buy Stop

If buy STP is checked then the bracket will have
the buy STP leg attached being placed above the
MKT on the opposite side of the Sell Bracket

This factor indicates how far from the Sell order
the Buy STP will be bracketed

Buy Limit

If buy LMT is checked the bracket will have the
Buy LMT leg attached be placed beloved the MKT
on the opposite side of the initial trade

This indicates where the sell STP will be placed
from the BUY bracket
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Glossary

#

2DNR: Two-day range (high-low) that is narrower than any two day range in the preceding 20 days.

3Day: The 3-day market pattern as described in “The Taylor Trading Technique by George Douglass Taylor. B=Buy, S=Sell,
SS=Short Sale.

3DNR: Three-day range (high-low) that is narrower than any three day range in the preceding 20 days.

A

Account balance: The amount of money or debt in an account.

Account Number: (1) A series of characters (alpha and/or numeric) used to identify a customer account or relationship. (2) The
remitting financial institution's account serviced by the receiving bank. (3) The identification assigned by a financial
institution often called the account number.

Account position: The balance and current holdings of an account.

Ask: An indication by a trader or a dealer of a willingness to sell a security, a futures, or other financial instrument. The price at which
an investor can buy. Syn. offer. See also bid; quotation.

Asked: The price that someone is willing to accept for a security, futures or other financial instrument. The ask portion of a quote is
the lowest price anyone is willing to accept at that time.

Asked Price: The price at which sellers offer securities, futures or other financial instrument to buyers. Also called offer price.

At-the-money: An option with a strike price equal to the current price of the instrument, such as a stock, upon which the option was
granted.

At-the-opening order: An order that specifies it is to be executed at the opening of the market or of trading or else it is to be
canceled. The order does not have to be executed at the opening price, but within the opening range of prices.

At or better: (1) In a buy order for securities, futures or other financial instruments it is purchasing at the specified price or under it
(2) For a sell order, it is selling at the specified price or above it. See limit order

B

Bear Market (bear/bearish): A market in which prices are declining. A trader who believes prices will move lower is called a
“bear.” A period of generally failing prices and pessimistic attitudes.

Beta: A measure of an investment's volatility. The lower the beta, the less risky the investment.
Bid: An indication of a trader of a willingness to buy a security. The price at which an investor can sell.
Bid-offer spread: The difference between the bid price and the offer price.

Break-even point: (1) The point at which gains equal losses. (2) The price a market must reach for an option buyer to avoid a loss if
he exercises. For a call, it is the strike price plus the premium paid. For a put, it is the strike price minus the premium paid.

Broker: An individual or firm that charges a fee or commission for executing buy and sell orders placed by another individual or firm,
floor broker in commodities futures trading, a person who actually executes orders on the trading floor of an exchange; an
account executive (associated person) as the person who deals with customers and their orders in commission house
offices.

Buy Limit order: An order to a broker to buy a specified quantity of a security at or below a specified price (called the limit price).

Buy on close: Buying securities, futures or other financial instruments at the end of a trading session at a price within the closing
range.

Buy on opening: Buying securities, futures or other financial instruments at the beginning of a trading session at a price within the
opening range.

Buy Stop Order: An order to buy a market that is entered at a price above the current offering price and that is triggered when the
market price touches or goes through the buy stop price.

Buying Hedge (or Long Hedge): Buying futures contracts (or other financial instruments) to protect against possible increased cost
of inputs slated for futures uses. See Hedging.
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C

Closing balance: The balance of entries posted to the account at the close of the statement period.

Closing price: The price at which transactions are made just before the close on a given day. A number of transactions are often made
at this time and they will be included over a range of prices. See also closing range.

Commission: (1) A fee charged by a broker to a customer for performance of a specific duty, such as the buying or selling of futures
contracts. Banks charge commissions for issuing letters of credit, accepting drafts drawn under letters of credit, entering
foreign exchange transactions for their customers, custodial services, acting as fiscal agent, etc. Fees are paid by banks to
others for various services and include fees to foreign exchange brokers for arranging foreign exchange transactions. A
commission must be fair and reasonable, considering all the relevant factors of the transaction. (2) Sometimes used to refer
to the Commodity Futures Trading Commission (CFTC).

Commodity: An entity of trade or commerce, services, or rights in which contracts for future delivery may be traded. Some of the
contracts currently traded are wheat, corn, cotton, livestock, copper, gold, silver, oil, propane, plywood, currencies,
Treasury Bills, Treasury Bonds, and Stock Indexes.

Contract Month: The month in which deliveries to be made in accordance with a futures contract.

D

Day Trade: The purchase and sale of a futures or an options contract in the same day, thus ending the day with no established
position in the market or being flat.

Delivery Month: A calendar month during which a futures or options contract matures and becomes deliverable.

F

FOK (Fill or Kill): FOK (Fill or Kill) When an order is given to a broker that must immediately be filled in its entirety or, if this is
not possible, totally canceled.

G

GTC (Good until cancelled): GTC (Good until cancelled) orders are generally held on file and considered to be active unless
cancelled by you. Upon expiration of the contract, the GTC order will be automatically cancelled.

Initial Margin: The minimum value on deposit in your account to establish a new futures or options position, or to add to an existing
position. Initial margin amount levels differ by contract. Brokerage firms set the level of Initial Margin required, and it may
change at any time at their discretion. Increases or decreases in Initial Margin levels reflect anticipated or actual changes in
market volatility. Also called "Initial Performance Bond." (See also Margin)

Intrinsic Value: The absolute value of the in the money amount; that is, the amount that would be realized if an in the money option
were exercised.

10C (Immediate or Cancel): IOC (Immediate or Cancel). An order requiring that all or part of the order be executed immediately
after it has been brought to the market. Any portions not executed immediately are automatically cancelled. This is used for
large orders where filling quickly can be difficult.

L

Leverage: Essentially, it allows an investor to establish a position in the marketplace by depositing funds that are less than the value
of the contract. The use of borrowed assets by a business to enhance the return to the owner's equity.

Limit Order: An order in which the customer sets a limit on either price or time of execution, or both, as contrasted with a market
order, which implies that the order should be filled at the most favorable price as soon as possible.

M

Margin Call: A call from a brokerage firm to a customer to bring margin deposits back up to minimum levels required by exchange
regulations; similarly, a request by the clearinghouse to a clearing member firm to make additional deposits to bring
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clearing margins back to minimum levels required by clearinghouse rules. A demand upon an investor to put up more
collateral for securities bought on credit.

Market If Touched Order: An order which becomes a market order if the specified price is reached.

Market Inversion Index (MI1): Market Inversion Index. A very short term momentum indicator. This indicator is used to determine
which side of the market to be on for the close and early session the following day. When the Ml flips from, for instance,
long to short on the market close, a trader should go short with the intent of covering the short either in globex or early in
the next day’s session. This is a short term indicator for aggressive traders.

Market On Close Order: A buy or sell order which is to be executed as a market order as close as possible to the end of the day.

Market Order: An order to buy or sell futures contracts, stocks or other financial instrument which is to be filled at the best possible
price and as soon as possible. A limit order, in contrast, may specify requirements for price or time of execution.

Moving Average: A mathematical procedure to smooth or eliminate the fluctuations in data. Moving averages emphasize the
direction of a trend, confirm trend reversals, and smooth out price and volume fluctuations or “noise” that can confuse
interpretation of the market.

N

Net position: (1) A financial institution has a position in foreign currency when its assets, including future contracts to purchase, and
liabilities, including future contracts to sell, in that currency are not equal. An excess of assets over liabilities is called a net
"long" position and liabilities in excess of assets result in a net “short" position. A long net position in a currency which is
depreciating results in a loss, because with each day, that position (asset) is convertible into fewer units of local currency.
A short position in a currency which is appreciating represents a loss, because with each day, satisfaction of that position
(liability) costs more units of local currency. (2) The difference between the open long (buy) contracts and the open short
(sell) contracts held by any one entity in any one futures contract month or in all months combined.

R

Round Turn: The combination of an initiating purchase or sale of a futures contract or other financial instrument and offsetting sale
or purchase of an equal number of futures contracts or other financial instruments, of the same specifications. Commissions
and fees for transactions are charged on the round turn.

S

Sell Limit order: An order to a broker to sell a specified quantity of a security at or above a specified price (called the limit price).

Stop Limit Order: An order to buy or sell a certain quantity of a certain security at a specified price or better, but only after a
specified price has been reached. Essentially a combination of a stop order and a limit order.

Stop Loss: A risk management technique used to close out a losing position at a given point. A stop loss order is placed at the given
point.

Strike price: A specified price at which an investor can buy or sell an option's underlying financial instrument. The exchange rate,
interest rate, or market price that is guaranteed by an option transaction.

Symbol: Code by which futures are identified on a futures exchange; a corporation which provides the facilities to trade futures
contracts
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